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1. Setting Up Batch Builder 
1.1 Installing Batch Builder 
1.2 Setting options 

This section provides an overview of Batch Builder features and describes requirements for file 
names and batch directories.  

1.1 Installing Batch Builder  
Batch Builder (BB) is a Java-based application compatible with Windows, Mac and Linux 
operating systems. 

The Batch Builder application package includes a Graphical User Interface (GUI) and a separate 
Command Line Interface (CLI) for automated deposit workflows.  The application package is 
bundled as a zip file, which must be downloaded, unzipped, and installed on your computer.  The 
Batch Builder 2 Beta zip archive can be downloaded from: 
http://hul.harvard.edu/ois/systems/drs/BatchBuilder-2-current.zip   

Recommended System Requirements 

• Operating System: Windows XP/Vista/7, Mac OS X 10.5.8 or higher, Linux. 

• Processing Power: Intel Core 2/i3/i5/i7; AMD Athlon II/Phenom II  

• Physical Memory: 3 GB RAM or higher (requires 64-bit Operating system).  

• Java version 1.6.0 or higher. Download the latest version of Java here: 
http://www.java.com/en/  

Installation 

1. Download the zip file from here: 
http://hul.harvard.edu/ois/systems/drs/BatchBuilder-2-current.zip   

2. When prompted, save  the BB zip archive to your computer (e.g. a download directory or your 
desktop) 

3. Unzip the archive and extract the files to a directory of your choice (e.g. Program Files or 
Applications).  The installer will create a “batchbuilder-2.x” directory and copy the files to it. 

4. To start the GUI, double click the launch (executable) file (look for the BB icon  in the 
batchbuilder-2.x directory).  
 

If you can’t start BB using the executable, try the following alternative: 

ο On Windows: double click on the file batchbuildergui.bat. A command prompt 
window will open and then BB Graphical User Interface will start up. 

ο On Mac or Linux:open terminal, change directory to the BB home directory and type: 
sh batchbuildergui.sh and then press Enter. BB Graphical User Interface 
will start up. 

5. To start the Command Line Interface (CLI):  

ο On Windows: run the command prompt (CMD), change directory to the BB home 
directory, type batchbuildercli with required parameters and press Enter. 

Revised: June 2, 2013 
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ο On Mac or Linux: run the Terminal, change directory to the BB home directory and type: 
sh batchbuildercli.sh with required parameters and press Enter. 

1.2 Setting options 

1.2.1 General Batch Builder application options 
There are a few Batch Builder features that are controlled by using View > Options on the file 
menu.  These options will affect all projects. 

 
Batch Builder Default Options 

• Auto-increment new batch directory names.  (Unselected by default.)  When selected, if you 
create a batch directory name that ends with a number, the next time you click Batch->New … 
Batch Builder will use the same directory name but will increment the number to the next 
value.  

• Ignore file validation errors.  (Selected by default.)  When selected, this option forces Batch 
Builder to create a batch even when the FITS tool has detected errors in one or more files in the 
batch.  

Note: this option must be selected when generating PDF Document objects as well as Opaque 
objects.  

• Open last project on application startup. (Unselected by default.)  When selected, on Batch 
Builder startup the most recently used project will open automatically. 

• Verbose logging.  (Selected by default.)  This option is exposed specifically for testing 
purposes. Leave it checked during this testing phase so that LTS staff can troubleshoot Batch 
Builder processing errors. 

• Delete object and directory contents when removing. (Unselected by default). If this option 
is checked, the object and directory contents are removed from disk when removed from within 
BB. This applies to Template directories as well . When this option is not selected, directories 
will remain on your local computer, but will disappear from the BB2 project window. 
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• Copy files when dragging and dropping onto project tree. (Selected by default). BB 2 
introduces drag-and-drop functionality for files. If this option is checked, when files are 
dragged and dropped from a directory on disk onto a file directory in the BB Project Panel the 
files are copied rather than moved.  

1.2.2 File name pattern options for generating file OSNs 
Batch Builder allows users to set file name pattern options to be used when either automatically 
building objects from template or creating objects manually. Note that this option should not be 
used in conjunction with using external mapping files to supply file OSNs (an alternate method of 
supplying file OSNs).  The following file name pattern can be set (these persist for each Batch 
Builder project). 

 
Derive File OSN from File Name (set by default) – this option, when set, results in Batch Builder 
using file name for the file owner supplied name according to one of the options checked below: 

• Use full file name (minus the extension) as file OSN – results in full file name being used as 
OSN.  

ο For all objects except PDS Document objects this accomplishes the following 

 When building objects automatically – this option captures the full file name, including 
the object name prefix, as file OSN. (e.g.: obj1—file1.jpg will result in file OSN 
“obj1—file1”.)  

 When building objects manually - this option captures the full supplied file name as 
file OSN. (e.g: file1.jpg will result in file OSN “file1”.)  

ο For PDS Document objects  using  the file name used as OSN option accomplishes the 
following : 
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 When building objects automatically – this option captures the full file name, including 
the object name prefix and the page sequence number, as file OSN. (e.g.: obj1—
file1__seq1.jpg will result in file OSN obj1—file1__seq1. ) 

 When building objects manually this option, when set, captures the full file name, 
including the page sequence number, as file OSN. (e.g: file1__seq1.jpg will result in 
file OSN file1__seq1.) 

• Use baseName as file OSN – this option results in Batch Builder using file base name, 
excluding the object name prefix, as the file OSN . Don’t use this option for PDS Object if the 
file basename is the same for all the files (only the seq number is different) 

ο For all objects except PDS Document objects this accomplishes the following 

 When building objects automatically – this option captures the file base name, 
discarding the object name prefix, as file OSN. (e.g.: obj1—file1.jpg will result in file 
OSN “file1”. ) 

 When building objects manually this option captures the file base name as file OSN. 
(e.g: file1.jpg will results in file OSN “file1”.)  

ο For PDS Document objects  

 

• Use baseName—pageSeq as file OSN – this option results in Batch Builder using file base 
name and page sequence suffix – if present, but excluding the object name prefix, as the file 
OSN 

ο For all objects except PDS Document objects this accomplishes the following 

 When building objects automatically – this option captures the file base name, 
discarding the object name prefix, as file OSN. (e.g.: obj1—file1.jpg will result in file 
OSN “file1”. ) 

 When building objects manually this option captures the file base name as file OSN. 
(e.g: file1.jpg will results in file OSN “file1”.)  

ο For PDS Document objects 

 When building objects automatically – this option captures the file base name and page 
sequence number as file OSN, discarding the object name prefix. (e.g.: obj1—
file1__seq1.jpg will result in file OSN “file1__seq1”.)  

 When building objects manually this option captures the file base name and the page 
sequence number as file OSN. (e.g: file1__seq1.jpg will result in file OSN 
“file1__seq1”.) 

• Use only pageSeq as file OSN – this option only applies to PDS Document Objects 

ο When building objects automatically – this option  captures the page sequence number as 
file OSN, discarding the object name prefix and the file name. (e..g.: obj1—
file1__seq1.jpg will result in file OSN “seq1”.)  

ο When building objects manually this option captures the page sequence number as file 
OSN. (e.g: file1__seq1.jpg will result in file OSN “seq1”.) 
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1.2.3 Setting options for processing large batches 
When processing large batches – either from large file sizes or the sheer number if files – you may 
get “out of memory errors”.  The threshold is around 30GB.  If you do get memory errors, you will 
need to make adjustments to BB configuration files to assign more memory to Java. 

Note for Windows users:  If you find that you need more than 3GB of RAM to run Batchbuilder, 
you will also need to use a 64-bit version of Windows.  

Assigning more memory to Java 

1. In the main BB program directory use a text editor to open  batchbuildergui.bat (Windows) or 
batchbuildergui.sh (Mac) 

2. Find line starting with ‘java –cp’ 

3. In that line, find the section ‘-Xmx1024m’ and do one of the following: 

• To assign 2GB of RAM, change it to ‘-Xmx2048m’ 

• To assign 3GB of RAM, change it to ‘-Xmx3072m’ 

• To assign 4GB of RAM, change it to ‘-Xmx4096m’ 

4. Save the file 

Use the smallest amount of RAM to get rid of the error to avoid performance problems with your 
local computer. 

When you need to process a large batch, start BatchBuilder using the batchbuildergui.bat or 
batchbuildergui.sh instead of the executable file. 

2. User Interface Basics 
2.1 BB panels 
2.2 BB menus 

The Batch Builder interface includes a menu bar, a tool bar, and three display panels. Context 
menus are also available by right-clicking on certain places within the GUI. 

2.1 BB panels 
In the following screen-shot of the interface, these components are labeled. 
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Message panel displays information 
and error messages as you use the 
application. 

Project panel displays project 
configuration components as well 
as batch directories associated 
with the project. 

Content panel displays project level, object 
level and directory level metadata as well as 
contents of reports and configuration files that 
were selected in the left panel. 

Revised: June 2, 2013 



Batch Builder 2 Beta User Guide Page 10 of 131 
 

The following image shows more details about the project panel.  

 

2.2 BB menus 
There are two sets of menus in BB:  

• Menus accessible from the menu toolbar at the top  

• Context menus accessible by right-clicking a particular item in the Project Panel on the left.  

Menu toolbar 
There are five menus that are accessible from the menu toolbar 

Project menu 

 
• New – create new project. 

• Open – open existing project. 

• Close – close currently open project. 

• Save – save currently open project. 

• Save as … -- save currently open project as a new project. This option saves the project 
configuration file project.conf (which contains all the project metadata settings entered in the 
Deposit Settings and Object Template) into a new directory. This is a useful option to use if 
you are planning to create a new project but the Deposit Settings information or/and Object 
Template information is going to be the same. 

Project directory 
 Object template 

 

Object descriptor 
 

Batch directory 
 

Batch.xml file for this batch 
 Object directory 

 

Reports directory 
 

File directory 
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• Exit – exit the program. 

Batch menu 

 
• New – create a new object batch. 

• Create descriptors & batch.xml – process a selected batch (note that a batch icon for a given 
batch needs to be selected in the Project Panel for this command to become active). 

• Stop creation of batch.xml – stops the creation of batch that is being currently processed (this 
command is only active while a batch is being processed). 

Object menu 

 
• New – create new object (this command is only active if you first select a batch icon of a given 

batch in which object needs to be created in the BB2 Project Panel). 

• Create a new batch with objects from template – create a new batch of objects automatically 
from template. See the “Automatically build [object type] from template” section for a given 
object type in this Guide for procedure (E.g.: 5.2 Automatically build still image objects from 
template). 

View menu 

 
• Options – view the options dialog. See section 1.2 Setting options for more information.  

• Clear messages – clears messages from the messages panel. 

• Reload tree – reloads the Project Panel tree (useful when you want to see the latest changes 
made in the project panel). 

• Toolbar – show / hide toolbar with action icons . 
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Help menu 

 
• About  -- information about Batch Builder version and built date. 

• Contents – link to Batch Builder 2 User Guide. 

Context menus 
There are six types of context menus that are available in BB2 – all from the Project Panel. These 
are: 

1. Project context menu 

2. Object template context menu 

3. Object template directory context menu 

4. Batch context menu 

5. Object context menu 

6. Object directory context menu 

These context menus are described below in more detail. 

Project context menu 

Right-clicking on the project icon (P) will open a context menu that allows you to create a new 
batch. 

 
 

Object template context menu   

Right-clicking on the object template icon (T) will open a menu where you can add a new directory 
or automatically create a batch of objects from template. 
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Object template directory context menu   

Right-clicking on the directory icon will open a context menu where you can add a new directory 
nested inside the present one or remove a directory. 

 
 

Batch context menu   

Clicking on the batch icon (B) opens a context menu where you can create a new object, process 
the batch and remove the batch. 

 
 

Object context menu   

Right-clicking on the object icon (O) will open a context menu where you can add new directory, 
rename an object and remove and object. 
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Note that the right way to rename an object after it was created in BB is to use this menu option. 
Renaming the object directory on disk outside BB is not sufficient and will lead to errors when 
trying to open the project in BB afterward. 

Object directory context menu 

Right-clicking on the directory icon will open a context menu where you can add a directory 
(nested inside the current directory) or remove the current directory 

 
 

3. Naming Rules for Objects, Files and Directories 
File names on disk 
Object and batch directory names on disk 
File owner supplied names 
Object owner supplied names 

File names on disk 
For all files in an object: 

• Maximum number of characters per file name is 100.  LTS recommends that file names be kept 
to 64 characters or less, and that the complete_directory_path + file_name for each file be kept 
to 255 characters or less. 

• Valid characters in file names are letters, digits, '.', underscores ('_'), and hyphens ('-'). 

• File names should not contain spaces. 

Files that share a derivative relationship (e.g., a production master .tif file and its related 
deliverable .jpg or .jp2 file) should share the same file name in order for Batch Builder to 
determine that the relationship exists (e.g. clocktower.tif and clocktower.jpg). 
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The file name of a digital file will be changed once the file is in DRS storage.  At the point of 
deposit, DRS assigns each file a numeric DRS identifier.  The file name will be the DRS ID 
followed by the format extension (e.g., 5844020.tif, 5844022.jpg).   

The original file name is preserved in DRS metadata. The DRS load report that is sent after a 
successful DRS deposit will associate the file’s DRS ID with the original file name (FILE-
ORIGPATH).  Also, if you use Batch Builder’s default method for assigning owner supplied name, 
the original file name (minus format extension) will be preserved in DRS metadata as the owner 
supplied name. In the case of PDS documents, the original filename will be the part of the owner 
supplied name before the double underscore (e.g. ‘doc1’ in the owner supplied name ‘doc1__seq1’) 

Object and batch directory names on disk 
• Maximum directory name length is 100 characters.  

• No spaces are allowed in batch or object directory names 

• Valid directory name characters are letters, numbers, underscores ('_') and hyphens ('-'). 

File owner supplied names 
File owner supplied name (file OSN) serves as an identifier that can be used to link files deposited 
into the DRS with local information about the files (such as local accession numbers or 
classification numbers).   

An owner supplied name is generally optional for files and need not be unique, except in the case 
of: 

• images linked to OLIVIA 

• audio files, if a playlist is in use 

Failure to supply a unique OSN in these cases will prevent access to these files. 

There are three ways of supplying a file OSN: 

1. Use file name for file OSN. When using this option, set the file name pattern preferences 
for generating file OSNs in Batch Builder Options menu. See Section 1.2.2 for more 
information. 

2. Supply file OSNs using an external mapping file. To find out more about using mapping 
files see section 12 Using External Mapping Files to Supply ownerSuppliedNames, Page 
Sequence Numbers and Aleph IDs of this document. 

3. Supply file OSNs on Command Line Interface (CLI) during batch processing. For more 
details about CLI see “Processing Batches Using Command Line Interface” in this Guide. 

Recommendations for file owner supplied names: 

• Owner supplied names should not exceed 100 characters.   

• Only alpha-numeric characters and these symbols should be used: 
'.', underscores ('_'), and hyphens ('-'). 

Object owner supplied names 
Object owner supplied name (object OSN) serves as an identifier that can be used to link objects 
deposited into the DRS with local information about them (such as local accession numbers or 
classification numbers).  Each object requires an owner supplied name.   
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Tip: Within a DRS owner code, the object  Owner Supplied Name must be unique.  

There are four ways of supplying object OSNs: 

1. Enter Object OSN manually when creating a new object in Batch Builder (Note that you have 
to create a batch first, before you can create a new object). For the procedure see a subsection 
“Manually create [content model] objects from template” in a section on how to create object 
batches of a given content model in this Guide (e.g.: 5.1 “Manually create still image objects 
from template” in section 5 “Creating and processing still image object batches.”). 

2. Have BB create object OSNs for you when it is building object batches automatically from 
template.  In this case you need to add object name prefix to file names (the syntax is:  1) for 
all objects except PDS Document Objects:[object_osn]--
[filename].[extension]; 2) for PDS Document Objects: 
[object_osn]--[filename]_ _[pageSeq].[extension])  or supply 
mapping.txt file in order for BB to associate files with objects. For the procedure see a 
subsection “Automatically build [content model] objects from template” in a section on how to 
create object batches of a given content model in this Guide (e.g.: 5.2 “Automatically build still  
image objects from template” in section 5 “Creating and processing still image object 
batches.”).  See also Section 1.2.2 for additional information on setting file name patterns in 
the BB Options dialog. 

3. Supply object OSN using Command Line Interface (CLI) during batch processing (Note that to 
use this option you need to have an existing object with an object OSN. The new object OSN 
supplied in CLI overwrites the object OSN that was given to the object at the time it was 
originally created.).  For more details about CLI see section  11 “Processing Batches Using 
Command Line Interface” in this Guide. 

4. Supply object OSN using external mapping file during batch processing (Note that to use this 
option you need to have an existing object with an object OSN. The new object OSN supplied 
in the external mapping files overwrites the object OSN that was given to the object at the time 
it was originally created.). To find out more about using mapping files see section 12 Using 
External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph 
IDs of this document. 

Recommendations for owner supplied names: 

• The number of characters per owner supplied name should not exceed a 100.   

• Only alpha-numeric characters and these symbols should be used: 
'.', underscores ('_'), and hyphens ('-'). 

4. Object and Batch Directories Structure and Contents 
Object directory structure and contents 
An object directory structure is generated by Batch Builder when a new object is created. The 
object directory structure is dependent on the content model. For instance, a Still Image object 
directory structure may look like this: 

Revised: June 2, 2013 



Batch Builder 2 Beta User Guide Page 17 of 131 
 

 
Nested directories indicate a derivative relationship where a file in the top directory serves as a 
source of the files in the subdirectories. Each object type has a set of required directory name 
prefixes (such as “image” for Still Image object type). Custom names can be appended to the 
required prefixes. Batch Builder automatically enforces object directory structure and required 
directory prefixes based on the content model selected. 

After a batch is processed Batch Builder will place a descriptor.xml file at the top level of each 
object directory. No other files should be stored there.  

Batch directory structure and contents 
All objects within a batch must be located in a batch directory.  The top level of this directory 
should contain only the batch control file (batch.xml) and object directories.  No other file should 
be stored in the top-level batch directory.  

  

Required prefix 

Appended custom name 

Obj1/ 
  /image 
    /image-derivative1 
    /image-derivative2 
    /etc. 
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5. Creating and Processing Still Image Object Batches 
5.1 Manually create still image objects from template 
5.2 Automatically create still image objects from template 

There are three methods you can use to create Still Image objects in Batch Builder: 

1. Manually create objects from template. This is best for small batches (10 objects or less). In 
this scenario you generate an object structure in BB for each object and then copy files into it 
(can be done outside BB). See section 5.1 for the procedure. 

2. Automatically build objects from template. This method is best for large batches of objects 
(over 10 objects). In this scenario BB generates object structure for each of your objects and 
moves files into object directories. Before this can happen you need to rename your files to add 
special “object name” file prefixes or provide mapping files that associate files with their 
objects. See section 5.2 for the procedure. 

3. Manually create objects without using the template. In this method, rather than using the 
template, you fill out object and file metadata and create object directories for each individual 
object one-object-at-a-time. This method is useful when object properties such as Owner Code, 
Billing Code and URN authority path are different for each object. Because this option will be 
rarely used, it is not currently documented.  

5.1 Manually create still image objects from template 
This is a description of the procedure to manually create a batch of Still Image objects from 
template in Batch Builder 2 (BB).  This method is a good choice when creating a batch with a 
small number of objects.  To create a batch with many objects (over 10), the automatic object 
creation procedure may be more efficient.   

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directories to object template. 

5. Create a new batch and objects. 

6. Move/copy files into corresponding directories on disk. 

7. Process the batch. 

8. Upload batch to dropbox 

9. Check load report in email 

What you need before you start:  
• Prepare several digital images and put them in a directory of your choice somewhere on local 

hard disk or network drive.  If you have more than one file per image (e.g.: an archival master 
and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names 
match (e.g.: image-1.tif, image-1.jp2 and image-1.jpg). Consult section 3 
Naming rules for files, objects and directories of this Guide for more information. 
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• Decide what you will use for owner supplied names for image objects and the digital image 
files they consist of. For instance, you could use local classification or local accession 
numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for 
more information. 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 

Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 

TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. 
museum_slide_project) 

Content Model: select the "still image" value from the dropdown. 

Project Description (optional): Any information relevant to the project – will only remain 
locally. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 

Batch Name Pattern:  default - 
{owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss} 

(This is the name for a batch that appears on DRS deposit reports.) 

[Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 
Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific object metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
Object Access:  the DRS access flag.  At this level, select the least restrictive value if the 
batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  use default value {n} to generate a unique number. 
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c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, 
roles and relationships that will apply to your objects). For more about optional metadata 
see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding 
Licenses, Documentation and Other Supporting Content.   

4. Add directories to template: 

For one image file per object: 

Add directory: 

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add 
a directory…” menu option. 

b. Type in a name for your directory in the text box . The directory name will start with 
“image” but the name you type will be appended to it.  Tip: to make it easier to read, start 
your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a 
directory called ‘image_tifs_and_jpegs’ 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “HIGHUSE” for Usage Class. 

 

Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to “Still Image File Metadata” 

d. Enter any file level optional metadata in the form 

Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 

For multiple image files per object (e.g.: a file for archival master and a separate file for 
deliverable) you need to create a directory for the master file and a nested sub-directory for 
each derivative file.  (This is needed for BB to determine the derivative relationship). 

 Add a master directory:  

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add 
a directory…” menu option. 

b. Type "-archival_master" or a similar suffix that describes the role for your directory in the 
text box. The directory name will start with “image” but the name you type will be 
appended to it.  So, typing ‘-archival_master’ will result in a directory called ‘image-
archival_master’ 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “LOWUSE” for Usage Class. 
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Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 

d. Enter any file level optional metadata in the form 

Role: select ARCHIVAL_MASTER. 

Add a nested directory for derivative (e.g. a directory for deliverable images): 

a. Right click on the directory you just created in the Project Panel on the left and select the 
‘add a directory…” menu option. 

b. Type "-deliverable" or a similar suffix that describes the role for your directory in the text 
box. The directory name will start with “image” but the name you type will be appended to 
it.  So, typing ‘-deliverable’ will result in a directory called ‘image-deliverable’ 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “no” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “HIGHUSE” for Usage Class. 

Add additional metadata for this derivative subdirectory (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 

d. Enter any file level optional metadata in the form 

Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to 
get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB 

e. Repeat steps 3 and 4 to create additional nested directories if you have more files derived 
from the current one.  

f. Save your work (Project > Save on main menu). 

5. Create new batch with objects: 
Metadata added at this level can be applied to a specific object, or specific file directory.  

a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch 
(will be used as the batch directory name on disk).  Click OK. 

Tip: including the word "batch" in the name will help you remember the directory’s 
purpose on the file system.   

b. Select the batch (with the red letter B) in the Project Panel 

c. From the main menu select Object > New; leave Content Model at default (FROM 
TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and 
click OK.  
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d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new 
object (blue letter O)   

e. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note: any 
metadata entered at the object level will override metadata entered at the template level. 

f. Repeat b-e if you have more than object. 

g. Save your project (Project > Save on main menu). 

6. Copy image files into batch object directories on disk (can be done outside Batch Builder). 

Note: if you need to check where the batch/object directories are on disk, click on "Deposit 
Settings" in the Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary object path in the project. 

7. Process the batch: 

a. In the Project Panel tree, right click on the batch you want to process (batch icon with a 
red letter B) and select “Create descriptors and batch.xml.” 

Processing messages will appear in the messages pane.  

b. When the batch is successfully processed you will see the following message: FINISHED 
Creation of batch.xml and descriptors complete for batch: 

8. Upload batch to dropbox. 

a. Open your SFTP client and log into your DRS2 training dropbox account. 

b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

9. Check load report in email. 

a. Open your email inbox. 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

For a more readable report, open the attached text file in Excel, or just copy the file listing and 
paste into Excel.   If you see any error messages, remedy the errors and re-process the batch.  
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5.2 Automatically build still image objects from template 
This is a description of the procedure to automatically build a batch of still image objects from 
template using Batch Builder 2 (BB). Use this method if you have a large number of objects (more 
than 10) that need to be created and your source files are not broken into directories by object. 

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit information. 

3. Create the object template. 

4. Add directories to the object template. 

5. Repeat steps in (4) for additional nested directories if needed. 

6. Save your work 

7. Move/copy images into the object template. 

8. Create a new object batch. 

9. Process the batch. 

What you need before you start: 
• Prepare digital images and put them in a directory of your choice somewhere on local hard disk 

or network drive.  If you have more than one file per image (e.g.: an archival master and a 
deliverable or an archival master, a deliverable and a thumbnail) make sure file names match 
(e.g.: image-1.tif, image-1.jp2 and image-1.jpg).  

• Decide what you will use for owner supplied names for image objects and the digital image 
files they consist of. For instance, you could use local classification or local accession 
numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for 
more information. 

• Make sure you either provide object name prefixes for each file to specify which objects it 
should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or 
provide object assignment for your file in an external mapping file. For more details about 
providing object prefixes for your files see section 1.2.2. For more details about external 
mapping files see section 12.1. 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 

Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 

TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. 
museum_slide_project) 
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Content Model: select the "still image" value from the dropdown. 

Project Description (optional): Any information relevant to the project – will only remain 
locally. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 

Batch Name Pattern:  default - 
{owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss} 

(This is the name for a batch that appear on DRS deposit reports.) 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 
Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific object metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

c. DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
Object Access:  the DRS access flag.  At this level, select the least restrictive value if the 
batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  use default value {n} to generate a unique number. 

d. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, 
roles and relationships that will apply to your objects). For more about optional metadata 
see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding 
Licenses, Documentation and Other Supporting Content.   

4. Add directories to template: 

In automatic object workflow, you create role-based directories (archival master, deliverable) 
and in a later step, Batch Builder will create the objects for you. 

For one image file per object: 

Add directory: 

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add 
a directory…” menu option. 

b. Type in a name for your directory in the text box . The directory name will start with 
“image” but the name you type will be appended to it.  Tip: to make it easier to read, start 
your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a 
directory called ‘image_tifs_and_jpegs’ 
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c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “HIGHUSE” for Usage Class. 

 

Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 

d. Enter any file level optional metadata in the form 

Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 

For multiple image files per object (e.g., archival master, deliverable), you need to create a 
directory for the master file and a nested sub-directory for each derivative file.  

Add a master directory:  

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add 
a directory…” menu option. 

b. Type "-archival_master" or a similar suffix that describes the role for your directory in the 
text box. The directory name will start with “image” but the name you type will be 
appended to it.  So, typing ‘-archival_master’ will result in a directory called ‘image-
archival_master’ 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “LOWUSE” for Usage Class. 

 

Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 

d. Enter any file level optional metadata in the form 

Role: select ARCHIVAL_MASTER. 

e. Add a nested directory for derivative (e.g. a directory for deliverable images): 

f. Right click on the directory you just created in the Project Panel on the left and select the 
‘add a directory…” menu option. 
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g. Type "-deliverable" or a similar suffix that describes the role for your directory in the text 
box. The directory name will start with “image” but the name you type will be appended to 
it.  So, typing ‘-deliverable’ will result in a directory called ‘image-deliverable’ 

h. In the Project Panel on the left select the directory you just created. 

i. In the Content Panel on the right, choose “no” from the dropdown list for the field “First 
Generation in DRS”. 

j. Choose “HIGHUSE” for Usage Class. 

 

Add additional metadata for this derivative subdirectory (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 

d. Enter any file level optional metadata in the form 

Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to 
get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB 

e. Repeat steps 3 and 4 to create additional nested directories if you have more files derived 
from the current one.  

5. Save your work (Project > Save on main menu). 

6. Copy image files into Batch Builder template directory on disk (can be done outside Batch 
Builder). 

The directories you created in BB have been created on disk, in the project’s template path: 

{project_name}\template\ 

In order to tell BB which object each file should end up with you need to either add object 
name prefixes to each file name or supply a mapping.txt file that associates each file with its 
future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using 
mapping.txt file for how to create a mapping file. 

In the automatic workflow, files with the same role (archival master, deliverable) are copied 
into the corresponding role-based directory.  In a later step, Batch Builder will use the object 
name prefix for each file to create object directories and move files for each object into these 
directories. 

Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the 
Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
template directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary template path in the project. 

7. Create a new object batch. 
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You can create your new object batch in the Graphical User Interface or using the Command 
Line Interface (CLI).  

In the Graphical User Interface 

a. From the Object menu in BB select “Create a new batch with objects from template”; enter 
the name of the batch directory to be created on disk and click OK.  A new batch icon will 
be added to the Project Panel on the right (icon with a red letter B) and new objects will be 
built that are going to be part of this batch. 

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to 
expand the tree – it will show the icons for the new objects (a blue letter O). 

c. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that 
any metadata entered at the object level will override metadata entered at the template 
level. 

d. Save the project to have BB2 write the new metadata values to the internal configuration 
files. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33 

Type bathcbuildercli –a buildtemplate –p 
[project_directory_path] –b [batch_directory_name]. 

Example: 
batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1 

Note that the batch directory name is the name of your new batch directory, to be created 
by BB. 

b. If the batch creation is successful you will see the following messages: 
Initializing BB... 

Done! 

Creating batch1 and objects from files in the template... 

Success! 

8. Process the batch. 

You can process your batch in the Graphical User Interface (GUI) or using the Command Line 
Interface (CLI). 

In the In the Graphical User Interface 

a. In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  
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c. When the batch is successfully processed you will see the following message: FINISHED 
- Creation of batch.xml and descriptors complete for batch …. 

If you see any error messages, remedy the errors and re-process the batch. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33 

d. Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.: 
batchbuildercli -a build -p “E:\My Project” -b batch1 

b. (Optional) add additional parameters to the bathcbuildercli command to substitute 
batch, object and directory level properties. For more information see section 11. 
Processing Batches Using Command Line Interface. 

c. When the batch is successfully processed you will see the following messages: 
Building PREMIS file metadata... 

Building HulDrsAdmin file metadata... 

Success! 

If you see any error messages at the end of batch processing, remedy the errors and re-process 
the batch (you can disregard any errors showing during batch processing on command line as 
long as you get the final “Success!” message). 

5.3 Processing images for OLIVIA 
Procedure summary: 

1. Create a new project. 

2. Enter deposit settings. 

3. Create object template. 

4. Add directories to object template. 

5. Follow manual or automatic object creation process as described in sections 5.1 or 5.2 to create 
objects and process the batch. 

Steps: 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data: 

Project Name:  enter a name for your project (used for internal tracking only). 
Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 
Content Model: select the "still image" value from the dropdown. 

Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 
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b. Enter deposit data in the form: 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 

Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific object metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
Object Access:  the DRS access flag.  At this level, select the least restrictive value if the 
batch will contain a mix of public and restricted files. 
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  use default value {n} will generate a unique number. 

c. Enter optional admin and descriptive metadata to the object template. Click the 
“optional” tab to enter any optional metadata (for example descriptive metadata, roles 
or/and relationships that will apply to your objects). 

For more about optional metadata see: Adding Relationships, Adding Descriptive Metadata, or 
Adding Licenses, Documentation and Other Supporting Content. 

4. Add directories to object template. 

a. For one image file per object (e.g. one JP2 as both master and deliverable): 

Add directory: right click on “Object Template” in Project Panel tree.  The new directory 
name will start with “image” but you can append a custom suffix. 

Add metadata: click to select the new directory, then add metadata to the form: 

In the ‘Required’ tab: 

  First Generation in DRS: select "yes". 
  Usage Class: select "HIGHUSE". 

In the ‘Optional’ tab (this is required for OLIVIA / VIA workflow): scroll down to "Still 
Image File Metadata": 

Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note 
that in order to get a delivery URN on deposit and for a file to get linked in OLIVIA a file 
needs to have a role DELIVERABLE set in BB. 

Quality: Select ‘5’ from the dropdown list (required for OLIVIA / VIA workflow) 

b. For multiple image files per object (e.g., archival master, deliverable), you need to create 
a directory for the master file and a nested sub-directory for each derivative file. 

Add a master directory: right click on “Object Template” in Project Panel tree to create 
an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that 
describes the role. 
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Add metadata for the master directory: click to select the new directory, then add 
required metadata to the form: 

In the ‘Required’ tab: 
First Generation in DRS: select "yes". 
Usage Class: select "LOWUSE". 
 
In the ‘Optional’ tab: scroll down to "Still Image File Metadata": 
Role: select ARCHIVAL_MASTER. 

Quality: select a value higher than ‘5’ from dropdown list (any value higher than ‘5’ is 
allowed - ‘10’ is the highest quality) 

Add a nested directory for derivative (JP2s or JPEGs): right click on the directory you 
just created and create another directory nested inside it (e.g., a directory for deliverable 
images).  Add a suffix for this derivative (e.g., "-deliverable"). 

Add metadata for this derivative subdirectory: click to select the new subdirectory, then 
add metadata to the form: 

In the ‘Required’ tab: 
First Generation in DRS: select "no":. 
Usage Class: select "HIGHUSE". 

In the ‘Optional’ tab (required for OLIVIA / VIA workflow): scroll down to "Still Image 
File Metadata": 

Role: select ‘DELIVERABLE.  Note that in order to get a delivery URN on deposit and 
for a file to get linked in OLIVIA a file needs to have a role DELIVERABLE set in BB. 

Quality: Select ‘5’ from the dropdown list (required for OLIVIA / VIA workflow) 

Add a second nested directory if thumbnails are needed. 
 If your deliverables are JPEGs, create an additional nested directory for a thumbnail 
image. Right click on the deliverable directory you just created for large delivery images 
and create another directory nested inside it.  Add a suffix for this derivative (e.g., "-
thumb"). 

c. Click to select the new subdirectory, then add metadata to the form: 

In the ‘Required’ tab: 
First Generation in DRS: select "no":. 
Usage Class: select "HIGHUSE". 

In the ‘Optional’ tab (required for OLIVIA / VIA workflow): scroll down to "Still Image 
File Metadata": 

Role: select ‘DELIVERABLE.  Note that in order to get a delivery URN on deposit and 
for a file to get linked in OLIVIA a file needs to have a role DELIVERABLE set in BB. 

Quality: Select ‘1’ from the dropdown list (required for OLIVIA / VIA workflow) 

d. Repeat steps a and b to create additional nested directories if you have more files derived 
from the current one. 

e. Save your work (Project > Save on main menu). 

5. Follow instructions in section 5.1 for manually creating a batch of objects or in section 5.2 for 
automatically creating a batch of objects from template and then process the batch. 
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6. Creating and Processing PDS Document Object Batches 
6.1 Accepted formats 
6.2 File name rules 
6.3 Procedures to create a batch 

PDS Document objects are page-turned objects that can be delivered by the DRS Page Delivery 
Service (PDS). Each object can be composed of multiple files, each representing either a page 
image, a page text or (optionally) the page text together with the layout  (ALTO files).  

All PDS Document objects automatically get assigned public delivery service URNs, which resolve 
to the Page Delivery Service (PDS) URLs. Individual files within a PDS Document object do not 
automatically get assigned public delivery service URNs. 

6.1 Accepted formats 
PDS Document objects can contain files in the following formats: 

Page Image 

• JPEG 2000 JP2 image files (file extension: jp2) 

• JPEG File Interchange Format image files (file extension: jpg) 

• Graphic Interchange Format (GIF) image files (file extension: gif) 

• Tagged Image File Format (TIFF) image files (file extension: tif or tiff) 

Page Text 

• Plain UTF-8 encoded text (file extension: txt) 

Page Layout 

• Extensible Markup Language (XML) Files (file extension: xml) 

The file extensions noted above are mandatory.  

6.2 File name rules 
This topic describes specific file name requirements for page-turned object batches.  See Naming 
Rules for Objects, Files and Directories for general Batch Builder requirements. 

Page image, page text and page layout file naming 
The file-naming scheme for page image, text and page layout files in page-turned object is: 

     {fileBaseName}{separator}{sequenceNumber}.{extension} 

where: 

{fileBaseName} is usually a locally-meaningful name, for example a name that associates the 
digital file with an analog counterpart.  This may be an accession number, Aleph ID or other 
curatorially-significant name. Valid characters to use for the {fileBaseName} are letters, digits, '.', 
underscores ('_'), and hyphens ('-' ).  

{separator}  is a double underscore (‘__’) used to separate the {fileBaseName} from the page 
sequence number.   
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{sequenceNumber} is the numeric value that represents the sequence number of the page within 
the page-turned document.  A sequenceNumber can be composed of any of the following 
characters: 0123456789.   

The sequence number can include leading zeros, for example the third page can be written as: 3 or 
03 or 000000003.  The page sequence number indicates a page's relative position within a sequence 
of pages, regardless of the numbering that may appear on the page.   

.{extension} is one of the valid file extensions at the beginning of this topic. 

By default Batch Builder assumes that fileBaseName plus the separator and the page sequence 
number is the file OwnerSuppliedName. E.g.: in a file 12345__01.tif Batch Builder will assume 
that 12345__01 is the file OwnerSuppliedName. This default can be changed in View-Options 
menu. See section 1.2 Setting Options. 

Alternatively, instead of using the file naming scheme the file OwnerSuppliedName, the page 
sequence number and the object OwnerSuppliedName can be supplied in a special mapping file 
called “mapping.txt”. More about mapping files…  

6.3 Procedures to create a batch 
6.3.1 Manually create PDS Document objects from template 
6.3.2 Automatically build PDS objects from template 
6.3.3 Use externally generated METS file to build structure-rich PDS objects 

6.3.1 Manually create PDS Document objects from template 
This is a description of the process to manually create a PDS Document object batch using Batch 
Builder 2 (BB). This method is best to use when you have only one or two PDS objects in your 
batch. 

Procedure summary: 
1. Create a new project 

2. Enter DRS deposit settings 

3. Create object template 

4. Add directories to template 

5. Create a new object batch 

6. Move/copy files into corresponding batch directories on disk 

7. Process the batch 

8. Upload batch to dropbox 

9. Check load report in email 

What you need before you start: 
• Prepare a batch of page images and (optionally) accompanying machine readable text and 

XML layout (Alto) files that constitute a future PDS Document object and put them in a 
directory of your choice somewhere on local hard disk or network drive.  If you have more 
than one file per page image (e.g.: an archival master and a deliverable or an archival master, a 
deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 
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and file1.jpg). The file names of text files and XML layout (Alto) files should match the 
file names of the page images files (e.g.: file1.tif, file1.jp2 file1.jpg, 
file1.txt, file1.xml). 

• Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: 
[fileBaseName]__[sequence_number].[extension]. E.g.: file1__1.jpg, 
file2__2.jpg, etc. Check Section 1.2.2 of this Guide for more information about setting 
file name patterns in BB. Alternatively, instead of supplying appended sequence numbers you 
can provide them via the external mapping file called mapping.txt. See section 12. Using 
External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph 
IDs for more information. 

• Decide what you will use for Owner Supplied Names for your object and the digital image files 
it consists of. For instance, you could use local classification or local accession numbers or an 
ALEPH ID. 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 
Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 
Content Model: select the value "PDS document" from the dropdown. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 

Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific batch-, object-, or directory-level metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
File Access Flags:  the DRS access flag for the files.  At this level, select the least 
restrictive value if the batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path. Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
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URN Resource Name Pattern:  default value {n} will generate a unique number. See 
Metadata Reference for more values for this field. 

c. Enter optional admin and descriptive metadata to the object template. Click the “optional” 
tab to enter any optional metadata (for example descriptive metadata, roles or/and 
relationships that will apply to your objects).  

For more about optional metadata see sections 14. Adding Relationships, 15. Adding 
Descriptive Metadata, and 16. Adding Licenses, Documentation and Other Supporting 
Content. 

4. Add directories to template: 

Image directories 

For one image file per page image: 

a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory 
name will start with “image” but you can append a custom suffix. 

b. Add metadata: click to select the new directory, then add metadata to the form: 

In “required” tab: 

   First Generation in DRS: select "yes". 
   Usage Class: select "HIGHUSE". 

In “optional” tab: scroll down to "Still Image File Metadata": 

   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 

For multiple image files per page image (e.g., archival master, deliverable), you need to 
create a directory for the master file and a nested sub-directory for each derivative file.  

a. Add a master directory: right click on “Object Template” in Project Panel tree to create 
an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that 
describes the role.  

b. Add metadata for the master directory: click to select the new directory, then add 
required metadata to the form: 

In “required” tab: 
   First Generation in DRS: select "yes". 
   Usage Class: select "LOWUSE". 

In “optional” tab: scroll down to "Still Image File Metadata": 

   Role: select ARCHIVAL_MASTER. 

c. Add a nested directory for derivative: right click on the directory you just created and 
create another directory nested inside it (e.g., a directory for deliverable images).  Add a 
suffix for this derivative (e.g., "-deliverable").  

d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then 
add metadata to the form: 

In “required” tab: 
   First Generation in DRS: select "no":. 
   Usage Class: select "HIGHUSE". 
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In “optional” tab: scroll down to "Still Image File Metadata": 

   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order 
to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB. 

e. Repeat the previous steps to create additional nested directories if you have more files 
derived from the current one.  

f. Save your work (Project > Save on main menu). 

Text directories 

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “text” but you can append 
a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

Layout directories (for Alto coordinates files) 

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “layout” but you can 
append a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “LOWUSE” for Usage Class. 

5. Create new batch with objects: 

Note: Metadata added at this level can be applied to a specific object or file directory.  

a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch 
(will be used as the batch directory name on disk).  Click OK. 

Tip: including the word "batch" in the name will help you remember the directory’s 
purpose on the file system.   

b. Click to select new batch in Project Panel tree.  (Look for red letter B). 

c. Create new object from template: select Object > New from the main menu.  Enter the 
name of the object (by default, will be used as object OSN).  Make sure this object name is 
unique!  Click OK.  (Look for blue letter O). 

d. Enter optional metadata for each object and file.  Click the object directory in the Project 
Panel tree and select the “optional” tab on the right to enter optional metadata (for example 
descriptive metadata, roles or/and relationships that will apply to your objects).  

For more about optional metadata see sections Adding Relationships, Adding Descriptive 
Metadata, Adding Licenses, Documentation and Other Supporting Content. Note that any 
metadata entered at the object level will override metadata entered at the template level. 

e. Repeat the previous steps to create additional objects (if you have more than one object in 
the batch). 
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f. Save your project (Project > Save on main menu). 

6. Copy files into batch object directories on disk (done outside Batch Builder). 

Page image files go into an object's "image" directory.  Text files go in a "text" directory.  
Layout files go in a "layout" directory.  

Note: if you need to check where the batch/object directories are on disk, click on "Deposit 
Settings" in the Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary object path in the project. 

7. Process the batch: 

a. In the Project Panel tree, right click on the batch you want to process (batch icon with a 
red letter B) and select “Create descriptors and batch.xml.” 

b. Processing messages will appear in the messages pane.  

c. When the batch is successfully processed you will see the following message: FINISHED - 
Creation of batch.xml and descriptors complete for batch: 

8. Upload batch to dropbox. 

a. Open your SFTP client and log into your DRS2 dropbox account. 

b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

9. Check load report in email. 

a. Open your email inbox. 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

For a more readable report, open the attached text file in Excel, or just copy the file listing and 
paste into Excel.    
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6.3.2 Automatically build PDS objects from template 
This is a description of the procedure to automatically build a batch of PDS Document objects from 
template using Batch Builder 2 (BB). Use this method if you have more than two PDS Document 
objects in your batch. 

Procedure summary: 
1. Create a new project.  

2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directories to template. 

5. Move/copy files into template directory. 

6. Create an new object batch 

7. Process the batch. 

What you need before you start: 
• Prepare a batch of page images and (optionally) accompanying machine readable text files and 

put them in a directory of your choice somewhere on local hard disk or network drive.  If you 
have more than one file per page image (e.g.: an archival master and a deliverable or an 
archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, 
file1.jp2 and file1.jpg). The file names of text files should match the file names of the page 
images files as well (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt). 

• Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: 
[fileBaseName]__[sequence_number].[extension]. E.g.: file1__1.jpg, 
file2__2.jpg, etc. Alternatively, instead of supplying appended sequence numbers you 
can provide them via the external mapping file called mapping.txt. See section 12. Using 
External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph 
IDs for more information. 

• Decide what you will use for Owner Supplied Names (OSNs) for your object and the digital 
image files it consists of. For instance, you could use local classification or local accession 
numbers or an ALEPH ID. 

• Make sure that the object OSNs are supplied for each file by one of the following methods: 

ο Append the object prefix to each file name (the syntax is [objprefix]--
[fileBaseName]__[pageSeq].[ext]). Set the desired file name pattern objects in 
the BB Options dialog (see section 1.2.2 for more information). 

ο Supply an external mapping file that maps each file to object (see section 12.1 for more 
information). 

Procedure:  
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 
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b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 
Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 
Content Model: select the "PDS document" value from the dropdown. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 

Note: Metadata added at this level will be applied to every object in a batch, unless overridden 
by specific object-level metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
File Access Flags:  the DRS access flag for the files.  At this level, select the least 
restrictive value if the batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  default value {n} will generate a unique number. 

c.  Enter optional admin and descriptive metadata to the object template. Click the 
“optional” tab.   

IDS URN for Deliverable JPG and JP2: Select "Yes" if you need IDS URNs for all 
deliverable images in the batch. 

4. Add directories to template: 

In automatic object workflow, you create role-based directories (archival master, deliverable) 
and in a later step, Batch Builder will create the objects for you. 

Image directories 

For one image file per page image: 

a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory 
name will start with “image” but you can append a custom suffix. 

b. Add metadata: click to select the new directory, then add metadata to the form: 

Required: 

   First Generation in DRS: select "yes". 
   Usage Class: select "HIGHUSE". 
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Optional: scroll down to "Still Image File Metadata": 

   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.   Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 

For multiple image files per page image (e.g., archival master, deliverable), you need to 
create a directory for the master file and a nested sub-directory for each derivative file.  

a. Add a master directory: right click on “Object Template” in Project Panel tree to create 
an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that 
describes the role.  

b. Add metadata for the master directory: click to select the new directory, then add 
required metadata to the form: 

Required: 
   First Generation in DRS: select "yes". 
   Usage Class: select "LOWUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role: select ARCHIVAL_MASTER. 

c. Add a nested directory for derivative: right click on the directory you just created and 
create another directory nested inside it (e.g., a directory for deliverable images).  Add a 
suffix for this derivative (e.g., "-deliverable").  

d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then 
add metadata to the form: 

Required: 
   First Generation in DRS: select "no":. 
   Usage Class: select "HIGHUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order 
to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB. 

e. Repeat previous steps to create additional nested directories if you have more files derived 
from the current one.  

f. Save your work (Project > Save on main menu). 

Text directories  

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “text” but you can append 
a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

Layout directories (for Alto coordinates files) 
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a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “layout” but you can 
append a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “LOWUSE” for Usage Class. 

5. Copy files into Batch Builder template directories on disk (can be done inside or outside of 
Batch Builder). 

The directories you created in BB have been created on disk, in the project’s template path: 

{project_name}\template\ 

In order to tell BB which object each file should end up with you need to either add object 
name prefixes to each file name or supply a mapping.txt file that associates each file with its 
future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using 
mapping.txt file for how to create a mapping file. 

In the automatic workflow, files with the same role (archival master, deliverable, text, layout) 
are copied into the corresponding role-based directory.  In a later step, Batch Builder will use 
the object name prefix for each file to create object directories and move files for each object 
into these directories. 

Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the 
Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
template directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary template path in the project. 

6. Create a new object batch. 

You can create your new object batch in the Graphical User Interface or using the Command 
Line Interface (CLI). 

In the Graphical User Interface 

a. From the Object menu in BB select “Create a new batch with objects from template”; enter 
the name of the batch directory to be created on disk and click OK.  A new batch icon will 
be added to the Project Panel on the right (icon with a red letter B) and new objects will be 
built that are going to be part of this batch. 

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to 
expand the tree – it will show the icons for the new objects (a blue letter O). 

c. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata that applies specifically 
to your object (for example descriptive metadata or Aleph ID, administrative categories, 
etc.). Note that any optional metadata that applies to all objects in the batch should be 
entered in the object template before your batch is created. For more about optional 
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metadata see sections Adding Relationships, Adding Descriptive Metadata, Adding 
Licenses, Documentation and Other Supporting Content. Note that any metadata entered at 
the object level will override metadata entered at the template level. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a buildtemplate –p 
[project_directory_path] –b [batch_directory_name]. 

Example: 
batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1 
 
Note that [batch_directory_name] is the name of your new batch directory, to be created by 
BB. 

If the batch creation is successful you will see the following messages: 
Initializing BB... 

Done! 

Creating batch1 and objects from files in the template... 

Success! 

7. Process the batch. 

You can process your batch in the Graphical User Interface (GUI) or using the Command Line 
Interface (CLI). 

In the Graphical User Interface 

a. In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message:  
FINISHED - Creation of batch.xml and descriptors complete for batch: … 

If you see any error messages, remedy the errors and re-process the batch. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.: 
batchbuildercli -a build -p “E:\My Project” -b batch1 

b. (Optional) add additional parameters to the bathcbuildercli command to substitute 
batch, object and directory level properties. For more information see section 11. 
Processing Batches Using Command Line Interface. 

c. When the batch is successfully processed you will see the following messages: 
Building PREMIS file metadata... 
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Building HulDrsAdmin file metadata... 

Success! 

If you see any error messages at the end of batch processing, remedy the errors and re-
process the batch (you can disregard any errors showing during batch processing on 
command line as long as you get the final “Success!” message) 

 

6.3.3 Use externally generated METS file to build structure-rich PDS 
objects 

This is a description of the procedures to build structure-rich PDS objects using externally 
generated METS files. This method is best to use when additional structure (i.e. custom section 
nodes) needs to be added to a PDS object before DRS deposit. Structure-rich PDS objects can be 
built using the BB manual object building option as well as using the BB automatic object building 
option. 

Preparing externally generated METS file for import into Batch Builder 2 

1. Where to place the PDS METS file(s)? 

ο When building the objects manually the file(s) should be placed into the directory: 
[project]\_aux\[batch]\[object]  

ο When building objects automatically the file(s) should be placed into the directory 
[project]\_aux\template  

2. How to adjust PDS METS file(s) for ingest by BB? 

There are changes to the file path and the file name in each xlink:href attribute in the <filesec> 
section of the provided METS files that need to be done before the file can be read and 
converted by BB.  

a. (Required) The file path must be updated to correspond to the Batch Builder 2 
naming and directory structure for every file referenced in xlink:href attribute in 
the <filesec> section of the provided METS file. For instance, given that when you 
created directories in BB template you named your archival master directory image-
arch, your deliverable directory image-deliverable and your text directory 
text, the DRS 1-style PDS METS <filesec> section should be updated in the 
following way: 

xlink:href="archival_master/mydoc__1.tif" 
should be updated to read 
xlink:href="image-arch/ mydoc__1.tif " 

xlink:href="archival_master/deliverable/ mydoc__1.jp2"  
should be updated to read 
xlink:href="image-arch/image-deliverable/ mydoc__1.jp2"  

xlink:href="archival_master/ocr_uncorrected/ mydoc__1.txt" 
should be updated to read 
xlink:href="text/ mydoc__1.txt" 

File path syntax note: The file path style (Linux/Mac vs Windows) in the xlink 
attribute needs to correspond to the computer operating system on which BB is being run. 
If BB is run on Windows the file path should use Windows-style slashes: 
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image-arch\image-deliverable\ mydoc__1.jp2  

If BB is run on Linux or Mac the file path should use the Linux/Mac style slashes: 

image-arch/image-deliverable/ mydoc__1.jp2 

b. (Optional) The file name in xlink:href needs to be modified if you plan to add an object 
OSN prefix to file names. For every file referenced in xlink:href attribute in the 
<filesec> section of the provided METS file The file names should be updated in the 
following way. 

If original file names were mydoc__1.tif, mydoc__1.jp2 and mydoc_1.txt and the object 
OSN prefix was added to the left and the page sequence number was added to the right so 
that the new file names are: obj1-- mydoc__1.tif , obj1-- mydoc__1.jp2 and obj1-- 
mydoc__1.txt the xlink:href attributes should be updated to read: 

xlink:href="image-arch/obj1-- mydoc__1.tif" 
xlink:href="image-arch/image-deliverable/obj1-- mydoc__1.jp2"  
xlink:href="text/obj1-- mydoc__1.txt" 

where “obj1” is the object OSN prefix. 

3. Name the PDS METS file(s) to correspond to BB naming scheme 

The METS file(s) should be named in the following way:{obj_name}_mets.xml.  

Example 
If the original METS file name is original_name.xml, and the PDS Document object 
owner supplied name is obj1 the new name of the METS file should be obj1_mets.xml  

Note that the object OSN that is part of the METS file name (e.g.: obj1_mets.xml) should 
match the object OSN specified in the object name prefix for each file  
(e.g.: obj1--image1_1.jp2) or in the external mapping file mapping.txt (See Using 
mapping.txt file for how to create a mapping file.).  

If building objects automatically, once a new batch is created the METS file(s) will be moved 
to the appropriate object directory(ies): [project]\_aux\[batch]\[object]. Note that if you 
need to edit your METS file(s) after the batch has been created you can edit them in their new 
locations ([project]\_aux\[batch]\[object]). 

6.3.3.1 Using BB manual object building option 
This is a description of the process to manually create a structure-rich PDS Document object batch 
using Batch Builder 2 (BB). This method is best to use when you have only one or two PDS 
objects in your batch. 

Procedure summary: 
1. Create a new project 

2. Enter DRS deposit settings 

3. Create object template 

4. Add directories to template 

5. Create a new object batch 

6. Copy files into object directories on disk 
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7. Adjust PDS METS file(s) for ingest by BB 

8. Rename the PDS METS file(s) to required naming scheme. 

9. Place PDS METS file(s) into corresponding object directori(es/y) on disk 

10. Process the batch 

11. Upload batch to dropbox 

12. Check load report in email 

What you need before you start: 
• Prepare a batch of page images and (optionally) accompanying machine readable text and 

XML layout (Alto) files that constitute a future PDS Document object and put them in a 
directory of your choice somewhere on local hard disk or network drive.  If you have more 
than one file per page image (e.g.: an archival master and a deliverable or an archival master, a 
deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 
and file1.jpg). The file names of text files and XML layout (Alto) files should match the 
file names of the page images files (e.g.: file1.tif, file1.jp2 file1.jpg, 
file1.txt, file1.xml). 

ο Repeat the steps above for each PDS object you are preparing. Files for all objects you are 
preparing should reside in directories designated by their future roles – e.g.: archival 
masters for all objects reside in one directory, large deliverables for all objects reside in 
another, nested directory, etc. 

• Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: 
[filename]__[sequence_number].[extension]. E.g.: file1__1.jpg, 
file2__2.jpg, etc. Check Section 1.2.2 of this Guide for more information about setting 
file name patterns in BB. Alternatively, instead of supplying appended sequence numbers you 
can provide them via the external mapping file called mapping.txt. See section 12. Using 
External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph 
IDs for more information. 

• Decide what you will use for Owner Supplied Names for your object and the digital image files 
it consists of. For instance, you could use local classification or local accession numbers or an 
ALEPH ID. 

• Supply externally generated PDS METS file for each object for ingest by Batch Builder (see 
Harvard METS Profile for PDS for a list of elements that can be included in the PDS METS 
file). See section “Preparing externally generated METS file for import into Batch Builder 2” 
above to learn how to adjust the METS file for ingest by Batch Builder. 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 
Project Directory: select the directory where project will be saved (click ellipsis button to 
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browse for or create a directory). 
Content Model: select the value "PDS document" from the dropdown. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 

Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific batch-, object-, or directory-level metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
File Access Flags:  the DRS access flag for the files.  At this level, select the least 
restrictive value if the batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path. Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  default value {n} will generate a unique number. 

c. Enter optional admin and descriptive metadata to the object template. Click the “optional” 
tab to enter any optional metadata (for example descriptive metadata, roles or/and 
relationships that will apply to your objects).  

For more about optional metadata see sections 14. Adding Relationships, 15. Adding 
Descriptive Metadata, and 16. Adding Licenses, Documentation and Other Supporting 
Content. 

4. Add directories to template: 

Image directories 

For one image file per page image: 

a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory 
name will start with “image” but you can append a custom suffix. 

b. Add metadata: click to select the new directory, then add metadata to the form: 

Required: 

   First Generation in DRS: select "yes". 
   Usage Class: select "HIGHUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 
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For multiple image files per page image (e.g., archival master, deliverable), you need to 
create a directory for the master file and a nested sub-directory for each derivative file.  

c. Add a master directory: right click on “Object Template” in Project Panel tree to create 
an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that 
describes the role.  

d. Add metadata for the master directory: click to select the new directory, then add 
required metadata to the form: 

Required: 
   First Generation in DRS: select "yes". 
   Usage Class: select "LOWUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role: select ARCHIVAL_MASTER. 

e. Add a nested directory for derivative: right click on the directory you just created and 
create another directory nested inside it (e.g., a directory for deliverable images).  Add a 
suffix for this derivative (e.g., "-deliverable").  

f. Add metadata for this derivative subdirectory: click to select the new subdirectory, then 
add metadata to the form: 

“required” tab: 
   First Generation in DRS: select "no". 
   Usage Class: select "HIGHUSE". 

“optional” tab: scroll down to "Still Image File Metadata": 

   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order 
to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB. 

g. Repeat the previous steps to create additional nested directories if you have more files 
derived from the current one.  

h. Save your work (Project > Save on main menu). 

Text directories 

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “text” but you can append 
a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

Layout directories (for Alto coordinates files) 

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “layout” but you can 
append a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 
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d. Choose “LOWUSE” for Usage Class. 

5. Create new batch with objects: 

Note: Metadata added at this level can be applied to a specific object or file directory.  

a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch 
(will be used as the batch directory name on disk).  Click OK. 

Tip: including the word "batch" in the name will help you remember the directory’s 
purpose on the file system.   

b. Click to select new batch in Project Panel tree.  (Look for red letter B). 

c. Create new object from template: select Object > New from the main menu.  Enter the 
name of the object (by default, will be used as object OSN).  Make sure this object name is 
unique!  Click OK.  (Look for blue letter O). 

d. Enter optional metadata for each object and file.  Click the object directory in the Project 
Panel tree and select the “optional” tab on the right to enter optional metadata (for example 
descriptive metadata, roles or/and relationships that will apply to your objects).  

For more about optional metadata see sections Adding Relationships, Adding Descriptive 
Metadata, Adding Licenses, Documentation and Other Supporting Content. Note that any 
metadata entered at the object level will override metadata entered at the template level. 

e. Repeat the previous steps to create additional objects (if you have more than one object in 
the batch). 

f. Save your project (Project > Save on main menu). 

6. Copy files into batch object directories on disk (done outside Batch Builder). 

Page image files go into an object's "image" directory.  Text files go in a "text" directory.  
Layout files go in a "layout" directory.  

Note: if you need to check where the batch/object directories are on disk, click on "Deposit 
Settings" in the Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary object path in the project. 

7. Adjust PDS METS file(s) for ingest by BB. See section Preparing externally generated 
METS file for import into Batch Builder 2 at the top of section 6.3. 

8. Rename the PDS METS file(s) to correspond to BB external mapping files naming 
scheme. See section Preparing externally generated METS file for import into Batch Builder 2 
at the top of section 6.3. 

9. Place the PDS METS file(s) into corresponding object directories 

The PDS METS file(s) should be placed into corresponding object directories: 
[project]\_aux\[batch]\[object]. 

10. Process the batch: 
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a. In the Project Panel tree, right click on the batch you want to process (batch icon with a 
red letter B) and select “Create descriptors and batch.xml.” 

b. Processing messages will appear in the messages pane.  

c. When the batch is successfully processed you will see the following message: FINISHED - 
Creation of batch.xml and descriptors complete for batch: 

11. Upload batch to dropbox 

a. Open your SFTP client and log into your DRS2 training dropbox account. 

b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

12. Check load report in email. 

a. Open your email inbox. 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

For a more readable report, open the attached text file in Excel, or just copy the file listing 
and paste into Excel. 

6.3.3.2 Using BB automatic object building option 
This is a description of the procedure to build structure-rich PDS objects using externally generated 
METS files by means of the BB automatic object building option. This method is best to use when 
you have more than two PDS objects in your batch. 

Procedure summary: 
1. Create a new project  

2. Enter DRS deposit settings 

3. Create object template 

4. Add directories to template 

5. Move/copy files into template directory 

6. Place PDS METS file(s) into corresponding template directory 

7. Adjust PDS METS file for ingest to BB 

8. Rename the PDS METS file to correspond to BB external mapping files naming scheme 

9. Create a new object batch 

10. Process the batch 

11. Upload batch to dropbox 

12. Check load report in email 

What you need before you start: 
• Prepare a batch of page images and (optionally) accompanying machine readable text files and 

put them in a directory of your choice somewhere on local hard disk or network drive.  If you 
have more than one file per page image (e.g.: an archival master and a deliverable or an 
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archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, 
file1.jp2 and file1.jpg). The file names of text files should match the file names of the page 
images files as well (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt).  

ο Repeat the steps above for each PDS object you are preparing. Files for all objects you are 
preparing should reside in directories designated by their future roles – e.g.: archival 
masters for all objects reside in one directory, large deliverables for all objects reside in 
another, nested directory, etc. 

• Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: 
[filename]__[sequence_number].[extension]. E.g.: file1__1.jpg, 
file2__2.jpg, etc. Alternatively, instead of supplying appended sequence numbers you 
can provide them via the external mapping file called mapping.txt. See section 12. Using 
External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph 
IDs for more information. 

• Decide what you will use for Owner Supplied Names (OSNs) for your objects and the digital 
image files they contain. For instance, you could use local classification or local accession 
numbers or ALEPH IDs. 

• Make sure that the object OSNs are supplied for each file by one of the following methods: 

ο Append the object prefix to each file name (the syntax is [objprefix]--
[filename]__[pageSeq].[ext]). Set the desired file name pattern objects in the 
BB Options dialog (see section 1.2.2 for more information).  

ο When preparing several objects, objprefix for a corresponding object should be used 
for the files that are going to be part of that object. E.g.: obj1—file1__01.jpeg, obj2—
file1__01.jpeg, obj1—file2__02.jpeg, obj2—file2__02.jpeg ect. 

ο Supply an external mapping file that maps each file to object (see section 12.1 for more 
information). One mapping file can contain references to multiple objects. 

• Supply externally generated PDS METS file for each object for ingest by Batch Builder (see 
Harvard METS Profile for PDS for a list of elements that can be included in the PDS METS 
file). The PDS METS file should be placed into [project]\_aux\template directory 
(for Unix, Linux or Mac the path would be [project]/_aux/template).  

ο Note that you can place several corresponding METS files for each of your objects in the 
[project]\_aux\template directory. The naming scheme for the PDS METS files 
is explained in step 7 of this procedure. 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 
Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 
Content Model: select the "PDS document" value from the dropdown. 
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c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 

Note: Metadata added at this level will be applied to every object in a batch, unless overridden 
by specific object-level metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
File Access Flags: DRS access flag for the files in the object. Should contain the least 
restrictive access flag that applies to all the files. 
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  default value {n} will generate a unique number. 

c.  Enter optional admin and descriptive metadata to the object template. Click the 
“optional” tab.   

IDS URN for Deliverable JPG and JP2: Select "Yes" if you need IDS URNs for all 
deliverable images in the batch. 

4. Add directories to template: 

In automatic object workflow, you create role-based directories (archival master, deliverable) 
and in a later step, Batch Builder will create the objects for you. 

Image directories 

For one image file per page image: 

a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory 
name will start with “image” but you can append a custom suffix. 

b. Add metadata: click to select the new directory, then add metadata to the form: 

Required: 

   First Generation in DRS: select "yes". 
   Usage Class: select "HIGHUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.   Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 
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For multiple image files per page image (e.g., archival master, deliverable), you need to 
create a directory for the master file and a nested sub-directory for each derivative file.  

a. Add a master directory: right click on “Object Template” in Project Panel tree to create 
an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that 
describes the role.  

b. Add metadata for the master directory: click to select the new directory, then add 
required metadata to the form: 

Required: 
   First Generation in DRS: select "yes". 
   Usage Class: select "LOWUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role: select ARCHIVAL_MASTER. 

c. Add a nested directory for derivative: right click on the directory you just created and 
create another directory nested inside it (e.g., a directory for deliverable images).  Add a 
suffix for this derivative (e.g., "-deliverable").  

d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then 
add metadata to the form: 

Required: 
   First Generation in DRS: select "no":. 
   Usage Class: select "HIGHUSE". 

Optional: scroll down to "Still Image File Metadata": 

   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order 
to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB. 

e. Repeat previous steps to create additional nested directories if you have more files derived 
from the current one.  

f. Save your work (Project > Save on main menu). 

Text directories  

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “text” but you can append 
a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

Layout directories (for Alto coordinates files) 

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the 
directory name in the dialog box. The directory name starts with “layout” but you can 
append a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 
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d. Choose “LOWUSE” for Usage Class. 

5. Copy files into Batch Builder template directories on disk (can be done inside or outside 
of Batch Builder) 

The directories you created in BB have been created on disk, in the project’s template path: 

{project_name}\template\ 

In order to tell BB which object each file should end up with you need to either add object 
name prefixes to each file name or supply a mapping.txt file that associates each file with its 
future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using 
mapping.txt file for how to create a mapping file. 

In the automatic workflow, files with the same role (archival master, deliverable, text, layout) 
are copied into the corresponding role-based directory.  In a later step, Batch Builder will use 
the object name prefix for each file to create object directories and move files for each object 
into these directories. 

Copy your PDS METS file into the  

Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the 
Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
template directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary template path in the project. 

6. Place PDS METS file(s) into corresponding template directory 
The file(s) should be placed into the directory: [project]\_aux\template.  

7. Adjust PDS METS file(s) for ingest by BB. See section Preparing externally generated 
METS file for import into Batch Builder 2 at the top of section 6.3. 

8. Rename the PDS METS file(s) to correspond to BB external mapping files naming 
scheme. See section Preparing externally generated METS file for import into Batch Builder 2 
at the top of section 6.3. 

9. Create a new object batch. 

You can create your new object batch in the Graphical User Interface or using the Command 
Line Interface (CLI). 

In the Graphical User Interface 

a. From the Object menu in BB select “Create a new batch with objects from template”; enter 
the name of the batch directory to be created on disk and click OK.  A new batch icon will 
be added to the Project Panel on the right (icon with a red letter B) and new objects will be 
built that are going to be part of this batch. 

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to 
expand the tree – it will show the icons for the new objects (a blue letter O). 

c. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata that applies specifically 
to your object (for example descriptive metadata or Aleph ID, administrative categories, 
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etc.). Note that any optional metadata that applies to all objects in the batch should be 
entered in the object template before your batch is created. For more about optional 
metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. 
Adding Licenses, Documentation and Other Supporting Content. Note that any metadata 
entered at the object level will override metadata entered at the template level. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a buildtemplate –p 
[project_directory_path] –b [batch_directory_name]. 

Example: 
batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1 
 
Note that [batch_directory_name] is the name of your new batch directory, to be created by 
BB. 

If the batch creation is successful you will see the following messages: 
Initializing BB... 

Done! 

Creating batch1 and objects from files in the template... 

Success! 

10. Process the batch. 

You can process your batch in the Graphical User Interface (GUI) or using the Command Line 
Interface (CLI). 

In the Graphical User Interface 

a. In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message:  
FINISHED - Creation of batch.xml and descriptors complete for batch: … 

If you see any error messages, remedy the errors and re-process the batch. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.: 
batchbuildercli -a build -p “E:\My Project” -b batch1 

b. (Optional) add additional parameters to the bathcbuildercli command to substitute 
batch, object and directory level properties. For more information see section 11. 
Processing Batches Using Command Line Interface. 

c. When the batch is successfully processed you will see the following messages: 
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Building PREMIS file metadata... 

Building HulDrsAdmin file metadata... 

Success! 

If you see any error messages at the end of batch processing, remedy the errors and re-
process the batch (you can disregard any errors showing during batch processing on 
command line as long as you get the final “Success!” message) 

11. Upload batch to dropbox 

a. Open your SFTP client and log into your DRS2 training dropbox account. 

b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

12. Check load report in email. 

a. Open your email inbox. 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

For a more readable report, open the attached text file in Excel, or just copy the file listing 
and paste into Excel. 

7. Creating and Processing Opaque Object Batches 
7.1 Manually build opaque objects from template 
7.2 Automatically build opaque objects from template 

There are two methods you can use to create Opaque objects in Batch Builder: 

1. Manually create objects from template. This is best when you have less than 5 objects to work 
with. In this scenario you generate in BB an object structure for each object and then copy files 
into it (done outside BB). See section 7.1 for the procedure. 

2. Automatically build objects from template. This method is best for large batches of objects (5 
or more objects per batch). In this scenario BB generates object structure for each of your 
objects and moves files into object directories. Before this can happen you need to rename your 
files to add special “object name” file prefixes or provide mapping files that associate files with 
their objects. See section 7.2 for the procedure. 

Note that an opaque object can have only one directory named “content” (where all the content 
files are stored). Inside the content directory there can be additional nested directory structures. 
However the word “content” is reserved and cannot be used in the name of any directories that are 
part of the opaque object. 

7.1 Manually build Opaque objects from template 
This is a description of the procedure to manually create a batch of opaque objects from template in 
Batch Builder 2 (BB). This method should be used if you have less than 5 objects per batch. 

Procedure summary: 
1. Create a new project 

2. Enter DRS deposit settings 
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3. Create object template 

4. Add directories to template 

5. Add metadata 

6. Save your work 

7. Create a new object batch 

8. Move/copy files into corresponding directories on disk 

9. Process the batch 

What you need before you start: 
• Prepare several opaque objects and put them in a directory of your choice somewhere on local 

hard disk or network drive. Consult DRS2 Content Models Reference for guidelines on 
creating opaque objects. 

• Decide what you will use for Owner Supplied Names (OSNs) for opaque objects. For instance, 
you could use local classification or local accession numbers. Consult section 3 Naming rules 
for files, objects and directories of this Guide for more information. 

Procedure: 
1. Create a new project. 

a. Open BB by double clicking on the executable. 

b. From the Project menu select New. 

c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in 
which the project will be saved (click the ellipsis button to browse to it on disk); select 
Content Model “opaque” from the dropdown; click OK to continue. 

2. Enter DRS deposit settings. 

a. Select “Deposit Settings” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter email address(es) for DRS Reports to be sent to. 

c. Type the email in Success Email field and press Enter on the keyboard. 

d.  Type the email in Failure Email field and press Enter on the keyboard. 

e. For more email addresses repeat c and d. 

f. Choose success method (‘email‘ is the most commonly used). 

g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS 
metadata for each batch).  

3. Create object template 

a. Select “Object Template” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter DRS Owner Code for objects you will be depositing (use all caps). 

c. Enter DRS Billing Code for objects you will be depositing (use all caps). 
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d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta 
testing). 

e. (Optional) Switch to “optional” tab in the Content Panel to enter any optional metadata (for 
example descriptive metadata, roles or/and relationships that will apply to your objects). 
For more about optional metadata see sections 14. Adding Relationships, 15. Adding 
Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  

4. Add directories to template. 

Content directory (note that an opaque object can have only one directory named “content”) 

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The 
directory name starts with “content” but you can append a custom suffix). 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “LOWUSE” for Usage Class. 

Documentation directory (optional) 

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The 
directory name starts with “documentation” but you can append a custom suffix). 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “LOWUSE” for Usage Class. 

Go to Project menu in the top menu bar and choose Save to save your project. 

5. Add metadata: click to select the new directory, then add metadata to the form: 
 
Required: 
 
First Generation in DRS: select "yes".  
Usage Class: select "LOWUSE". 

Optional:  

Role:  There are no roles for content files, but you can select either DOCUMENTATION or 
LICENSE roles for documentation files.  Select any role that applies.   

6. Save your work:  Project > Save on main menu. 

7. Create a new object batch. 

a. From the Batch menu select “New”; enter the name of the new batch directory to be 
created on disk and click OK.  A new batch icon will be added to the Project Panel on the 
left (icon with red letter B). 

b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) 
and enter the name of the object (Object Owner Supplied Name). Click OK.  

c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new 
object.   
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d. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that 
any metadata entered at the object level will override metadata entered at the template 
level. 

e. Repeat b-d if you have more than object. 

8. Move/copy images into corresponding file directories on disk. 

(Done outside Batch Builder) 

The directory structure on disk is the same as what you see in the Project Panel in Batch 
Builder if you expand the batch icon. If you need to check where on disk Batch Builder built 
the directory structure, click on Deposit Settings in the Project Panel on the left and look at the 
Project Path field at the bottom of the Content Panel on the right.  

a. Copy the content files into the corresponding content directory in the object directory. 

b. Copy documentation files into the corresponding documentation directory in the object 
directory. 

c. Repeat if you have more than one object. 

9. Process the batch. 

a. In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message:  
FINISHED - Creation of batch.xml and descriptors complete for batch: … 

7.2 Automatically build Opaque objects from template 
This is a description of the procedure to automatically create a batch of opaque objects from 
template in Batch Builder 2 (BB).This method should be used if you have 5 or more opaque objects 
per batch and the object contents are simple (e.g.: several files per object without any nested 
directories). If the object content consists of many files and nested directories this method becomes 
impractical. In this latter case use the procedure to manually build Opaque objects from template. 

Procedure summary: 
1. Create a new project 

2. Enter DRS deposit settings 

3. Create object template 

4. Add directories to template 

5. Add metadata 

6. Save your work 

7. Move/copy files into corresponding directories on disk 

8. Create new batch with objects 
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9. Process the batch 

10. Upload batch to dropbox 

11. Check load report in email 

What you need before you start: 
• Prepare your opaque objects and put them in a directory of your choice somewhere on local 

hard disk or network drive. Consult DRS2 Content Models Reference for guidelines on 
creating opaque objects. Note that each opaque object can have only one “content” directory in 
which the contents are contained. The word “content” is reserved and cannot be used in any 
directory names that are part of the directory structure of the object itself (i.e. directories nested 
inside the “content” directory). 

• Decide what you will use for Owner Supplied Names (OSNs) for opaque objects. For instance, 
you could use local classification or local accession numbers. Consult section 3 Naming rules 
for files, objects and directories of this Guide for more information. 

• Make sure that the object OSNs are supplied for each file by one of the following methods: 

ο Append the object prefix to each file name (the syntax is [objprefix]--
[filename].[ext]). Set the desired file name pattern objects in the BB Options 
dialog (see section 1.2.2 for more information). 

ο Supply an external mapping file that maps each file to object (see section 12.1 for more 
information). 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data:  
Project Name:  enter a name for your project (used for internal tracking only). 
Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 
Content Model: select the appropriate value ("opaque") from the dropdown. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 
Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 
Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific batch-, object-, or directory-level metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 
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b. Enter required object metadata in the form: 
DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
Object Access:  the DRS access flag.  Set value to "N" (no access). 

c. Enter optional admin and descriptive metadata to the object template. Click the “optional” 
tab.  Notable metadata at this level: 

d. Admin category: assign a category to every object.  A curator-assigned label, such as an 
exhibit name, project name, etc., that can be used to group together a set of objects or files. 

4. Add directories to template: 
About files in opaque objects:  All files that make up the opaque object must be stored in one 
“content” directory.  Any documentation files that describe the opaque content must be stored 
in a “documentation” directory.  The “documentation” directory must be parallel to the 
“content” directory.  There can be only one “content” directory per opaque object. 

a. Add directory: right click on “Object Template” in Project Panel tree.  Content directories 
are prefixed with "content".  Documentation directories are prefixed with "documentation.  
But you can append a custom suffix to directory name. 

5. Add metadata: click to select the new directory, then add metadata to the form: 

a. Required: 
First Generation in DRS: select "yes".  
Usage Class: select "LOWUSE". 

b. Optional:  
Role:  There are no roles for content files, but you can select either DOCUMENTATION 
or LICENSE roles for documentation files.  Select any role that applies.  

6. Save your work (Project > Save on main menu). 

7. Copy files into Batch Builder template directory on disk. 

The directories you created in BB have been created on disk, in the project’s template path: 

{project_name}\template\ 

In the automatic workflow, files are copied into a directory in the template path.  In a later step, 
Batch Builder will use the object name prefix for each file to create object directories and move 
files for each object into these directories. 

Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the 
Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the file 
template directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary template path in the project. 

8. Create new batch with objects: 

a. Create new batch: From the menu select “Object > Create a new batch with objects from 
template”.  Enter the name of the batch directory to be created on disk and click OK.  

In response to this action you will see:  
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"FINISHED - Moved objects to [batch name]"  in the message panel. 

A new batch directory with red letter B added to the Project Panel. 

New object directories (marked by blue letter O), and file directories nested below the 
batch directory. 

Behind the scenes, BB created the batch and object directories on disk and moved the 
content files from the {project_name}\template directory into the object directories.  

b. Add optional metadata for each object and/or each file.  Note that required metadata was 
supplied by the object template. 

Select an object directory (or file directory) in the Project Panel and then select the 
“optional” tab on the right. 

Object metadata: select the object directory, open the “optional” tab.   

Notable metadata types include: 

Aleph ID for MODS import: import descriptive metadata from Aleph.  You can also 
right-click over the object directory in project panel to assign Aleph ID. 

Admin category: a curator-assigned label, such as an exhibit name, project name, etc., that 
can be used to group together a set of objects or files. 

Descriptive metadata fields (MODS): use only if not importing by Aleph ID or including 
external MODS file. 

File metadata: select a file directory, open the “optional” tab: 

Admin category: a curator-assigned label, such as an exhibit name, project name, etc., that 
can be used to group together a set of objects or files. 

To import an object description from Aleph, right click on the object directory and select 
"Set Aleph ID". 

c. Save your project (Project > Save on main menu). 

9. Process the batch: 

a. In the Project Panel tree, right click on the batch you want to process (batch with red 
letter B) and select “Create descriptors & batch.xml.”  Or from the main menu, select 
Batch > Create descriptors & batch.xml. 

b. Processing messages will appear in the messages pane.  

c. When the batch is successfully processed you will see the following message: FINISHED - 
Creation of batch.xml and descriptors complete for batch: 

10. Upload batch to dropbox: 

a. Open your SFTP client and log into your DRS2 dropbox account. 

b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

11. Check load report in email: 

a. Open your email inbox. 

Revised: June 2, 2013 



Batch Builder 2 Beta User Guide Page 61 of 131 
 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

c. For a more readable report, open the attached text file in Excel, or just copy the file listing 
and paste into Excel. 
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8. Creating and Processing Document (PDF) Object Batches 
8.1 Manually create document objects from template 
8.2 Automatically create document objects from template 

There are three methods you can use to create Document objects in Batch Builder: 

1. Manually create objects from template. This is best when you have only one or two Document 
objects to work with. In this scenario you generate an object structure in BB for each object 
and then copy files into the structure (can be done outside BB). See section 8.1 for the 
procedure. 

2. Automatically build objects from template. This method is best for large batches of objects 
(over 10 objects). In this scenario BB generates object structure for each of your objects and 
moves files into object directories. Before this can happen you need to rename your files to add 
special “object name” file prefixes or provide mapping files that associate files with their 
objects. See section 8.2 for the procedure. 

3. Manually create objects without using the template. In this method, rather than using the 
template, you fill out object and file metadata and create object directories for each individual 
object one-object-at-a-time. This method is useful when object properties such as Owner Code, 
Billing Code and URN authority path are different for each object. Because this option will be 
rarely used, it is not currently documented 

8.1 Manually create document objects from template 
This is a description of the procedure to create a simple batch of Document (PDF) objects from 
template in Batch Builder 2 (BB). Use this method when only several document objects need to be 
created, processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) 
objects to create, use the procedure to build objects automatically.  

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directories to template. 

5. Create a new object batch. 

6. Move/copy files into corresponding directories on disk. 

7. Process the batch. 

What you need before you start: 
• Prepare several PDF files and put them in a directory of your choice somewhere on local hard 

disk or network drive. 

• Decide what you will use for Owner Supplied Names for Document objects and the digital files 
(PDFs) they consist of. For instance, you could use local classification or local accession 
numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for 
more information. 
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Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 

Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 

TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. 
software_documentation_project) 

Content Model: select the "document" value from the dropdown. 

Project Description (optional): Any information relevant to the project – will only remain 
locally. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

d. Click on “Deposit Settings” in Project Panel tree. 

e. Enter deposit data in the form: 

Batch Name Pattern:  default - 
{owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss} 

(This is the name for a batch that appear on DRS deposit reports.) 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 
Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific object metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
Object Access:  the DRS access flag.  At this level, select the least restrictive value if the 
batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  use default value {n} to generate a unique number. 

c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, 
roles and relationships that will apply to your objects). For more about optional metadata 
see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding 
Licenses, Documentation and Other Supporting Content.   
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4. Add directories to template. 

a. Right click on “Object Template” in the Project Panel on the left and select the ‘add a 
directory…’ menu option.  

b. Type in a name for your directory in the text box.  The directory name will start with 
“document” but the name you type will be appended to it. Tip: to make it easier to read, 
start your directory name with an underscore (_) So, typing ‘_diary_pdfs’ will result in a 
directory called ‘document_diary_pdfs’ 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “HIGHUSE” for Usage Class. 

 

Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Document Object Metadata “ 

d. Enter any file level optional metadata in the form 

 

Role:  use Ctrl Click to select ARCHIVAL_MASTER and role DELIVERABLE. Note that in 
order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in 
BB. 

5. Save your work (Project > Save on main menu). 

6. Create new batch with objects: 
Metadata added at this level can be applied to a specific object, or specific file directory.  

a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch 
(will be used as the batch directory name on disk).  Click OK. 

Tip: including the word "batch" in the name will help you remember the directory’s 
purpose on the file system.   

b. Select the batch (with the red letter B) in the Project Panel 

c. From the main menu select Object > New; leave Content Model at default (FROM 
TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and 
click OK.  

d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new 
object (blue letter O)   

e. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
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Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note: any 
metadata entered at the object level will override metadata entered at the template level. 

f. Repeat b-e if you have more than object. 

7. Save your project (Project > Save on main menu). 

8. Copy image files into batch object directories on disk (can be done outside Batch Builder). 

Note: if you need to check where the batch/object directories are on disk, click on "Deposit 
Settings" in the Project Panel tree and look at the Project Path field at bottom.  

** Quick way to copy content files: you can drag files from your file system onto the object 
directories in the Batch Builder project panel. 

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the 
project.  

** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary object path in the project. 

9. Process the batch: 

a. In the Project Panel tree, right click on the batch you want to process (batch icon with a 
red letter B) and select “Create descriptors and batch.xml.” 

b. Processing messages will appear in the messages pane.  

c. When the batch is successfully processed you will see the following message: FINISHED - 
Creation of batch.xml and descriptors complete for batch: 

10. Upload batch to dropbox. 

a. Open your SFTP client and log into your DRS2 training dropbox account. 

b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

11. Check load report in email. 

a. Open your email inbox. 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

For a more readable report, open the attached text file in Excel, or just copy the file listing and 
paste into Excel.   If you see any error messages, remedy the errors and re-process the batch.  

 

8.2 Automatically create document objects from template 
This is a description of the procedure to automatically build a batch of Document (PDF) objects 
from template using Batch Builder 2 (BB). Use this method if you have a large number of objects 
(more than 10) that need to be created and your source files are not broken into directories by 
object. ( e.g. you have 100 PDF files in a directory on disk). 

Procedure summary: 
1. Create a new project. 
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2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directories to template. 

5. Move/copy files into template directory. 

6. Add object name prefix to file names or supply mapping.txt file. 

7. Create new object batch. 

8. Process the batch. 

What you need before you start: 
• Prepare the PDF files and put them in a directory of your choice somewhere on local hard disk 

or network drive. 

• Decide what you will use for qwner supplied names for document objects and the PDF files 
they consist of. For instance, you could use local classification or local accession numbers. 
Consult section 3 Naming rules for files, objects and directories of this Guide for more 
information.  

• Make sure you either provide object name prefix for each file to specify which objects it should 
be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide 
object assignment for your file in an external mapping file. For more details about providing 
object prefixes for your files see section 1.2.2. For more details about external mapping files 
see section 12.1. 

Procedure: 
Start at Step 5 if you are reusing a project to generate a new batch. 

1. Create new project in Batch Builder 

a. From main menu select Project > New. 

b. Enter project data:  

Project Name:  enter a name for your project (used for internal tracking only). 

Project Directory: select the directory where project will be saved (click ellipsis button to 
browse for or create a directory). 

TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. 
software_documentation _project) 

Content Model: select the "document" value from the dropdown. 

Project Description (optional): Any information relevant to the project – will only remain 
locally. 

c. Click OK to continue. 

2. Enter DRS deposit settings: 

a. Click on “Deposit Settings” in Project Panel tree. 

b. Enter deposit data in the form: 
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Batch Name Pattern:  default - 
{owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss} 

(This is the name for a batch that appear on DRS deposit reports.) 

Success Email:  type email and press enter. 
Failure Email:  type email and press enter. 
Success Method:  choose how you will receive load report. 
Deposit Agent:  type your HUID. 

3. Create object template: 
Metadata added at this level will be applied to every object in a batch, unless overridden by 
specific object metadata that you define in later steps. 

a. Click on “Object Template” in Project Panel tree: 

b. Enter required object metadata in the form: 

DRS Owner Code: your owner code (use all caps). 
DRS Billing Code: your billing code (use all caps). 
Object Access:  the DRS access flag.  At this level, select the least restrictive value if the 
batch will contain a mix of public and restricted files.   
URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if 
needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html. 
URN Resource Name Pattern:  use default value {n} to generate a unique number. 

c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, 
roles and relationships that will apply to your objects). For more about optional metadata 
see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding 
Licenses, Documentation and Other Supporting Content.  Note that any metadata entered 
at the object level will override metadata entered at the template level. 

4. Add directories to template: 

In automatic object workflow, you create role-based directories (archival master, deliverable) 
and in a later step, Batch Builder will create the objects for you. 

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add 
a directory…” menu option. 

b. Type in a name for your directory in the text box . The directory name will start with 
“document” but the name you type will be appended to it.  Tip: to make it easier to read, 
start your directory name with an underscore (_) So, typing ‘_PDFs’ will result in a 
directory called ‘document_PDFs’ 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “HIGHUSE” for Usage Class. 

 

Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 
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d. Enter any file level optional metadata in the form 

Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note 
that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE 
set in BB. 

 

Add additional metadata (optional): 

a. Select the new directory in the Project Panel on the left 

b. In the Content Panel, select the ‘optional’ tab. 

c. Scroll down to "Still Image File Metadata “ 

d. Enter any file level optional metadata in the form 

   Role: select ARCHIVAL_MASTER. 
 

5. Save your work (Project > Save on main menu). 

6. Copy files into Batch Builder template directory on disk (can be done outside Batch Builder) 

a. The directories you created in BB have been created on disk, in the project’s template path: 

b. {project_name}\template\ 

c. In order to tell BB which object each file should end up with you need to either add object 
name prefixes to each file name or supply a mapping.txt file that associates each file with 
its future object.  See Naming Rules for Objects for how to add an object name prefix.  See 
Using mapping.txt file for how to create a mapping file. 

d. Note: if you need to check where the directories are on disk, click on "Deposit Settings" in 
the Project Panel tree and look at the Project Path field at bottom  

e. ** Quick way to copy content files: you can drag files from your file system onto the 
object template directories in the Batch Builder project panel. 

f. ** If using mapping.txt, this is when you should copy it to the auxiliary template path in 
the project.  

g. ** If including external MODS descriptive metadata, this is when you should copy it to the 
auxiliary template path in the project. 

9. Create a new object batch. 

You can create your new object batch in the Graphical User Interface or using the Command 
Line Interface (CLI).  

In the Graphical User Interface 

a. From the Object menu in BB select “Create a new batch with objects from template”; enter 
the name of the batch directory to be created on disk and click OK.  A new batch icon will 
be added to the Project Panel on the right (icon with a red letter B) and new objects will be 
built that are going to be part of this batch. 

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to 
expand the tree – it will show the icons for the new objects (a blue letter O). 
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c. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that 
any metadata entered at the object level will override metadata entered at the template 
level. 

d. Save the project to have BB2 write the new metadata values to the internal configuration 
files. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33 

Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b 
[batch_directory_name], e.g.: 
batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1 
 
Note that the batch directory name is the name of your new batch directory, to be created 
by BB. 

b. If the batch creation is successful you will see the following messages: 
Initializing BB... 

Done! 

Creating batch1 and objects from files in the template... 

Success! 

10. Process the batch. 

You can process your batch in the Graphical User Interface (GUI) or using the Command Line 
Interface (CLI) 

In the Graphical User Interface 

a.  In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

When the batch is successfully processed you will see the following message: FINISHED 
- Creation of batch.xml and descriptors complete for batch: … 

If you see any error messages, remedy the errors and re-process the batch.  

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.: 
batchbuildercli -a build -p “E:\My Project” -b batch1 
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b. (Optional) add additional parameters to the bathcbuildercli command to substitute 
batch, object and directory level properties. For more information see section 11. 
Processing Batches Using Command Line Interface. 

c. When the batch is successfully processed you will see the following messages: 
Building PREMIS file metadata... 

Building HulDrsAdmin file metadata... 

Success! 

If you see any error messages at the end of batch processing, remedy the errors and re-process 
the batch (you can disregard any errors showing during batch processing on command line as 
long as you get the final “Success!” message). 

9. Creating and Processing Text Object Batches 
9.1 Manually create text objects from template 
9.2 Automatically create text objects from template 

There are three methods you can use to create Text objects in Batch Builder: 

1. Manually create objects from template. This is best when you have only one or two Text 
objects to work with. In this scenario you generate in BB an object structure for each object 
and then copy files into it (done outside BB). See section 8.1 for the procedure. 

2. Automatically build objects from template. This method is best for large batches of objects 
(over 10 objects). In this scenario BB generates object structure for each of your objects and 
moves files into object directories. Before this can happen you need to rename your files to add 
special “object name” file prefixes or provide mapping files that associate files with their 
objects. See section 8.2 for the procedure. 

3. Manually create objects without using the template. In this method, rather than using the 
template, you fill out object and file metadata and create object directories for each individual 
object one-object-at-a-time.  

9.1 Manually create text objects from template 
This is a description of the procedure to manually create a batch of Text objects from template in 
Batch Builder 2 (BB). Use this method when only several Text objects need to be created, 
processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to 
create, use the procedure to build objects automatically.  

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directories to template. 

5. Create new object batch.  

6. Move/copy files into corresponding directories on disk. 

7. Process the batch.  

Revised: June 2, 2013 



Batch Builder 2 Beta User Guide Page 71 of 131 
 

What you need before you start: 
• Prepare several text files and put them in a directory of your choice somewhere on local hard 

disk or network drive. 

• Decide what you will use for Owner Supplied Names for your Text objects and the digital files 
they consist of. For instance, you could use local classification or local accession numbers. 
Section 3 of this Guide for more information about file and object Owner Supplied Names. 

Procedure: 
1. Create a new project. 

a. Open BB by double clicking on the executable. 

b. From the Project menu select New. 

c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in 
which the project will be saved (click the ellipsis button to browse to it on disk); select 
Content Model “text” from the dropdown; click OK to continue. 

2. Enter DRS deposit settings. 

a. Select “Deposit Settings” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter email address(es) for DRS Reports to be sent to. 

c. Type the email in Success Email field and press Enter on the keyboard. 

d. Type the email in Failure Email field and press Enter on the keyboard. 

e. For more email addresses repeat c and d. 

f. Choose success method (“email” is the most commonly used). 

g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS 
metadata for each batch).  

3. Create object template (called “batch template” in BB 1). 

a. Select “Object Template” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter DRS Owner Code for objects you will be depositing (use all caps). 

c. Enter DRS Billing Code for objects you will be depositing (use all caps). 

d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta 
testing). 

e. Enter the URN Authority Path for your objects (Look up your Path here if needed: 
http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps. 

f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing). 

g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional 
metadata (for example descriptive metadata, roles or/and relationships that will apply to 
your objects). For more about optional metadata see sections 14. Adding Relationships, 15. 
Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting 
Content. Note that metadata entered at the object level will override metadata entered at the 
template level. 
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4. Add directories to template. 

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The 
directory name starts with “text” but you can append a custom suffix). 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

e. In the Content Panel switch to Optional tab, scroll down to Text File Metadata and use Ctrl 
Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. 
Note that in order to get a delivery URN on deposit a file needs to have a role 
DELIVERABLE set in BB. 

Go to Project menu in the top menu bar and choose Save to save your project. 

5. Create new object batch. 

a. From the Batch menu select “New”; enter the name of the new batch directory to be 
created on disk and click OK.  A new batch icon will be added to the Project Panel on the 
left (icon with red letter B). 

b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) 
and enter the name of the object (Object Owner Supplied Name). Click OK.  

c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new 
object.   

d. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to enter any additional optional metadata (for example 
descriptive metadata, roles or/and relationships that will apply to your object). For more 
about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that 
metadata entered at the object level will override metadata entered at the template level. 

e. Repeat if you have more than object. 

6. Move/copy files into corresponding file directories on disk. 

(Done outside Batch Builder) 

The directory structure on disk is the same as what you see in the Project Panel in Batch 
Builder if you expand the batch icon. If you need to check where on disk Batch Builder built 
the directory structure, click on Deposit Settings in the Project Panel on the left and look at the 
Project Path field at the bottom of the Content Panel on the right.  

a. Copy the files into corresponding file directories in the object directory. 

b. Repeat if you have more than one object. 

7. Process the batch. 

a. In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message: FINISHED 
- Creation of batch.xml and descriptors complete for batch: … 
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If you see any error messages, remedy the errors and re-process the batch.  

9.2 Automatically build text objects from template 
This is a description of the procedure to automatically build a batch of Text objects from template 
using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that 
need to be created and your source files are in directories that are not broken by object. 

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directives to template. 

5. Move/copy files into template directories. 

6. Add object name prefix to file names or supply a mapping.txt file. 

7. Create new object batch. 

8. Process the batch. 

What you need before you start: 
• Prepare a dozen of text files and put them in a directory of your choice somewhere on local 

hard disk or network drive. 

• Decide what you will use for Owner Supplied Names for your objects and the files they consist 
of. For instance, you could use local classification or local accession numbers. See section 3 for 
more information about owner supplied names. 

• Make sure you either provide object name prefix for each file to specify which objects it should 
be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide 
object assignment for your file in an external mapping file. For more details about providing 
object prefixes for your files see section 1.2.2. For more details about external mapping files 
see section 12.1. 

•  

Procedure: 
1. Create a new project. 

a. Open BB by double clicking on the executable. 

b. From the Project menu select New. 

c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in 
which the project will be saved (click the ellipsis button to browse to it on disk); select 
Content Model “text” from the dropdown; click OK to continue. 

2. Enter DRS deposit information. 

a. Select “Deposit Settings” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter email address(es) for DRS Reports to be sent to. 
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c. Type the email in Success Email field and press Enter on the keyboard. 

d. Type the email in Failure Email field and press Enter on the keyboard. 

e. For more email addresses repeat c and d. 

f. Choose success method ("email" is the most commonly used). 

g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS 
metadata for each batch).  

3. Create object template (called “batch template” in BB 1). 

a. Select “Object Template” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter DRS Owner Code for objects you will be depositing (use all caps). 

c. Enter DRS Billing Code for objects you will be depositing (use all caps). 

d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta 
testing). 

e. Enter the URN Authority Path for your objects (Look up your Path here if needed: 
http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps. 

f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing). 

g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional 
metadata (for example descriptive metadata, roles or/and relationships that will apply to 
your objects). For more about optional metadata see sections 14. Adding Relationships, 15. 
Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting 
Content. Note that metadata entered at the object level will override metadata entered at the 
template level. 

4. Add directories to template. 

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The 
directory name starts with “text” but you can append a custom suffix). 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

e. In the Content Panel switch to Optional tab, scroll down to Text Metadata and use Ctrl 
Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. 
Note that in order to get a delivery URN on deposit a file needs to have a role 
DELIVERABLE set in BB. 

Go to Project menu in the top menu bar and choose Save to save your project. 

5. Move/Copy files into template directory. 

(Done outside Batch Builder) 

Once you added directories to Object Template in BB, they were also created on disk. The 
directory structure on disk is the same as what you see in the Project Panel in Batch Builder 
when you expand the Object Template icon, but on disk the Object Template directory is called 
“template.” If you need to check where on disk Batch Builder built the directory structure, 
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click on Deposit Settings in the Project Panel and take a look at the Project Path field at the 
bottom of the main metadata panel.  

Copy files to the corresponding text directory inside the template directory.  

6. Add object name prefix to file names or supply a mapping.txt file. 

In order to tell BB which object each file should end up with you need to either add object 
name prefixes to each file name or supply a mapping.txt file that associates each file with its 
future object.  

ο Add an object owner supplied name as a prefix to the name of each file. The prefix 
needs to be separated from the file name by the special separator sting “--“.  
E.g.: obj1--file1.txt is a file name that tells Batch Builder that this particular file 
needs to be part of object obj1.  

ο Provide a mapping file mapping.txt placed in the project /_aux/template directory which 
maps each file to an object owner supplied name.  

Syntax:  
relative_file_path,file_OwnerSuppliedName,PDS_sequence 
number(optional),object_OwnerSuppliedName 

Example:  

 
Notes on syntax: There should be no spaces between a comma “,” and the next character. 
If an optional element value is skipped it still needs to be designated by a comma “,” so 
that Batch Builder can associate the right value with the right element. For example, when 
using mapping.txt file for objects other than PDS Documents, an extra comma needs to be 
inserted between the FILE OSN value and Object OSN value where PDS sequence number 
value would be expected.  

7. Create a new object batch. 

You can create your new object batch in the Graphical User Interface or using the Command 
Line Interface (CLI).  

In the Graphical User Interface 

a. From the Object menu in BB select “Create a new batch with objects from template”; enter 
the name of the batch directory to be created on disk and click OK.  A new batch icon will 
be added to the Project Panel on the right (icon with a red letter B) and new objects will be 
built that are going to be part of this batch. 

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to 
expand the tree – it will show the icons for the new objects (a blue letter O). 

c. (Optional) Select the object icon of your new object in the Project Panel and switch to 
“optional” tab in the Content Panel to add any additional optional metadata (for example 
descriptive metadata, roles or/and relationships that will apply to your objects). For more 
about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that 
metadata entered at the object level will override metadata entered at the template level. 

In the Command Line Interface 

document\379129.txt,FILEOSN1,,Obj1 
document\4541102.txt,FILEOSN2,,Obj2 
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a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b 
[batch_directory_name], e.g.: 
batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1 
 
Note that the batch directory name is the name of your new batch directory, to be created 
by BB. 

b. If the batch creation is successful you will see the following messages: 
Initializing BB... 

Done! 

Creating batch1 and objects from files in the template... 

Success! 

8. Process the batch. 

You can process your batch in the Graphical User Interface (GUI) or using the Command Line 
Interface (CLI) 

In the Graphical User Interface 

a.  In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message: FINISHED 
- Creation of batch.xml and descriptors complete for batch: … 

If you see any error messages, remedy the errors and re-process the batch.  

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.: 
batchbuildercli -a build -p “E:\My Project” -b batch1 

b. (Optional) add additional parameters to the bathcbuildercli command to substitute 
batch, object and directory level properties. For more information see section 11. 
Processing Batches Using Command Line Interface. 

c. When the batch is successfully processed you will see the following messages: 

Building PREMIS file metadata... 

Building HulDrsAdmin file metadata... 

Success! 

If you see any error messages at the end of batch processing, remedy the errors and re-process 
the batch (you can disregard any errors showing during batch processing on command line as 
long as you get the final “Success!” message).  
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10. Creating and Processing Audio Object Batches 
10.1 Manually create audio objects from template 
10.2 Automatically build audio objects from template 
10.3  Build an advanced audio batch 

There are four methods you can use to create Audio objects in Batch Builder: 

1. Manually create objects from template. This is best when you have only one or two Audio 
objects to work with. In this scenario you generate in BB an object structure for each object 
and then copy files into it (can be done outside BB). See section 10.1 for the procedure. 

2. Automatically build objects from template. This method is best for large batches of objects 
(over 10 objects). In this scenario BB generates object structure for each of your objects and 
moves files into object directories. Before this can happen you need to rename your files to add 
special “object name” file prefixes or provide mapping files that associate files with their 
objects. See section 10.2 for the procedure. 

3. Use Batch Builder advanced audio functionality to build an advanced audio batch. Use this 
method if you plan to deposit audio files along with additional supporting files containing 
technical and structural metadata about your audio – such as ADL audio decision lists and AES 
60 structural metadata files for governing audio playback. If you do not need to deposit ADL 
or AES-60 files with your audio, use the procedures described in sections 10.1 or 10.2 instead 

4. Manually create objects without using the template. In this method, rather than using the 
template, you fill out object and file metadata and create object directories for each individual 
object one-object-at-a-time.  

10.1 Manually create audio objects from template 
This is a description of the procedure to manually create a batch of Audio objects from template in 
Batch Builder 2 (BB). Use this method when only Audio objects need to be created, processed in 
Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to create, use 
the procedure to build objects automatically.  

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit settings.  

3. Create object template. 

4. Add directories to template. 

5. Create new object batch.  

6. Move/copy files into corresponding directories on disk. 

7. Process the batch. 

8. Upload the batch to your dropbox 

9. Check the email report 

What you need before you start: 
• Prepare several audio files and put them in a directory of your choice somewhere on local hard 

disk or network drive.  If you have more than one audio file per recording (e.g.: an archival 
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master and a deliverable or an archival master, a production master and a deliverable) make 
sure file names match (e.g.: music-1.aif, music-1.wav and music-1.mp3). Consult 
Section 3 of this Guide for more information on file and directory naming. 

• Decide what you will use for Owner Supplied Names for your objects and the files they consist 
of. For instance, you could use local classification or local accession numbers. See Section 3 
for more information about owner supplied names. 

Procedure: 
1. Create a new project. 

a. Open BB by double clicking on the executable. 

b. From the Project menu select New. 

c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in 
which the project will be saved (click the ellipsis button to browse to it on disk); select 
Content Model “audio” from the dropdown; click OK to continue. 

2. Enter DRS deposit settings. 

a. Select “Deposit Settings” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter email address(es) for DRS Reports to be sent to. 

c. Type the email in Success Email field and press Enter on the keyboard. 

d.  Type the email in Failure Email field and press Enter on the keyboard. 

e. For more email addresses repeat c and d 

f. Choose success method (‘email‘ is the most commonly used). 

g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS 
metadata for each batch).  

3. Create object template (called “batch template” in BB 1). 

a. Select “Object Template” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter DRS Owner Code for objects you will be depositing (use all caps). 

c. Enter DRS Billing Code for objects you will be depositing (use all caps). 

d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta 
testing). 

e. Enter the URN Authority Path for your objects (Look up your Path here if needed: 
http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps. 

f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing). 

g. (Optional) switch to “optional” tab to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  

4. Add directories to template. 
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If there is one audio file per object 
 (e.g.: one file that serves as archival master and as deliverable) 

a. Right click on “Object Template” in the Project Panel on the left and add a directory  and 
select the ‘add a directory…’ menu option 

b. Type in a name for your directory in the text box.  The directory name starts with “audio”, 
but the name you type will be appended to it.  Tip: to make it easier to read, start your 
directory name with an underscore (_). So, typing ‘_mp3_files’ will result in a directory 
called ‘audio_mp3_files’. 

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

e. Choose “HIGHUSE” for Usage Class. 

f. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and use 
Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role 
DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs 
to have a role DELIVERABLE set in BB. 

If there are two or more audio files per object  
(e.g.: a separate file for archival master and a separate file for deliverable) 

Create a directory for an archival master and nest one or more deliverable directories inside it 
(this is needed for BB to determine the derivative relationship). 

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add 
a directory …’ menu option.  

b. In the text box, type  ‘-archival_master’ or a similar suffix that describes the role of your 
directory. The directory name will start with “audio” but the name you type will be 
appended to it. So, typing ‘-archival_master’ will result in a directory called ‘audio-
archival_master’  

c. In the Project Panel on the left select the directory you just created. 

d. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”.  

e. Choose “LOWUSE” for Usage Class. 

f. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select 
role ARCHIVAL_MASTER. 

g. In the Project Panel on the left, right click on the directory you just created and select the 
‘add a directory …’ menu option. 

h. In the text box, type ‘-deliverable’ or a similar suffix that describes the role for your 
directory. 

i. In the Project Panel on the left, select the directory you just created. 

j. In the Content Panel choose “no” from the dropdown list for the field “First Generation in 
DRS”. 

k. Choose “HIGHUSE” for Usage Class. 
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l. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select 
role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file 
needs to have a role DELIVERABLE set in BB. 

m. If you have more deliverables that are derived from the archival master (an mp3 
deliverable and an mp4 deliverable for instance) right click on the topmost audio directory 
you created, add a custom suffix if needed and follow steps g-i once again. 

5. Save your work (Project > Save on main menu) 

6. Create new object batch. 

a. Select “Batch>New” from the main menu. Enter a name for the batch (will be used as the 
batch directory name on disk) Click OK. 

Tip: including the word “batch” in your batch name will help you remember the directory’s 
purpose on the file system.  

b.  Select the batch (with the red letter B) in the project Panel. 

c. From the main menu select Object > New; leave Content Model at default (FROM 
TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK.  

d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new 
object.  

e. (Optional) Select each object icon in the Project Panel and edit any needed metadata (for 
instance, if each object has a separate corresponding Aleph record, you can switch to the 
Optional tab in the Content Panel on the right while the object icon is selected in the 
Project Panel on the left and enter the Aleph ID for each object in the “Aleph ID for 
MODS import” field). 

f. Repeat if you have more than object. 

7. Move/copy files into corresponding file directories on disk. 

(Can be done outside Batch Builder) 

The directory structure on disk is the same as what you see in the Project Panel in Batch 
Builder if you expand the batch icon. If you need to check where on disk Batch Builder built 
the directory structure, click on Deposit Settings in the Project Panel on the left and look at the 
Project Path field at the bottom of the Content Panel on the right.  

a. Copy the files for into corresponding file directories in the object directory. 

b. Repeat if you have more than one object. 

8. Process the batch. 

a. In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message: FINISHED 
- Creation of batch.xml and descriptors complete for batch: … 

If you see any error messages, remedy the errors and re-process the batch.   

9. Upload batch to dropbox. 

a. Open your SFTP client and log into your DRS2 training dropbox account. 
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b. Change to the "incoming" directory. 

c. Upload the batch: copy the entire batch directory to the "incoming" directory. 

d. Close the SFTP client.  Batch processing will start. 

10. Check load report in email. 

a. Open your email inbox. 

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" 

For a more readable report, open the attached text file in Excel, or just copy the file listing and 
paste into Excel.   If you see any error messages, remedy the errors and re-process the batch.  

 

10.2 Automatically build audio objects from template 
This is a description of the procedure to automatically build a batch of audio objects from template 
using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that 
need to be created and your source files are not broken into directories by object. 

Procedure summary: 
1. Create a new project. 

2. Enter DRS deposit settings. 

3. Create object template. 

4. Add directories to template. 

5. Move/copy files into template directories. 

6. Add object name prefix to file names or supply a mapping.txt file. 

7. Create new object batch. 

8. Process the batch. 

9. Upload the batch to your dropbox 

10. Check the load report in email 

What you need before you start: 
• Prepare audio files and put them in a directory of your choice somewhere on local hard disk or 

network drive.  If you have more than one file per object (e.g.: an archival master and a 
deliverable or an archival master, a production master and a deliverable) make sure the file 
names match (e.g.: music-1.aif, music-1.wav and music-1.mp3). Consult Naming 
Rules section of this Guide for more information on file and directory naming. 

• Decide what you will use for Owner Supplied Names for your objects and the files they consist 
of. For instance, you could use local classification or local accession numbers. See section 3 of 
this Guide for more information about owner supplied names. 

• Make sure you either provide object name prefix for each file to specify which objects it should 
be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide 
object assignment for your file in an external mapping file. For more details about providing 
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object prefixes for your files see section 1.2.2. For more details about external mapping files 
see section 12.1. 

 

Procedure: 
1. Create a new project. 

a. Open BB by double clicking on the executable. 

b. From the Project menu select New. 

c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in 
which the project will be saved (click the ellipsis button to browse to it on disk); select 
Content Model “audio” from the dropdown; click OK to continue. 

2. Enter DRS deposit settings. 

a. Select “Deposit Settings” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter email address(es) for DRS Reports to be sent to. 

c. Type the email in Success Email field and press Enter on the keyboard. 

d.  Type the email in Failure Email field and press Enter on the keyboard. 

e. For more email addresses repeat c and d. 

f. Choose success method (‘email‘ is the most commonly used). 

g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS 
metadata for each batch).  

3. Create object template (called “batch template” in BB 1). 

a. Select “Object Template” in Project Panel on the left and then enter information in the 
Content Panel on the right. 

b. Enter DRS Owner Code for objects you will be depositing (use all caps). 

c. Enter DRS Billing Code for objects you will be depositing (use all caps). 

d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta 
testing). 

e. Enter the URN Authority Path for your objects (Look up your Path here if needed: 
http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps. 

f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing). 

g. (Optional) switch to “optional” tab to enter any optional metadata (for example descriptive 
metadata, roles or/and relationships that will apply to your objects). For more about 
optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive 
Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  

4. Add directories to template. 

If there is one audio file per object 
 (e.g.: one file that serves as archival master and as deliverable) 
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a. Right click on “Object Template” in the Project Panel on the left and add a directory (The 
directory name starts with “audio” but you can append a custom suffix). 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First 
Generation in DRS”. 

d. Choose “HIGHUSE” for Usage Class. 

e. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and use 
Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role 
DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs 
to have a role DELIVERABLE set in BB. 

If there are two or more audio files per object  
(e.g.: a separate file for archival master and a separate file for deliverable) 

Create a directory for an archival master and nest one or more deliverable directories inside it 
(this is needed for BB to determine the derivative relationship). 

a. Right click on “Object Template” in the Project Panel on the left to add a directory (this 
will be the directory for archival master). The directory name starts with “audio” but you 
can append a custom suffix. 

b. In the Project Panel on the left select the directory you just created. 

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First 
Generation in DRS”.  

d. Choose “LOWUSE” for Usage Class. 

e. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select 
role ARCHIVAL_MASTER. 

f. In the Project Panel on the left right click on the directory you just created and create 
another directory nested inside it (this will be the directory for deliverable audio). Once 
again, append a custom suffix to directory name if needed (e.g. “audio-deliverable”). 

g. In the content panel choose “no” from the dropdown list for the field “First Generation in 
DRS”. 

h. Choose “HIGHUSE” for Usage Class. 

i. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select 
role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file 
needs to have a role DELIVERABLE set in BB. 

j. If you have more deliverables that are derived from the archival master (an mp3 
deliverable and an mp4 deliverable for instance) right click on the topmost audio directory 
you created, add a custom suffix if needed and follow steps g-i once again. 

Go to Project menu in the top menu bar and choose Save to save your project. 

5. Move/Copy files into template directory. 

(Done outside Batch Builder) 
Once you added directories to Object Template in BB, they were also created on disk. The 
directory structure on disk is the same as what you see in the Project Panel in Batch Builder 
when you expand the Object Template icon, but on disk the Object Template directory is called 
“template.”  If you need to check where on disk Batch Builder built the directory structure, 
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click on Deposit Settings in the Project Panel and take a look at the Project Path field at the 
bottom of the main metadata panel.  

ο If you have one audio file per object, copy each file to the corresponding audio directory 
inside the template directory.  

ο If you have more than one file per object, copy the files for each object into corresponding 
nested audio directories in the template directory. 

Important: the file names for all files belonging to the same object need to match (e.g.: 
audio-1.aif; audio-1.wav; audio-1.mp3). 

6. Add object name prefix to file names or supply a mapping.txt file. 

In order to tell BB which object each file should end up with you need to either add object 
name prefixes to each file name or supply a mapping.txt file that associates each file with its 
future object.  

ο Add an object owner supplied name as a prefix to the name of each file. The prefix 
needs to be separated from the file name by the special separator sting “--“.  
E.g.: obj1--file1.aif is a file name that tells Batch Builder that this particular file 
needs to be part of object obj1. Make sure that the file name pattern setting in the BB 
Options dialog is set to the correct setting. See more information about file Owner 
Supplied Name pattern settings in section 1.2.2. 

ο Provide a mapping file mapping.txt placed in the project /_aux/template directory which 
maps each file to an object owner supplied name.  

Syntax:  
relative_file_path,file_OwnerSuppliedName,PDS_sequence 
number(optional),object_OwnerSuppliedName 

Notes on syntax: There should be no spaces between a comma “,” and the next character. 
If an optional element value is skipped it still needs to be designated by a comma “,” so 
Batch Builder can associate the right value with the right element. For example, for objects 
that do not have PDS sequence numbers, an extra comma needs to be inserted between the 
FILE OSN value and Object OS.  
Example:  

 

7. Create a new object batch. 

You can create your new object batch in the Graphical User Interface or using the Command 
Line Interface (CLI).  

In the Graphical User Interface 

a. From the Object menu in BB select “Create a new batch with objects from template”; enter 
the name of the batch directory to be created on disk and click OK.  A new batch icon will 
be added to the Project Panel on the right (icon with a red letter B) and new objects will be 
built that are going to be part of this batch. 

audio_archival-master\379129.aif,FILEOSN1,,Obj1 
audio_archival-master\4541102.aif,FILEOSN2,,Obj2 
audio_archival-master\audio_deliverable\379129.mp3,FILEOSN1,,Obj1 
audio_archival-master\audio_deliverable\4541102.mp3,FILEOSN2,,Obj2 
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b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to 
expand the tree – it will show the icons for the new objects (a blue letter O). 

c. (Optional) Select each object icon in the Project Panel and edit any needed metadata (for 
instance, if each object has a separate corresponding Aleph record, you can switch to the 
Optional tab in the Content Panel on the right while the object icon is selected in the 
Project Panel on the left and enter the Aleph ID for each object in the “Aleph ID for 
MODS import” field). 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b 
[batch_directory_name], e.g.: 
batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1 

Note that the batch directory name is the name of your new batch directory, to be created 
by BB. 

b. If the batch creation is successful you will see the following messages: 
Initializing BB... 

Done! 

Creating batch1 and objects from files in the template... 

Success! 

8. Process the batch. 

You can process your batch in the Graphical User Interface (GUI) or using the Command Line 
Interface (CLI) 

In the Graphical User Interface 

a.  In the Project Panel on the left right-click on the batch you want to process (batch icon 
with a red letter B) and select “Create descriptors and batch.xml.” 

b. Builder will start processing the batch.  

c. When the batch is successfully processed you will see the following message: FINISHED 
- Creation of batch.xml and descriptors complete for batch: … 

If you see any error messages, remedy the errors and re-process the batch. 

In the Command Line Interface 

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to 
the BB installation directory, e.g.:  
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17 

b. Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.: 
batchbuildercli -a build -p “E:\My Project” -b batch1 

c. (Optional) add additional parameters to the bathcbuildercli command to substitute 
batch, object and directory level properties. For more information see section 11. 
Processing Batches Using Command Line Interface. 
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d. When the batch is successfully processed you will see the following messages: 
Building PREMIS file metadata... 

Building HulDrsAdmin file metadata... 

Success! 

If you see any error messages at the end of batch processing, remedy the errors and re-process 
the batch (you can disregard any errors showing during batch processing on command line as 
long as you get the final “Success!” message) 

10.3 Build an advanced audio batch (command line) 
This is a description of the procedure to build an advanced audio batch using Batch Builder 2 
advanced mode.  Use this method if you plan to deposit audio files along with additional 
supporting files containing technical and structural metadata about your audio – such as ADL audio 
decision lists, AES-57 technical metadata files and AES-60 structural files (playlists) for governing 
audio playback. 

If you do not need to deposit these files with your audio, use the procedures described in sections 
10.1 and 10.2 instead.  

If you want to deposit just audio files and corresponding AES-60 playlists but do not need to 
deposit any additional technical metadata files, you may do so using the Audio genre and Text 
genre in Batch Builder GUI. First deposit the audio and then deposit the playlists as a separate Text 
object batch. See Sections 10.1 and 10.2 for depositing simple audio and Section 9 for depositing 
Text Object batches for more information. 

Note that BB2 in advanced mode is COMMAND LINE ONLY. Required and optional metadata 
such as deposit settings, object and file metadata is supplied using special configuration files. 

10.3.1 Command line syntax 
The existing Batch Builder Windows bat and Unix shell scripts are used to launch Batch Builder in 
advanced mode.  The syntax is: 

• On PC: batchbuildercli –advanced audio –d [object directory path] 

ο Use Windows style directory separator ‘\’ 

• On Mac or Linux: ./batchbuildersli.sh -advanced audio –d [object directory path] 

ο use UNIX style directory separator ‘/’ 

Note that by default the object directory name serves as the object Owner Supplied Name (you can 
override that in audio.properties file). 

Example 1 (Windows): 
   batchbuildercli –advanced audio –d “C:\mybatch\004390909” 

Example 2 (Mac / Linux): 
   ./batchbuildersli.sh -advanced audio -d /mybatch/004390909 

10.3.2 Preparation 
1. Arrange the content so that it has the directory structure shown in Figure 1. 
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Figure 1: 
An example directory structure created in preparation for use with Batch Builder. Items highlighted yellow 
must be named as shown. Other directories can exist in the directory structure but Batch Builder will ignore 
them.  
 

…/my_batch-19a326/ 
        my_object-A299ff/ 
   audio.properties  -- required 

relationships.csv  -- required if have derivative relationships                  
mods.xml -- optional (descriptive metadata for the object) 

archival/ -- required if have archival master files 
                    sub_dir1/ 
                              file1.wav 
                              file1.xml [AES57 metadata for file1.wav] 
                               file1.properties [DRS metadata for file1.wav]                                                        
                               file2.wav 
                               file2.xml [AES57 metadata for file2.wav] 

file2.properties [DRS metadata for file2.wav]   
                    sub_dir2/ 
                               file1.wav 
                               file1.xml [AES 57 metadata for file1.wav] 
          file1.properties [DRS metadata for file1.wav] 
                               file2.wav 
                               file2.xml [AES57 metadata for file2.wav] 

file2.properties [DRS metadata for file2.wav] 
                               sub_dir1.adl [ADL for *.wav files in sub_dir1] 
                               sub_dir2.adl [ADL for *.wav files in sub_dir2] 
      digiprov.xml [process history for object] 
deliverable/ 
            performances/ -- required if have deliverable files 
                        file1.mp3 
                        file1.xml [AES57 metadata for file1.mp3] 

file1.properties [DRS metadata for file1.mp3] 
                         file2.mp3 
                         file2.xml [AES57 metadata for file2.mp3] 

file2.properties [DRS metadata for file2.mp3] 
               playlists/ -- required for playlists 
                                             playlist1.xml [AES60 file] 
                                             playlist2.xml [AES60 file] 
     misc/ -- optional 
                       (can contain any # of files in any format) 
    original/ -- optional 
                     audio_object.xml [AES57 metadata for original item] 
    production/ -- required if have production master files 
                      sub_dir1/ 
                              file1.wav 
                              file1.xml [AES57 metadata for file1.wav] 

file1.properties [DRS metadata for file1.wav] 
                               file2.wav 
                               file2.xml [AES57 metadata for file2.wav] 
          file2.properties [DRS metadata for file2.wav] 
                         sub_dir2/ 
                               file1.wav 
                               file1.xml [AES57 metadata for file1.wav] 

file1.properties [DRS metadata for file1.wav] 
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                               file2.wav 
                               file2.xml [AES57 metadata for file2.wav] 

file2.properties [DRS metadata for file2.wav] 
 
                         sub_dir1.adl [ADL for *.wav files in sub_dir1] 
                         sub_dir2.adl [ADL for *.wav files in sub_dir2] 
    workspace/-- optional 
                                 (can contain any # of files in any format) 
 

2. Create the required audio.properties configuration file. This contains all required batch and 
object settings. The format of it must be: 

a. US-ASCII text 

b. Each line in “property=value” format 

c. Lines can be commented out by starting the line with the ‘#’ symbol. 

d. Can’t use reserved XML characters (see the table below for full list). 

The table below lists the properties that can be specified in this file. An example audio.properties 
file is shown in Figure 2. 

Property Valid Values Example Meaning 

download true, false dowload=true specifies whether deliverable 
audio can be downloaded or 
can only be streamed. If 
dowload=true two delivery 
URNs will be created for 
deliverable audio -- one for 
FDS and one for SDS. 

accessFlag one of: P,R,N R The default access flag to use 
for this object’s files. Can be 
overridden by the access flag 
specified in file level 
properties files. 

alephID a valid Aleph 
Identifier 

009513791-2  

authorityPath a valid NRS authority 
path 

FHCL.Loeb Authority path for any URNs 
that will be created for this 
object’s files 
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batchName 100 character limit; 
Valid values: ASCII 
alpha-numeric 
characters,  / "-" / "." / 
"_" / "~"/ 

 
The  following 
reserved XML 
characters should be 
excluded:  

gen-delims  = ":" / "/" / 
"?" / "#" / "[" / "]" / 
"@" 
 
      sub-delims  = "!" / 
"$" / "&" / "'" / "(" / ")" 
                  / "*" / "+" / 
"," / ";" / "=" / 

Valid value examples: 
Project_137_4a~5.1a 

Batch-123_23yux-a.21 

 

Invalid values examples: 

batch&&<<>>><! 

project清代盐政与盐稅 

Name for the batch 

billingCode a valid DRS billing 
code 

FHCL.MUSI.MUS_004 Billing code for the object 

depositAgent a valid 8 digit HUID xxxxxxxx Person depositing the object.  

objectOSN A unique value within 
the content’s DRS 
owner code 

A299ff Name for the object 

ownerCode a valid DRS owner 
code 

FHCL.MUSI Owning unit of the object 

resourcePattern an NRS resource 
pattern, see Section 
13.1 Assigning URN 
Resource Name 
Patterns 

{n} Resource name pattern for 
any URNs created for this 
object’s files 

role currently no roles for 
audio object are used 

 One or more roles for the 
object (not likely to be used - 
included to support future 
uses) 
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failureEmail one or more valid 
email addresses 
separated by commas 

example1@fas.harvard.ed
u, 
example2@fas.harvard.ed
u   

People who will be sent failed 
loader reports 

successEmail one or more valid 
email addresses 
separated by commas 

example1@fas.harvard.ed
u, 
example2@fas.harvard.ed
u 

People who will be sent 
successful loader reports 

successMethod one of: EMAIL, 
DROPBOX, ALL 

EMAIL Distribution method for the 
loader reports 

 
 

 
Figure 2: an example audio.properties file 

#properties for the object 

alephID=009513791 

authorityPath=FHCL.Loeb 

batchName=Project_137_4a 

billingCode= FHCL.MUSI.MUS_004 

depositAgent=12345678 

failureEmail=example1@fas.harvard.edu,example2@fas.harvard.edu 

objectOSN= A299ff 

ownerCode=FHCL.MUSI 

resourcePattern={n} 

successEmail=example1@fas.harvard.edu,example2@fas.harvard.edu 

successMethod=EMAIL 

  
Place the audio.properties file at the same file system level as the object directory, e.g.: 

…/my_batch-19a326/ 

  my_object-A299ff/  

  audio.properties 

 

3. Create a relationships file. This must be a comma-separated file named relationships.csv, 
supplying relationships between files in the object, and/or between this object and DRS 
objects, and/or between files in this object and DRS files or objects. The format must be: 
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source,relationship_name,target_type,target 

where 

ο source: 

 for files in this object: relative path to the source file from the object directory 

 for this object: the word object# 

ο relationship_name, one of: 

 HAS_SOURCE (indicates derivative relationships between files in this object) 

 HAS_DOCUMENTATION (for pointing from files or the object to DRS-stored 
documentation files or objects) 

 HAS_METHODOLOGY (for pointing from the object to a DRS-stored methodology 
object) 

 HAS_RIGHTS (for pointing from files or the object to DRS-stored rights files or 
objects) 

ο target_type, one of: 

 RELATIVE_PATH (used for a relative file path) 

 HUL_DRS_OBJECT_URN# (used for the URN of a DRS object) 

■ For example: urn-3:HUL.DRS.OBJECT:175616 

■ These are persistent IDs new to DRS2 given to all objects that always have a 
HUL.DRS.OBJECT authority path 

 OBJECT_OSN# (used for the owner supplied name of a DRS object having the same 
owner code as this object)  Note that the object ingest service needs to be updated to 
support handing relationships using OBJECT_OSN 

 We also support HUL_DRS_OBJECT_ORACLE and HUL_DRS_FILE_ORACLE 
target_type values 

ο target: relative path to a file, DRS object URN or DRS object owner supplied name# 

 

Lines can be commented out by starting the line with the ‘#’ symbol 

 
Figure 3: an example relationships.csv file (the paths need to be in the form supported by the 
OS you are running Batch Builder on)  

# Derivative audio content relationships 

deliverable\performances\file1.mp3,HAS_SOURCE,RELATIVE_PATH,production\sub_dir1\file1
.wav 

deliverable\performances\file2.mp3,HAS_SOURCE, 
RELATIVE_PATH,production\sub_dir1\file1.wav 

deliverable\performances\file3.mp3,HAS_SOURCE, 
RELATIVE_PATH,production\sub_dir1\file2.wav 
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deliverable\performances\file4.mp3,HAS_SOURCE, 
RELATIVE_PATH,production\sub_dir1\file2.wav 

 

Place this file at the same file system level as the object directory, e.g.: 

…/my_batch-19a326/ 

  my_object-A299ff/ 

  audio.properties 

  relationships.csv 

 

Note that the following relationships are automatically determined by Batch Builder and should not 
be listed in the relationships.csv file: 

• HAS_DOCUMENTATION relationships between audio files and audio decision lists 
deposited at the same time 

• HAS_PRESENTATION relationships between audio deliverable files and AES60 playlist 
objects deposited at the same time. 

4. If manually supplying descriptive metadata, create a MODS file called mods.xml complying 
with MODS schema versions 3.4 or earlier#.  See http://www.loc.gov/standards/mods/ for more 
information about MODS metadata and schemas. 

Place this file at the same file system level as the object directory, e.g.: 

…/my_batch-19a326/ 

  my_object-A299ff/ 

  audio.properties 

  mods.xml 

  relationships.csv 

Note that as an alternative to supplying a MODS file, descriptive metadata can be 
imported from Aleph by Batch Builder by providing an Aleph ID in the audio.properties 
file (See Figure 2). 

5. Optionally provide technical metadata for files in the batch in the AES57 format. 

These files should be named the same as the files they describe, except with an xml file 
extension. For example in Figure 1 on page 1 of this document, the file at 

my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.xml 

contains technical metadata for the file at 

my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.wav 

Batch Builder will read in and use the technical metadata supplied by these files but will 
supplement it with format metadata supplied by FITS (see http://fits.googlecode.com). 

6. Optionally provide properties files for files in the batch to override Batch Builder-configured 
metadata values. These files can contain any file-level batch Builder properties shown in the 
Table below.  
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Property Valid values Example Meaning 

accessFlag one of: P,R,N P Access level of file 

adminCategory# -- done A comma-delimited 
list of one or more 
Wordshack URIs – 
You can alternatively 
use the same string 
formatting used in the 
BB GUI 

http://id.lib.harvard.e
du/wordshack/admin
Category/12345 

Administrative categories to 
associate with the file 

fileosn  34561-a7-bach Name for the file (not 
necessarily unique) 

isFirstGenerationInDrs one of: yes, no, 
unspecified 

yes whether or not the file is the 
closest version in the DRS to 
the original capture or 
creation 

isPreferredDeliverableS
ource 

one of: yes, no, 
unspecified 

yes whether or not the file is the 
recommended file to use for 
generating future 
deliverables 

processing comma-delimited list 
of one or more of: 
CROPPED 
BIT_REDUCED 
BRIGHTNESS_ADJU
STED 
COLOR_CORRECTE
D 
CONTRAST_ADJUS
TED 
DENOISED 
DESKEWED 
DOWN_MIXED 
DYNAMIC_RANGE_
COMPRESSED 
EQUALIZED 
GAMMA_CORRECT

BIT_REDUCED, 
DENOISED 

Key actions taken on the file 
before it was deposited to the 
DRS 
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ED 
LEVEL_ADJUSTED 
PHASE_INVERTED 
PROCESSED 

SAMPLERATE_CON
VERTED 
SHARPENED 

quality one of: 1, 2, 3, 4, 5, 6, 
7, 8, 9, 10 

5 Locally-defined measure of 
quality 

usageClass One of: HIGHUSE, 
LOWUSE 

LOWUSE Estimate of how frequently 
the file will be accessed by 
library users 

methodology (any text)  Notes about the methods 
performed and/or tools used 
in the creation, processing or 
preparation of the content 
prior to DRS deposit 

role comma-delimited list 
of one or more of#: 
ARCHIVAL_MASTER,
CONTAINER,DELIVE
RABLE,DOCUMENT
ATION,LICENSE,LO
G,ORIGINAL_ORDER
,PAGE_COORDINAT
ES,PAGE_IMAGE,PA
GE_TEXT,PRODUCT
ION_MASTER,STYLE
_SHEET,TARGET_DE
SCRIPTION,TARGET
_IMAGE,THUMBNAI
L,AUDIO_DECISION
_LIST,PROCESS_FIL
ES,PROCESS_HISTO
RY 

DELIVERABLE  

downloadProhibited 

(for audio files) 

yes yes Audio file must be streamed 
- direct download will not be 
permitted 
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downloadProhibitedBas
is 

(for audio files) 

one of: Harvard 
policy, license, statute, 
Risk assessment 

license Basis for the restrictions or 
terms of use 

downloadProhibitedLic
ense 

(for audio files) 

DRS object URN of 
the license object 

urn-
3:HUL.DRS.OBJEC
T:197548 

ID of the documentation 
within the DRS, e.g. a 
deposited donor agreement 

downloadProhibitedLic
enseTerms 

(for audio files) 

(any text) 90 year policy A note about the 
documentation, e.g. the 
applicable section 

downloadProhibitedGra
ntStart 

(for audio files) 

A date/timestamp yyyy-mm-dd 

yyyy-mm 

yyyy 

schema date  and 
schema dateTime 
formats 

Embargo start date 

downloadProhibitedGra
ntEnd 

(for audio files) 

A date/timestamp yyyy-mm-dd 

yyyy-mm 

yyyy 

schema date  
and schema 
dateTime 
formats 

Embargo end date 

 

Note that because of the way the support for PREMIS rights is implemented in the advanced workflow 
properties files, you can also set object level embargo and secure storage rights in the audio.properties 
files.  You just need to use the appropriate property names. 

These files should be named the same as the files they describe, except with a properties file extension. 
For example the file at 

my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.properties 

would contains metadata for the file at 

my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.wav 
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10.3.3 Batch Builder Execution 
The syntax is: 

./batchbuildercli.sh -advanced audio -d path-to-object-directory 

where the path-to-object-directory is a relative or absolute path to the directory containing the 
content needed to build a single audio object. 

For example: 

./batchbuildercli.sh -advanced audio -d /home/prod/content/my_batch-19a326/obj-994533 

The program will: 

• Create a directory at workspace/moved_content 

• Put a copy of the files that were in the misc directory in the workspace/moved_content 
directory 

• Zip up the contents of the misc directory and name it misc_files.zip 

• Create the object descriptor for the audio content 

ο The AES57 file at original/?.xml will be interpreted as technical metadata for the original 
item to be stored in a <sourceMD> element in the descriptor 

ο If any AES60 files were included in the playlist directory: 

ο Build separate Text objects for each playlist 

 The file name# will be used as the object owner-supplied-name 

 Create the object descriptor for each object 

 The descriptor will be named {object-OSN}_descriptor.xml and will be written to the 
batch directory 

 (Relationships between the playlist object and audio deliverable files will be 
automatically created by the DRS Loader.) 

After executing Batch Builder the following changes should be visible in the batch directory: 

…/my_batch-19a326/ 

  batch.xml [DRS batch loading file] 

  descriptor.xml [object descriptor for the audio object] 

  my_object-A299ff/ 

    misc/ 

      misc_files.zip [the files that were in the misc directory] 

    workspace/ 

         moved_content/ [will contain the content that was in the misc directory] 

playlist1-A299ff_descriptor.xml [object descriptor for the playlist object containing playlist1-   
A299ff.xml] 

playlist2-A299ff_descriptor.xml [object descriptor for the playlist object containing playlist2-
A299ff.xml] 
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10.3.4 Depositing to the DRS 
After executing the script, copy the following portion of the directory structure to your DRS 
dropbox. 

…/my_batch-19a326/ [example batch directory] 

  batch.xml 

  descriptor.xml 

  my_object-A299ff/ [example object directory] 

    archival/ 

    deliverable/  

    misc/  

    original/ 

    production/ 

  playlist1-A299ff_descriptor.xml [example descriptor for a playlist object] 

  playlist2-A299ff_descriptor.xml [example descriptor for a playlist object] 

 

The DRS loader will not automatically delete any files or directories that are uploaded to a dropbox 
but that aren’t referenced in the object descriptors. These files and directories should be filtered out 
as part of the transfer process; otherwise they will need to be manually deleted from the dropbox. 
These include: 

• Any other subdirectories in the object directory (e.g. pre-archival, workspace) 

• Properties files (audio.properties) 

• AES57 files used to indicate metadata for the original item or for audio content files (*.xml) 

• MODS file (mods.xml) 

• Relationships file (relationships.csv) 

 

Notes 

• Object owner-supplied-names (Object OSNs) 

ο Object OSNs are required in DRS 2 and must be unique within a DRS owner code.  Please 
keep that in mind when explicitly assigning objects names, for example in the 
audio.properties file; or implicitly for example, by the file names of the AES60 playlists. 

• URNs 

ο An object-level URN is automatically given to all objects. 

 These URNs will have a HUL.DRS.OBJECT authority path, e.g. 
 urn-3:HUL.DRS.OBJECT:175844 

ο File-level URNs are automatically given to files with the role DELIVERABLE. 
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 These URNs will have a local authority path, e.g. 
 urn-3:FHCL.Loeb.Faids:mus00023 

11. Processing Batches Using Command Line Interface 
11.1 Basic command line syntax 
11.2 Switches 
11.3 Deposit settings properties 
11.4 Object properties 
11.5 Directory properties 

The Batch Builder 2 installation package includes a command line interface tool (CLI) designed 
for automated deposit workflows that performs three actions: 

• build: build the descriptors and batch.xml for a specified batch within a specified project using 
batch, object and directory level property values supplied on command line or/and  in the 
Graphical User Interface (GUI). 

• templatedirs: rebuild the directories in the object template from the information in the project 
configuration file . 

• buildtemplate: Create a new batch with objects from template in the specified project. 

CLI should be used in conjunction with the GUI. For instance, a depositor can use the Batch 
Builder GUI to build the initial project, and then use the command line to substitute batch-level, 
object-level and directory level metadata values when processing batches of objects.  

CLI On-screen Help. To see on-screen help while in CLI type: 

batchbuildercli –h to display only example usage 

batchbuildercli –fullhelp to display example usage and a list of all overridable 
batch, object and directory properties 

11.1 Basic command line syntax 
Please note that on computers running Microsoft Windows XP or later, the maximum length of the 
string that you can use at the command prompt is 8191 characters.  
batchbuildercli -a action -p project_dir -b batch_name 

-a actions:  templatedirs, buildtemplate, build. 

[-aleph object_name=123;...] 

[-batchprop property=value,property=value,property=value...] 

[-objectprop object_name::property=value,property=value;...] 

[-dirprop 
object_name::directory_path::property=value,property=value;...] 

11.2 Switches 
-a [action] –required – accepts three actions: templatedirs, buildtemplate, and 
build.  

• templatedirs: rebuild the directories in the object template from the information in the project 
configuration file . 
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• buildtemplate: Create a new batch with objects from template in the specified project. 

• build: build the descriptors and batch.xml for a specified batch within a specified project using 
batch, object and directory level property values supplied on command line or/and  in the 
Graphical User Interface (GUI). 

-p [project directory path]   – required – indicates the path to the project directory on disk.  This 
path must be created in Batch Builder GUI before using the command line option.  The project path 
cannot be created while executing this command.  If path does not already exist the action will fail. 

-b [batch_name]   –  required for actions buildtemplate and build – name of batch 
directory.  When using buildtemplate action BB2 will create a new batch directory with the 
name specified by the –b switch, e.g.: batchbuildecli –a buildtemplate –p 
c:\myproject\ -b new_batch_directory_name. When using the build action, 
BB2 will process the existing batch directory specified by the –b switch, e.g.: batchbuildecli 
–a build –p c:\myproject\ -b existing_batch_directory_name. 

-aleph [object_name1]=[alephID];[ object_name2]=[alephID] etc.   – optional – system number 
of corresponding record in ALEPH.  Batch Builder uses this number to pull metadata from the 
corresponding ALEPH record into the MODS section of the object descriptor. This switch can be 
used with action build. Example:  

-aleph obj1=12345;obj2=67890 

Note that no other methods of entering aleph id or MODS should be used for the batch if this 
switch is invoked – such as mapping files with ALEPH IDs, user supplied MODS files, descriptive 
metadata entered in the GUI or ALEPH IDs supplied in the GUI – otherwise BB will throw an 
error or silently fail to write the new ALEPH ID into the descriptor. 

-batchprop [property=value,property=value,property=value...] – optional – overrides specified 
project deposit settings for a given batch. The -batchprop argument must be wrapped in quotes to 
ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should 
be separated by a comma ‘,’. Repeatable batch property values should be as property=value pairs 
separated by a comma – e.g.:   

- batchprop “successEmail=success1@example.com,successEmail=success2@example.com” 

-objectprop [object_name::property=value,property=value;...] – optional – overrides specified 
object metadata properties for given objects. The -objectprop argument must be wrapped in quotes 
to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair 
should be separated by a comma ‘,’.  

-dirprop [object_name::directory_path::property=value,property=value;...] – optional – 
overrides specified file metadata property values for given files. The -dirprop argument must be 
wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each 
property=value pair should be separated by a comma ‘,’.  

11.3 Deposit settings properties (batch properties) 
Syntax: -batchprop property=value,property=value,property=value... 

• projectName -- substitutes passed string for the existing BB project name 

• projectDescription – substitutes passed string for the existing content of the project 
description field 
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• batchName – substitutes passed string for the default batch name (not the batch directory 
name ) 

E.g.: -batchprop batchName=mybatch 

E.g.: - batchprop batchName={depositAgent}{batchDir}{ss} 

• successEmail – substitutes passed string for success email(s) (emails should be separated 
by comma without any blank space in between) 

E.g.: - batchprop successEmail=myname@example.com,myname2@example2.com 

• failureEmail – substitutes passed string for failure email(s) 

E.g.: - batchprop failureEmail=myname@example.com,myname2@example2.com 

• successMethod - substitutes passed string for the successMethod specified in deposit 
settings panel in the GUI. The options are email, all, dropbox. 

E.g.: - batchprop successMethod=email 

• depositAgent - substitutes passed string for the deposit agent HUID specified in deposit 
settings panel 

E.g.: - batchprop depositAgent=12345678 

Example:  
C:\Program Files\BatchBuilder\BatchBuilder-2.0.14> 
batchbuildercli -a build -p "C:\Documents and 
Settings\user\Desktop\stillimage-imgs-frm-via-nomods-20110714" 
-b batch3 –batchprop 
“batchName=mybatch{depositAgent}{batchDir}{ss},successEmail=suc
cess@me.me,failureEmail=failure@me.me,successMethod=email,depos
itAgent=12345678” 

11.4 Object properties 
Syntax: -objectprop 
object_name1::property=value,property=value;object_name2::property
=value,property=value; etc. 

List of overridable object properties 
Property Name Definition 
ownerCode DRS Owner Code 
billingCode DRS Billing Code 
accessFlag DRS Access Flag 
adminCategory Administrative Category ID (can be looked 

up in Word Shack by searching for Admin 
Category display value 

captionBehavior IDS / PDS Caption Behavior 
captionUnitName IDS / PDS Caption Unit Name 
captionDescription IDS / PDS Caption Description 
metsLabel METS Label display value (currently 

displays in citation label of PDS Document 
objects) 
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methodology Object methodology 
nonPublicNote Value for the non-public note field 
processingLevel Object processing level 
producer Object producer – controlled value from 

Word Shack 
relatedLinks Related links values – displays in PDS 
harvardMetadataLinks Harvard metadata links values – displays in 

PDS 
viewText viewText option – affects display of text in 

PDS 
secureStorage Rights Metadata – not yet implemented. 

Expected in Production Release 2. 
secureStorageBasis Rights Metadata – not yet implemented. 

Expected in Production Release 2. 
secureStorageLicense Rights Metadata – not yet implemented. 

Expected in Production Release 2. 
secureStorageLicenseTerms Rights Metadata – not yet implemented. 

Expected in Production Release 2. 
secureStorageGrantEnd Rights Metadata – not yet implemented. 

Expected in Production Release 2. 
embargoDuration Embargo duration value in days, months or 

years 
embargoBasis One of the controlled values:   

• Harvard policy 
• license 
• risk assessment 
• statute 
• copyright 

embargoLicense URN of the DRS license object – 
corresponds to BB GUI field Documentation 

embargoLicenseTerms Corresponds to BB GUI field Documentation 
Note 

embargoGrantStart Corresponds to BB GUI field Start Date 
embargoGrantEnd Corresponds to BB GUI field End Date 
harvardPolicy URN of an existing Harvard policy object in 

DRS 
license URN of an existing license object in DRS 
statute URN of an existing statute object in DRS 
titleInfoType MODS Metadata – see 

http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoTitle MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoSubTitle MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
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information 
titleInfoPartNumber MODS Metadata – see 

http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoPartName MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoNonSort MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoType2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoTitle2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoSubTitle2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoPartNumber2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoPartName2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

titleInfoNonSort2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameType MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameAuthority MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameNamePart MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameNamePartType MODS Metadata – see 
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http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameDisplayForm MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameAffiliation MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameRoleTerm MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameDescription MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameType2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameAuthority2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameNamePart2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameNamePartType2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameDisplayForm2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameAffiliation2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameRoleTerm2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameDescription2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
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information 
nameType3 MODS Metadata – see 

http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameAuthority3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameNamePart3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameNamePartType3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameDisplayForm3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameAffiliation3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameRoleTerm3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

nameDescription3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

typeOfResource MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

typeOfResourceCollection MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

typeOfResourceManuscript MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

genre MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoPlaceTerm MODS Metadata – see 
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http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoPublisher MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoDateIssued MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoDateCreated MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoDateCaptured MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoDateValid MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoDateModified MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoCopyrightDate MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoDateOther MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

originInfoEdition MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

languageTerm MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

physicalDescriptionReformattingQuality MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

physicalDescriptionDigitalOrigin MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
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information 
abstract MODS Metadata – see 

http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

tableOfContents MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

classification MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

identifier MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

identifierType MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

identifier2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

identifierType2 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

identifier3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

identifierType3 MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

ccessCondition MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

accessConditionDisplayLabel MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

accessConditionType MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

recordInfoRecordIdentifier MODS Metadata – see 
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http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

recordInfoSource MODS Metadata – see 
http://www.loc.gov/standards/mods/v3/mods
-userguide-elements.html for more 
information 

has_documentation Object URN of a related Documentation 
object in DRS 

Has_methodology Object URN of a related Methodology object 
in DRS 

urnAuthorityPath URN Authority Path 
resourceNamePattern Resource Name Pattern for a URN 
role Object role 

Example 1:  
C:\Program Files\BatchBuilder\BatchBuilder-2.0.14> batchbuildercli 
-a build -p "C:\Documents and Settings\user\Desktop\stillimage-
imgs-olivia" -b batch3 -objectprop 
"Obj1::ownerCode=FHCL.FAL,billingCode=FCHL.FAL.SSP_0001,urnAuthori
tyPath=FHCL" 

Example 2:  
C:\Program Files\BatchBuilder\BatchBuilder-2.0.14> batchbuildercli 
-a build -p "C:\Documents and Settings\user\Desktop\stillimage-
imgs-olivia" -b batch4 -objectprop 
"Obj1::ownerCode=FHCL.FAL,billingCode=FCHL.FAL.SSP_0001,urnAuthori
tyPath=FHCL;Obj2::ownerCode=FHCL.FAL,billingCode=FCHL.FAL.SSP_0001
,urnAuthorityPath=FHCL" 

11.5 Directory (file) properties 
Syntax: -dirprop 
“object1::directory_path1::property=value,property=value;object1::
directory_path2::property=value,property=value;object2::directory_
path1::property=value,property=value” ... etc. 

List of overridable directory properties 
Property Name Definition 
accessFlag File DRS Access Flag 
adminCategory Administrative Category ID (can be looked 

up in Word Shack by searching for Admin 
Category display value) 

adminFlag Adminstrative Flag 
adminFlagNote Administrative Flag Note 
isFirstGenerationInDrs Is first generation in DRS 
isPreferredDeliverableSource Is preffered deliverable source (for future 

reformatting purposes) 
nonPublicNote Value for the non-public note field 
processing Processing 
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producer Object producer – controlled value from 
Word Shack 

quality Quality 
usageClass Usage Class 
methodology File Methodology 
processingNote Processing Note (Text files) 
encodingAgent Encoding Agent (Text files) 
encodingRole Encoding Role (Text files) 
language Language (Text files) 
disposition Audio Metadata 
useType Audio Metadata 
leftRightPanMap Audio Metadata 

frontRearPanMap Audio Metadata 
role Role 
has_target Has target in DRS 
has_color_profile Has color profile in DRS 
has_world_reference_data Has world location in DRS 
has_documentation Has documentation in DRS 
has_subset Has subset files in DRS 
has_presentation Has a playlist in DRS (Audio only) 
maxPixelDimension IDS restriction on delivery size for JP2 

images in pixels 
maxPixelBasis One of the controlled values:   

• Harvard policy 
• license 
• risk assessment 
• statute 
• copyright  

maxPixelLicense URN of the DRS license object – 
corresponds to BB GUI field 
Documentation 

maxPixelLicenseTerms Corresponds to BB GUI field 
Documentation Note 

downloadProhibited Prohibits delivery of audio as downloadable 
file. Audio will only be delivered as 
streaming 

downloadProhibitedBasis One of the controlled values:   
• Harvard policy 
• license 
• risk assessment 
• statute 
• copyright 

downloadProhibitedLicense URN of the DRS license object – 
corresponds to BB GUI field 
Documentation 

downloadProhibitedLicenseTerms Corresponds to BB GUI field 
Documentation Note 

harvardPolicy Object URN of related Harvard policy 
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object in DRS 
license Object URN of related license object in 

DRS 
statute Object URN of related statute object in 

DRS 
idsDeliverableURNs Additional IDS URNs for individual images 

within a PDS Document object 

See the DRS 2 Metadata Reference document on the DRS 2 iSite for more detailed descriptions of 
the substituted properties. See Adding Relationships section for more details definitions of 
substituted relationship values. 

Example 1:  
C:\Program Files\BatchBuilder\BatchBuilder-2.0.17>batchbuildercli 
-a build -p "E:\Testing\BatchBuilderProjects\Still-Image-20110907" 
-b batch4 -batchprop 
"successEmail=success1@example.com,successEmail=successemail2@exam
ple.com,failureEmail=failure@example.com" -objectprop 
"obj1::ownerCode=FHCL.FAL,billingCode=FHCL.FAL.SSP_0001,accessFlag
=R,urnAuthorityPath=FHCL;obj2::ownerCode=FHCL.FAL,billingCode=FHCL
.FAL.SSP_0001,accessFlag=R,urnAuthorityPath=FHCL" -dirprop 
"obj1::image_archmaster::accessFlag=N,isFirstGenerationInDrs=yes,q
uality=10;obj1::image_archmaster\image_deliverable::accessFlag=R,i
sFirstGenerationInDrs=yes,quality=5"  
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12. Using External Mapping Files to Supply 
ownerSuppliedNames, Page Sequence Numbers and Aleph 
IDs. 

12.1 Using mapping.txt file 
12.2 Using object_mapping.txt file 

Batch Builder can use external mapping files to: 

1. Associate Owner Supplied Names with existing files and new (to be built automatically by 
BB) objects (mapping.txt) 

2. Associate Aleph IDs with new (to be built automatically by BB) objects (mapping.txt) 

3. Determine page sequence numbers for PDS Document objects (mapping.txt) 

4. Associate Aleph IDs with existing objects (object_mapping.txt) 

5. Associate Owner Supplied Names with existing objects (object_mapping.txt) 

Mapping files can be used in two ways: 

• To interact with files and objects during automatic object building from template. 

• To interact with files and objects during batch processing. 

Batch Builder will display an INFO message in the message panel when any of the auxiliary input 
files are discovered, e.g.: 
INFO   - found mapping.txt in E:\Testing\ 
DRS_2.2\BatchBuilderProjects\StillImage-2-3-11\_aux\batch1\ObjwJP2 

12.1 Using mapping.txt file 

Rules for using mapping.txt file 
File name: mapping.txt 

Function:  

• Objects that are built by BB automatically from template will inherit the following property 
values specified in this file: File Owner Supplied Name, PDS Document sequence number, 
Object Owner Supplied Name and Aleph ID. 

• Objects that are created manually will inherit the following property values specified in this 
file: File Owner Supplied Name, PDS Document sequence number. 

Placement:  

• For use during automatic object building, place the file in the 
{project_dir}/_aux/template/ directory 

When used with the automatic object building function the file will be automatically copied to 
{project_dir}/_aux/{batch_name}/{object_name}/ for each object created. 

• For use during manual object building, place the file in the 
{project_dir}/_aux/{batch_name}/{object_name}/ directory 
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Syntax:  
relative_file_path,file_OwnerSuppliedName,PDS_sequence 
number(optional),object_OwnerSuppliedName(optional), 
AlephNumber(optional)  

E.g.: 

 
Notes on syntax: There should be no spaces between a comma “,” and the next character. If an 
optional element value is skipped it still needs to be designated by a comma “,” so Batch Builder 
can associate the right value with the right element. E.g.:  

 
• Relative file path: the relative path to the file (including the file name and extension), from 

either the _aux/{batch}/{object}, or _aux/template directory. This is the file that the next 3 
parameters will be applied to. 

• File Owner Supplied Name: (Required) - The file owner supplied name 

• Sequence number: (Optional) - Alternate method to providing the sequence number as part of 
the file name pattern. This controls in which order page images and text appear in PDS 
Document objects when they are displayed in PDS. 

• Object Owner Supplied Name: (Optional) - When the object Owner Supplied Name is not 
provided as part of the file name pattern, then this property can be used to control which files 
are added to which objects when building objects from the template. This parameter is ignored 
when the mapping.txt file is placed directly into _aux/{batch}/{object}/ directory for a 
manually created object.  

• Aleph ID (Optional) - Aleph ID of the HOLLIS record where the object is described. Batch 
Builder imports MODS descriptive metadata from the HOLLIS record specified and places it 
into the object descriptor during batch processing.  

Note that there are multiple methods of passing a MODS descriptive metadata file to Batch 
Builder. Only one method at a time can be used.  

Procedure for creating and placing a mapping file 
Create the mapping file: 

1. Create a text file called "mapping.txt".  If your batch contains multiple objects, file mappings 
for all objects can go in this one file. 

2. Add a line of mapping values for every file to be mapped, using the syntax:   

relative_file_path,file_OSN,PDS_sequence_number(optional),object_OSN(optional),AlephID 
(optional) 

image_archival-master\379129.tif,ac1234,,ObjwTiff,  
-- skipped sequence number value, skipped Aleph ID value. 
image_archival-master\379129.tif,ac1234,,, 
-- skipped sequence number value, skipped Object OwnerSuppliedName value, skipped 
Aleph ID value. 

image_archival-master\379129.tif,ac1234,1,ObjwTiff,12345 
image_archival-master\4541102.jp2,ac5678,2,ObjwJP2,67890 
image_archival-master\image_deliverable\379129.jpg,ac1234,1,ObjwTiff,12345 
image_archival-master\image_deliverable\4541102.jpg,ac5678,2,ObjwJP2,67890 
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Example that maps file OSN only: 

image-archivalmaster\379129.tif,ac1234,,, 
image-archivalmaster\image-deliverable\379129.jpg,ac5678,,, 

3. Save the mapping.txt file.   

Add the mapping file to the batch: 

1. If using the manual object workflow: 

a. Create the batch with objects (Step 5 in the batch procedure).  This will generate batch 
directory structure on disk.  

b. Copy mapping.txt into the object directory inside the BB project's auxiliary (_aux) path:  

{project_dir}/_aux/{batch_name}/{object_name}/ 

 

If you have file mappings for multiple objects in a batch, place a copy of the same file into 
each corresponding object directory inside the BB project's auxiliary (_aux) path. 

c. Continue with your batch procedure. 

2. If using the automatic object workflow: 

a. Add directories to the template and copy content files into those directories (Steps 4-5 in 
the batch procedure). 

b. Place mapping.txt into the template directory in the BB project's auxiliary (_aux) path: 

{project_dir}/_aux/template/ 

c. Continue with your batch procedure. 

3. When BB processes the batch, an INFO message displays in the message panel when the 
mapping file is discovered, for example: 

INFO   - found mapping.txt in C:\drs2-beta2-training-BB\BB2-projects-2.0.19o\image-
project\_aux\batch-brueghel-skaters-3\object-skaters-3 

12.2 Using object_mapping.txt file 
File Name: object_mapping.txt 

Function: The objects contained in the batches processed by Batch Builder will inherit the 
property values (such as Aleph IDs and object owner supplied names) specified in the file (note 
that this file is not used for automatic object building).  This file is accessed by Batch Builder 
during batch processing (generating the batch/xml file and the descriptor). 

Placement: There is one object_mapping.txt file per project. It needs to be placed in 
{project_dir}/_aux/template/ directory. It is read in once when the project is opened. 
If you created and placed the file while BB was open, you will need to restart BB so that the file 
can be accessed during batch processing. 

Syntax: 
object_directory_name,ALEPH_number,Object_Owner_Supplied_Name 

• Object directory name: (Required) - The name of the directory in which object is contained. 
E.g.: birdsofasia 
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• Aleph id: (Optional) - Aleph ID of the HOLLIS record where the object is described. Batch 
Builder imports MODS descriptive metadata from the HOLLIS record specified and places it 
into the object descriptor during batch processing.  

• Note that there are multiple methods of passing a MODS descriptive metadata file to Batch 
Builder. Only one method at a time can be used.  

• Object Owner Supplied Name: (Optional) - This property can be used to override the object 
Owner Supplied Name that is normally derived from object directory name. It will be applied 
to the object specified by in the object directory name property. 

Example 1 (specifying object directory name and aleph ID): 
birdsofasia,005111819, 

brighambulletin,006659177, 

The extra comma at the end represents the blank value for object owner supplied name. It is 
required even if object owner supplied name is not specified. 

Example 2 (specifying object directory name, aleph ID and object owner supplied name): 
birdsofasia,005111819,BA_2348 

brighambulletin,006659177,BA_35559 

In this example all three values are specified.  

Example 3 (specifying object directory name and object owner supplied name): 
birdsofasia,,BA_2348 

brighambulletin,,BA_35559 

The extra comma in the middle represents the blank value of the aleph ID for the object. Even if 
aleph ID is not specified the comma delimited is required. 

13. Working with URNs 
13.1 Assigning URN resource name patterns 
13.2 Using URNs 

Batch Builder by default requests public delivery service URNs for deliverable files of still image 
objects, document objects and text objects. For PDS document objects a public delivery URN is 
requested for the object itself rather than for a particular file within the object. For opaque objects 
no public delivery URNs are requested.  

URN authority path and URN resource name pattern values can be entered in the required settings 
panel for each object or in the object template required setting panel (in which case the settings will 
propagate to all objects created from the template).  
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Required settings panel – NRS section 

13.1 Assigning URN resource name patterns 
The resource name component of the URN must be unique relative to the authority path.  Batch 
Builder can generate all or part of the resource name automatically using mask fields that will be 
replaced with actual values by the system (shown in the table below).  

Resource names can be composed of alpha-numeric characters (upper and lower case, although all 
NRS comparisons are case-insensitive) and the following punctuation characters: 
     ( ) + , - = @ ; $ _ ! * ' . : 

Batch Builder will use {n} as the default resource name mask field ({n} resolves to a unique 
number).  However, Batch Builder supports additional resource name patterns that are described 
below. 

URN resource name pattern fields 
Field Replacement Value Meaning 
{dd}  01 to 31 Day of the month 
{hh24} 01 to 24 Current hour of day 
{mm}  00 to 59 Current minute of hour 
{mo} 01 to 12 Current month of year 
{ss} 00 to 59 Current second of hour 
{yyyy}  1999 to 9999 Current year 
{n} 0 to 10 to the 27th power Unique numeric value 
{fileBaseName} Name of the file excluding the file 

extension 
Base name of file. Note that this 
mask works only in BB. It does 
not work if assigning URNs to 
existing objects in Web Admin 

Here are examples of URN masks and the resulting resource name: 

urn-3:dig:{n}   -->   urn-3:dig:75  

urn-3:FAL:{yyyy}-{n}   -->    urn-3:FAL:1999-76  

urn-3:HCL-DIG:{yyyy}{mo}{dd}   -->   urn-3:HCL-DIG:20000103 (unique only for one file on 
any given day)  

urn-3:HCL-DIG:{yyyy}{mo}{dd}{n}   -->   urn-3:HCL-DIG:200001032 (always unique)  
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13.2 Using URNs 
Each URN assigned by NRS has the form: 

   urn-3:{authorityPath}:{resourceName} 
   urn-3:RAD.SCHL:1081404 

where ”urn-3” is the Harvard namespace identifier, {authorityPath} is the NRS authority path 
corresponding to the organizational unit responsible for the URN, and {resourceName} is the 
unique identifier for the digital file.   

To make a URN actionable (usable in a browser) for DRS 2 test objects, you must append it to an 
NRS URL (http://nrstest.harvard.edu:9031/).  The full working URL for the example URN above 
would be: 

http://nrstest.harvard.edu:9031/urn-3:HUL.Guest:152824  

 New URNs are passed to the NRS name resolution server for activation. A URN requested during 
DRS2 batch deposit should become active within 15 minutes of successful batch deposit.  

14. Adding Relationships 
14.1 Image relationships 
14.2 PDS Document object relationships 
14.3 Opaque object relationships 
14.4 Document (PDF) object relationships 
14.5 Text object relationships 
14.6  Audio object relationships 

DRS models relationships between files and objects. Relationships can indicate derivative 
relationships between object files, how an object is structured, or associations between content.  

Derivative relationships and structural relationships are automatically determined by Batch Builder 
based on placement of files in particular directories and on file names. Other relationships must be 
explicitly set by depositors, especially relationships between objects or files being processed in 
Batch Builder to objects or files already stored in the DRS.  

Below is a list of relationships Batch Builder can create for the six content models it currently 
supports. 

14.1 Still image object relationships 

File-to-file 
HAS SOURCE -- relationships between derivative images. The relationship is automatically 
inferred by Batch Builder if a file with the same file name is present in two directories, one of 
which is nested inside the other. 

HAS SUBSET FILE – file is the source of relationship to another file that is part of a stitched 
image. A DRS ID or a DRS URN of the related subset file needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

File-to-object 
HAS COLOR PROFILE OBJECT – file has an associated color profile object in the DRS. A 
DRS ID or a DRS URN of the color profile object needs to be entered in the directory level 
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metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note 
that the Color Profile Content Model is not supported by Batch Builder 2 yet). 

HAS TARGET OBJECT – file has an associated target object in the DRS. A DRS ID or a DRS 
URN of the target image object needs to be entered in the directory level metadata panel in Content 
Panel of Batch Builder in order for this relationship to be created. (Note that the Target Image 
Content Model is not supported by Batch Builder 2 yet). 
 
HAS WORLD REFERENCE OBJECT – file has an associated world file object in the DRS (for 
GIS objects). A DRS ID or a DRS URN of the world file object needs to be entered in the directory 
level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 
 
HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID 
or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of 
the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 
 
HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. 
A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

Object-to-object 
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the object level metadata panel in Content Panel of Batch 
Builder in order for this relationship to be created. 

HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS 
ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN 
of the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the 
DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created.  

14.2 PDS document object relationships 

File-to-file 
HAS SOURCE -- relationships between derivative images. The relationship is automatically 
inferred by Batch Builder if a file with the same file name is present in two directories, one of 
which is nested inside the other. 
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File-to-object 
HAS COLOR PROFILE OBJECT – file has an associated color profile object in the DRS. A 
DRS ID or a DRS URN of the color profile object needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note 
that the Color Profile Content Model is not supported by Batch Builder 2 yet). 

HAS TARGET OBJECT  – file has an associated target object in the DRS. A DRS ID or a DRS 
URN of the target image object needs to be entered in the directory level metadata panel in Content 
Panel of Batch Builder in order for this relationship to be created. (Note that the Target Image 
Content Model is not supported by Batch Builder 2 yet) 

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID 
or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of 
the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. 
A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

Object-to-object 
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the object level metadata panel in Content Panel of Batch 
Builder in order for this relationship to be created. 

HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS 
ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN 
of the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the 
DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

14.3 Opaque object relationships 

File-to-object 
HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID 
or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 
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HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of 
the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. 
A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

Object-to-object 
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the object level metadata panel in Content Panel of Batch 
Builder in order for this relationship to be created. 

HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS 
ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN 
of the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT– object has an associated documentation object in the 
DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

14.4 Document (PDF) object relationships 

File-to-file 
HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred 
by Batch Builder if a file with the same file name is present in two directories, one of which is 
nested inside the other. 

File-to-object 
HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID 
or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of 
the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. 
A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 
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Object-to-object 
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the object level metadata panel in Content Panel of Batch 
Builder in order for this relationship to be created. 

HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS 
ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN 
of the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the 
DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created.  

14.5 Text object relationships 

File-to-file 
HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred 
by Batch Builder if a file with the same file name is present in two directories, one of which is 
nested inside the other. 

File-to-object 
HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID 
or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of 
the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION – file has an associated documentation object in the DRS. A DRS ID 
or a DRS URN of the documentation object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

Object-to-object 
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the object level metadata panel in Content Panel of Batch 
Builder in order for this relationship to be created. 

HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS 
ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN 
of the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 
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HAS DOCUMENTATION OBJECT – object has an associated documentation object in the 
DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created.  

14.6 Audio object relationships 

File-to-file 
HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred 
by Batch Builder if a file with the same file name is present in two directories, one of which is 
nested inside the other. 

File-to-object 
HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID 
or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of 
the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. 
A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 

Object-to-object 
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of 
the license object needs to be entered in the object level metadata panel in Content Panel of Batch 
Builder in order for this relationship to be created. 

HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS 
ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata 
panel in Content Panel of Batch Builder in order for this relationship to be created. 

HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN 
of the statute object needs to be entered in the directory level metadata panel in Content Panel of 
Batch Builder in order for this relationship to be created. 

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the 
DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level 
metadata panel in Content Panel of Batch Builder in order for this relationship to be created.   
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15. Adding Descriptive Metadata 
15.1 Importing an Aleph record 
15.2 Entering data in the GUI 
15.3 Importing from a MODS file 

In DRS 2 descriptive metadata can be added to an object. It is stored in the object descriptor file. 
There are three ways to add descriptive metadata:  

1. Have Batch Builder import descriptive metadata from an existing ALEPH record. 

2. Enter descriptive metadata in the Batch Builder GUI. 

3. Import descriptive metadata from a MODS file. 

15.1 Importing an Aleph record 
Batch Builder provides three ways of importing descriptive metadata from an existing ALEPH 
record: 

1. Specify Aleph ID in a mapping file (see Section 12: Using External Mapping Files for more 
information) 

2. Specify Aleph ID on command line (see Section 11: Processing Batches Using Command Line 
Interface for more information) 

3. Enter Aleph ID in Batch Builder GUI (either in object template metadata or in object 
metadata). This option is described below. 

To enter Aleph ID in Batch Builder GUI: 

1. Obtain the Aleph ID of the record  

2. In BB select the object template or the object in the Project Panel on the left 

(Optional shortcut) Note that if you are selecting an object, you can right click on the object 
and choose “Set Aleph ID” from the right click context menu. A data entry box will pop up 
where you can enter the Aleph ID (this doesn’t work if you are selecting object template). You 
can then skip steps 3 and 4 below. 

 
3. Switch to Optional tab in the Content Panel on the right 

4. Enter the Aleph ID into the field “Aleph ID for MODS import.”  
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Note that Aleph ID is not repeatable. Save the project before processing the batch (so that the 
new information is written into the BB2 configuration file). 

Once the batch is processed the descriptive metadata for the object will end up in the MODS 
section of the object descriptor. Make sure that no other methods of entering descriptive 
metadata are used at the same time (e.g.: there is no MODS file as well or there is no 
descriptive metadata also entered in the Object Metadata fields in the BB GUI) or you will 
receive an error while processing a batch. 

15.2 Entering descriptive metadata in the BB GUI 
You can enter descriptive metadata directly in the BB GUI in the Object Metadata section in the 
Content panel.  

In BB select the object in the Project Panel on the left; switch to Optional tab in the Content Panel 
on the right, and enter the descriptive metadata into the fields in the Object Metadata section. The 
descriptive metadata is expected in MODS 3.4 format and the fields in the GUI follow MODS 3.4.  

You can look up MODS 3.3 fields definitions at: 
http://www.loc.gov/standards/mods/userguide/generalapp.html  

15.3 Importing descriptive metadata from a MODS file  

Rules for importing a MODS file 
Descriptive metadata for an object can be imported from a locally supplied MODS file. BB expects 
the MODS to be valid MODS 3.4 XML. There should be one MODS XML file per object being 
described. Descriptions of multiple objects cannot be supplied in the same MODS file. Each 
MODS file can contain only one set of descriptive metadata for an object – e.g.: a collection-level 
record and an object-lelel record cannot be part of the same MODS file for the same object. 

File Name: {obj_name}_mods.xml – where {obj_name} is OSN. 

Format: Valid MODS version 3.4 XML file 

Placement:  

For use while automatically creating a batch place the file in 
{project_dir}/_aux/template/ directory.  

Note that the file placed into {project_dir}/_aux/template/ directory will be moved to the 
corresponding _aux directory for the object (_aux/{batch_name}/{object_name}) after the 
object batch is built. The MODS file will be accessed by BB during batch processing 
(when batch.xml and object descriptor is created). 
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For use during with manually creating a batch place the file in 
{project_dir}/_aux/{batch_name}/{object_name}/ directory 

The MODS file will be accessed by BB during batch processing (when batch.xml and 
object descriptor is created). 

Examples of valid MODS 3.4 XML file 

http://www.loc.gov/standards/mods/mods-guidance.html  

Procedure for importing a MODS file 

Extracting MODS from HOLLIS or VIA using PRESTO 
If there is cataloging for an object in HOLLIS or VIA, you can use PRESTO to extract a MODS 
version of the record.  Since metadata extracted with PRESTO conforms to MODS version 3.4, the 
MODS file will be accepted as-is by the DRS2 batch loader without additional changes.   

1. Identify the ID of the record you want to extract.   

2. Construct a PRESTO request url for the record: 

For HOLLIS: http://webservices.lib.harvard.edu/rest/mods/hollis/{record_id_goes_here} 

For VIA: http://webservices.lib.harvard.edu/rest/mods/via/{record_id_goes_here} 

3. Paste the PRESTO request url into a browser.  The MODS XML file for the record will 
display.  If you don't see the XML, view source. 

4. Use the browser's "Save As" option to save the xml file to a local directory. 

5. Before using the file in Batch Builder, you must rename it to "{obj_name}_mods.xml" – where 
{obj_name} is the object's owner supplied name (OSN). 

Note about VIA:  A PRESTO request for VIA will return the record with all components (e.g., a 
work plus all surrogates).  Typically, what you need for object-level description in DRS2 is an 
individual surrogate description.  Before inserting a VIA MODS file into your batch, you may need 
to edit the file to remove surrogate descriptions that do not apply to the object you are depositing. 

Full details about using PRESTO are available in the PRESTO Data Lookup User Guide 
(http://hul.harvard.edu/ois/systems/webservices/lookup-userguide/). 

Creating MODS from scratch using a template 
It is easiest to create a MODS file from scratch by starting with a valid MODS template and 
inserting your descriptions.  For DRS2 beta testing, you can use a MODS full record example from 
the Library of Congress MODS web site:  http://www.loc.gov/standards/mods/mods-
guidance.html. 

1. Create a text file called "{obj_name}_mods.xml" – where {obj_name} is the object's owner 
supplied name (OSN). 

2. Select a sample MODS record on the LC site: http://www.loc.gov/standards/mods/v3/mods-
userguide-examples.html. 

3. Copy the entire LC MODS record and paste into your local MODS file. 

4. Add descriptions to the template as needed.  Remove elements that are not needed. 

5. Save the file. 
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Adding a MODS file to the batch 
1. If using the manual object workflow: 

a. Create the batch with objects (Step 5 in the batch procedure).  This will generate batch 
directory structure on disk.  

b. Copy the MODS file into the object directory inside the BB project's auxiliary (_aux) path:  

{project_dir}/_aux/{batch_name}/{object_name}/ 

If you have MODS files for multiple objects in a batch, do the same for each.  

c. Continue with your batch procedure. 

2. If using the automatic object workflow: 

a. Add directories to the template and copy content files into those directories (Steps 4-5 in 
the batch procedure). 

b. Place the MODS file into the template directory in the BB project's auxiliary (_aux) path: 

{project_dir}/_aux/template/ 

If you have MODS files for multiple objects in a batch, place all of them in the template 
directory. 

c. Continue with your batch procedure. 

3. When BB processes the batch, an INFO message displays in the message panel when the 
MODS file is discovered, e.g.: 

INFO – Imported XML from object-skating_mods.xml 
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16. Adding Licenses, Documentation and Other Supporting 
Content 

In DRS 2, supporting content such as licenses, documentation, finding aids, donor agreements, etc., 
can be deposited along with the regular content and linked to from the regular content. In order to 
link regular content objects to supporting content in the DRS, the supporting content needs to be 
deposited first. After supported content is deposited, the supporting object DRS ID or DRS URN 
can be used to link it to the regular content. Use the corresponding relationships fields in BB to link 
regular objects to supporting content when creating a regular content batch. 

To deposit supporting content to the DRS follow the “creating a batch” procedure in this guide for 
one of the following DRS content models: 

• Still Image 

• Document 

• Text 

After you created your supporting content batch, choose one of the following roles for your 
supporting objects before they are processed by BB (select one of these roles in the Content Panel 
on the right while the object is selected in the Project Panel on the left): 

• DOCUMENTATION 

• DONOR_AGREEMENT 

• FINDING_AID  

• HARVARD_POLICY 

• LICENSE 

• STATUTE 

Process the batch and deposit it to the DRS.  

Once your supporting content batch is deposited, get the DRS ID or the DRS URN of your 
supporting object from the batch report, and, after you created your regular content batch, select 
your object in the BB Project Panel on the left and enter the ID of URN  of the supporting object 
into one of the following relationship fields in BB in the Content Panel on the right under the 
Optional tab (before processing the batch): 

• Harvard Policy (Other Rights Documentation block in Content Panel under the Optional tab) 

• License (Other Rights Documentation block in Content Panel under the Optional tab) 

• Statute (Other Rights Documentation block in Content Panel under the Optional tab) 

• Has Documentation (last field at the bottom of the Content Panel under the Optional tab) 

Process your regular content batch and deposit it to the DRS. You objects are now linked to the 
supporting content. 

 

17. Uploading Batches to DRS 
Batches are loaded to DRS 2 in the same way as in DRS 1.  
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1. Log on to your ftp dropbox and drag and drop the whole batch directory (the one that has the 
file batch.xml and object directories in it) that BB processed into the “incoming” directory in 
the dropbox. 

2. Disconnect from the dropbox to kick-off batch processing.  

3. Once the batch is processed you will get a successful load batch report or an error report in the 
email. 

The path to the DRS 2 dropbox is: drs2drop.lib.harvard.edu.  

Username is your regular DRS 1 dropbox username with prefix “drs2_” added to the username. 
For example, if your DRS 1 production dropbox is xyzftp, then your DRS 2 dropbox is 
drs2_xyzftp, etc. The password is the same as the password you have for the DRS 1 production 
dropbox.  

18. Interpreting Load Reports 
13.1 Succesful load reports 
13.2 Failure load reports 

This section describes features of the loader reports generated in the DRS 2 environment. 

The DRS batch loader sends out an email message that reports on the success (or failure) of a 
processed batch. A batch consists of objects, a descriptor.xml file included with each object and the 
batch.xml batch control file. Recipients of the loader reports are identified within the batch.xml 
file. 

18.1 Successful load reports 
Reports of successfully processed batches will be sent to a designated email address or written to 
the dropbox (or both), based on preferences specified by the <successEmail> and 
<successMethod> elements in the batch.xml.   

• If delivered by email, the load report message: 

ο Will have a Subject line containing the following information: 

Subject: DRS LOAD REPORT (owner:{owner_code}, batch dir:{batch_directory_name}, 
batch:{batch_name} [DB:{batch_id}]) 

ο Will contain the following sections: 

Batch Summary 
File listing 
File listing text file (attachment) 

• If written to the dropbox, the load report text file: 

ο Will be located in the top-level batch directory with a file name that conforms to the 
following pattern: LOADREPORT_{batch directory name}. 

ο Will contain these sections:  

Batch Summary 
File listing 
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Remember that object descriptor files (descriptor.xml) are part of each batch in DRS2. For every 
object in the batch there will be a corresponding descriptor file and these files will be included in 
the load report summary and file listing.  

About the batch summary 
The batch summary section includes summary information about the batch.  Contents of this 
section include: 

• Batch directory name 

• Batch name 

• Depositor 

• Batch id 

• Owner(s) 

• Batch drop off time 

• Time waiting to start load 

• Loading start time 

• Loading end time 

• Total load time 

• Number of objects deposited 

• Number of files deposited 

• Batch size 

• Number of objects per object type 

• Number of files per format 

Sample summary for still image object batch: 
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Sample summary for page-turned (PDS) object batch: 

 

About the file listing 
Following the batch summary section, the report lists metadata for each file in the batch, including 
any object descriptor files (descriptor.xml).  The data in this section is tab-delimited, with these 
metadata headings at the top: 

• OBJ-ID:  DRS ID of the object associated with this file. 

• OBJ-DELIV-URN: Delivery URN of the object (only PDS Objects have delivery URNs) 

• OBJ-URN:  DRS URN (an alternative internal identifier to DRS ID) of the object associated 
with this file 

• DEPOSITOR:  First and Last name of depositor responsible for this batch. 

• OBJ-OSN:  Owner supplied name of the object associated with this file. 

• BILLING:  Billing code for this file. 

• OWNER:  Owner code for this file. 

• OBJ-TYPE:  The content model identifier and name (e.g., " STILL IMAGE") for the 
associated object. 

• OBJ-ROLES: Lists object roles for each object, if any were specified. 

• FILE-ID:  DRS ID of the file. 
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• FILE-URN:  Delivery URN of the file. 

• FILE-FORMAT:  Format of the file. 

• FILE-SIZE:  Byte-size of the file. 

• FILE-OSN:  Owner supplied name of the file. 

• FILE-ORIGPATH:  Directory path of the file in the batch. 

Tips and tricks 
Working with the file list.  Entries in the file list are arranged in the order files were ingested by 
the loader.  If you find it difficult to locate a particular file in the file list, best practice is to import 
the listing into an application that can sort tabular data, such as MS Excel (if working with the 
emailed report, import the attachment into MS Excel or another spreadsheet software).  In Excel, if 
you sort by the FILE-ID column, rows associated with a single object will sort together.  For page-
turned object batches, sorting this way should push the METS file to top of the listing. 

18.2 Failure load reports 
If any errors are detected during a load, the entire batch is rejected and an error report is sent to the 
email addresses in the <failureEmail> element of the batch.xml document.  The error message will 
include dropbox name, batch directory, and batch name along with a message describing the cause 
of the failure.  

All the digital files associated with an error batch are left in the depositor's batch directory, while 
the batch.xml file and the LOADING file are deleted.  To retry the batch, update any corrupt or 
missing digital files and upload the new batch.xml file.  After you disconnect from the SFTP 
session, your batch will be queued for reloading. 

Below are some common batch loader error scenarios and messages: 

1. Error in batch.xml header:  Errors in the header of the batch.xml file can cause processing to 
fail before the loader can read the failure email addresses.  In this case, the loader will report the 
error only to DRS staff in LTS.  If you submit a batch but receive no load report or error, send a 
message to the DRS2 team in LTS using this form: 
http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help. 

2. Couldn't find billing code for id {billing code} 

Sample: Type of problem: Couldn't find billing code for id HBS.BAKR.KRESS_001 

Cause: The specified billing code is invalid.  Correct the billing code in Batch Builder and 
regenerate the batch. 

3. Owner supplied name {OSN} already exists for owner code {owner code} 

Sample: Type of problem: Owner supplied name 'randy-pdsobject7' already exists for owner code 
HUL.TEST 

Cause: The specified owner supplied name has already been defined within the specified owner 
code.  Correct the OSN in Batch Builder and regenerate the batch. 

4. An unexpected problem occurred processing batch {batch ID} 

Sample: An unexpected problem occurred processing batch 8004. If this problem persists, please 
contact drs-support@hulmail.harvard.edu, forwarding the entire contents of this message. 
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Cause: This error usually indicates an internal DRS issue rather than an error in the batch.  In many 
cases, reloading the same batch will be successful.  But if the problem persists, send a message to 
the DRS2 team in LTS using this form: 
http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help.  

5. Object descriptor {path to descriptor.xml} not found  

Sample: Type of problem: Object descriptor 
/drs2dev/dropboxes/ois2dev/incoming/DefectiveDescriptorBatch/DontRegenerateTheDescript/desc
riptor.xml not found 

Cause: The specified object descriptor file was expected by the loader but not found.  Upload the 
missing descriptor file and the batch.xml file and disconnect from the dropbox. 

6. MD5 checksum mismatch for descriptor {path to descriptor.xml} 

Sample: Type of problem: MD5 checksum mismatch for descriptor file 
/drs2dev/dropboxes/ois2dev/incoming/BadDescriptorChecksum/DontRebuildTheDescriptor/descri
ptor.xml, services reported 22B5A77B581CCFFE908E535795CDA06A 

Cause: MD5 checksum calculated by DRS services does not match the checksum supplied in the 
batch.  

7. File not found: {path to file} 

Sample: Type of problem: File not found: 
/drs2dev/dropboxes/ois2dev/incoming/MissingDataFile/WhatISaidBefore/image/beethoven3.jpg 

Cause: The specified file could not be found in the batch.  Upload the missing file, re-upload 
batch.xml, then disconnect from the dropbox. 

8. Batch directory {directory path} contains no objects 

Sample: Type of problem: Batch directory 
/drs2dev/dropboxes/ois2dev/incoming/DefectiveBatchDotXML contains no objects 

Cause: The specified directory is missing from the batch.  Re-process in Batch Builder and upload 
the new batch to the dropbox. 

9. Descriptor file failed XML schema validation: {... } 

Sample: Type of problem: Descriptor file failed XML schema validation: cvc-complex-type.2.4.a: 
Invalid content was found starting with element 'amdSecXXXXXXXXXXXXXX'. One of 
'{"http://www.loc.gov/METS/":metsHdr, "http://www.loc.gov/METS/":dmdSec, 
"http://www.loc.gov/METS/":amdSec, "http://www.loc.gov/METS/":fileSec, 
"http://www.loc.gov/METS/":structMap}' is expected. 

Cause: The specified descriptor.xml file failed schema validation due to invalid content. Re-
process in Batch Builder and upload the new batch to the dropbox. 

10. Could not parse batch.xml 

Sample: Type of problem: Could not parse batch.xml 

Cause: This error condition indicates xml in the batch file is not well formed and is usually related 
to bad character data.  Revise the file and upload again.   
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19. Viewing Your Deposited Objects 
In Web Admin 
Use Firefox or Chrome web browsers. Internet Explorer is currently not supported. 

1. Connect to DRS 2 WebAdmin:  
https://drs2-qa.hul.harvard.edu:9400/drs2_webadmin/search.  

2. Enter the object ID from the emailed batch report into the Quick Search field and click on the 
Quick Search button. 

3. Click on the object ID in the search results. 

4. You will see an object view page with summarized information about your object.  

5. View files in your objects by clicking on files IDs within the file listing table at the bottom of 
the screen. 

For more instructions on searching and testing Web Admin please consult the DRS 2 WebAdmin 
User Guide. 

In DRS public delivery systems 
You can view your objects using the following DRS 2 QA Delivery Services: IDS, PDS, FDS and 
SDS (audio delivery). Still Image objects are delivered by IDS; PDS Document objects are 
delivered by PDS; Document objects and Text objects are delivered by FDS. Audio objects are 
delivered by SDS. The URNs created by Batch Builder 2 resolve in NRS QA.  

Use the following URLs to view your DRS2 objects: 

• To view Still Image objects in IDS: http://idstest.lib.harvard.edu:9001/ids/view/[file_id] 
E.g.: http://idstest.lib.harvard.edu:9001/ids/view/1166538  

• To view PDS Document objects in PDS: 
http://pdstest.lib.harvard.edu:9005/pds/view/[object_id] 
E.g.: http://pdstest.lib.harvard.edu:9005/pds/view/1016400  

• To view Document objects, Text objects and Opaque objects in FDS:  
http://fdstest.lib.harvard.edu:9001/fds/deliver/[file_id]  
E.g.: http://nrstest.harvard.edu:9031/urn-3:H.LIB:216776  

• To view Audio objects in SDS: 
http://sdstest.lib.harvard.edu:9007/sds/audio/[file_id]  
E.g.: http://sdstest.lib.harvard.edu:9007/sds/audio/1028926  
Click on the Flash Player button to play the audio in your browser.  

• To view objects using URNs: 
http://nrstest.harvard.edu:9031/urn-3:[nrs_authority_path]:[resource_name]  
E.g.: http://nrstest.harvard.edu:9031/urn-3:HUL.OIS:194271  
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	1. Setting Up Batch Builder
	1.1 Installing Batch Builder1.2 Setting options
	This section provides an overview of Batch Builder features and describes requirements for file names and batch directories. 
	1.1 Installing Batch Builder 

	Batch Builder (BB) is a Java-based application compatible with Windows, Mac and Linux operating systems.
	The Batch Builder application package includes a Graphical User Interface (GUI) and a separate Command Line Interface (CLI) for automated deposit workflows.  The application package is bundled as a zip file, which must be downloaded, unzipped, and installed on your computer.  The Batch Builder 2 Beta zip archive can be downloaded from: http://hul.harvard.edu/ois/systems/drs/BatchBuilder-2-current.zip  
	Recommended System Requirements
	 Operating System: Windows XP/Vista/7, Mac OS X 10.5.8 or higher, Linux.
	 Processing Power: Intel Core 2/i3/i5/i7; AMD Athlon II/Phenom II 
	 Physical Memory: 3 GB RAM or higher (requires 64-bit Operating system). 
	 Java version 1.6.0 or higher. Download the latest version of Java here: http://www.java.com/en/ 
	Installation
	1. Download the zip file from here:http://hul.harvard.edu/ois/systems/drs/BatchBuilder-2-current.zip  
	2. When prompted, save  the BB zip archive to your computer (e.g. a download directory or your desktop)
	3. Unzip the archive and extract the files to a directory of your choice (e.g. Program Files or Applications).  The installer will create a “batchbuilder-2.x” directory and copy the files to it.
	4. To start the GUI, double click the launch (executable) file (look for the BB icon / in the batchbuilder-2.x directory). 
	If you can’t start BB using the executable, try the following alternative:
	o On Windows: double click on the file batchbuildergui.bat. A command prompt window will open and then BB Graphical User Interface will start up.
	o On Mac or Linux:open terminal, change directory to the BB home directory and type:sh batchbuildergui.sh and then press Enter. BB Graphical User Interface will start up.
	5. To start the Command Line Interface (CLI): 
	o On Windows: run the command prompt (CMD), change directory to the BB home directory, type batchbuildercli with required parameters and press Enter.
	o On Mac or Linux: run the Terminal, change directory to the BB home directory and type: sh batchbuildercli.sh with required parameters and press Enter.
	1.2 Setting options
	1.2.1 General Batch Builder application options


	There are a few Batch Builder features that are controlled by using View > Options on the file menu.  These options will affect all projects.
	/Batch Builder Default Options
	 Auto-increment new batch directory names.  (Unselected by default.)  When selected, if you create a batch directory name that ends with a number, the next time you click Batch->New … Batch Builder will use the same directory name but will increment the number to the next value. 
	 Ignore file validation errors.  (Selected by default.)  When selected, this option forces Batch Builder to create a batch even when the FITS tool has detected errors in one or more files in the batch. 
	Note: this option must be selected when generating PDF Document objects as well as Opaque objects. 
	 Open last project on application startup. (Unselected by default.)  When selected, on Batch Builder startup the most recently used project will open automatically.
	 Verbose logging.  (Selected by default.)  This option is exposed specifically for testing purposes. Leave it checked during this testing phase so that LTS staff can troubleshoot Batch Builder processing errors.
	 Delete object and directory contents when removing. (Unselected by default). If this option is checked, the object and directory contents are removed from disk when removed from within BB. This applies to Template directories as well . When this option is not selected, directories will remain on your local computer, but will disappear from the BB2 project window.
	 Copy files when dragging and dropping onto project tree. (Selected by default). BB 2 introduces drag-and-drop functionality for files. If this option is checked, when files are dragged and dropped from a directory on disk onto a file directory in the BB Project Panel the files are copied rather than moved. 
	1.2.2 File name pattern options for generating file OSNs

	Batch Builder allows users to set file name pattern options to be used when either automatically building objects from template or creating objects manually. Note that this option should not be used in conjunction with using external mapping files to supply file OSNs (an alternate method of supplying file OSNs).  The following file name pattern can be set (these persist for each Batch Builder project).
	/
	Derive File OSN from File Name (set by default) – this option, when set, results in Batch Builder using file name for the file owner supplied name according to one of the options checked below:
	 Use full file name (minus the extension) as file OSN – results in full file name being used as OSN. 
	o For all objects except PDS Document objects this accomplishes the following
	 When building objects automatically – this option captures the full file name, including the object name prefix, as file OSN. (e.g.: obj1—file1.jpg will result in file OSN “obj1—file1”.) 
	 When building objects manually - this option captures the full supplied file name as file OSN. (e.g: file1.jpg will result in file OSN “file1”.) 
	o For PDS Document objects  using  the file name used as OSN option accomplishes the following :
	 When building objects automatically – this option captures the full file name, including the object name prefix and the page sequence number, as file OSN. (e.g.: obj1—file1__seq1.jpg will result in file OSN obj1—file1__seq1. )
	 When building objects manually this option, when set, captures the full file name, including the page sequence number, as file OSN. (e.g: file1__seq1.jpg will result in file OSN file1__seq1.)
	 Use baseName as file OSN – this option results in Batch Builder using file base name, excluding the object name prefix, as the file OSN . Don’t use this option for PDS Object if the file basename is the same for all the files (only the seq number is different)
	o For all objects except PDS Document objects this accomplishes the following
	 When building objects automatically – this option captures the file base name, discarding the object name prefix, as file OSN. (e.g.: obj1—file1.jpg will result in file OSN “file1”. )
	 When building objects manually this option captures the file base name as file OSN. (e.g: file1.jpg will results in file OSN “file1”.) 
	o For PDS Document objects 
	 Use baseName—pageSeq as file OSN – this option results in Batch Builder using file base name and page sequence suffix – if present, but excluding the object name prefix, as the file OSN
	o For all objects except PDS Document objects this accomplishes the following
	 When building objects automatically – this option captures the file base name, discarding the object name prefix, as file OSN. (e.g.: obj1—file1.jpg will result in file OSN “file1”. )
	 When building objects manually this option captures the file base name as file OSN. (e.g: file1.jpg will results in file OSN “file1”.) 
	o For PDS Document objects
	 When building objects automatically – this option captures the file base name and page sequence number as file OSN, discarding the object name prefix. (e.g.: obj1—file1__seq1.jpg will result in file OSN “file1__seq1”.) 
	 When building objects manually this option captures the file base name and the page sequence number as file OSN. (e.g: file1__seq1.jpg will result in file OSN “file1__seq1”.)
	 Use only pageSeq as file OSN – this option only applies to PDS Document Objects
	o When building objects automatically – this option  captures the page sequence number as file OSN, discarding the object name prefix and the file name. (e..g.: obj1—file1__seq1.jpg will result in file OSN “seq1”.) 
	o When building objects manually this option captures the page sequence number as file OSN. (e.g: file1__seq1.jpg will result in file OSN “seq1”.)
	1.2.3 Setting options for processing large batches

	When processing large batches – either from large file sizes or the sheer number if files – you may get “out of memory errors”.  The threshold is around 30GB.  If you do get memory errors, you will need to make adjustments to BB configuration files to assign more memory to Java.
	Note for Windows users:  If you find that you need more than 3GB of RAM to run Batchbuilder, you will also need to use a 64-bit version of Windows. 
	Assigning more memory to Java
	1. In the main BB program directory use a text editor to open  batchbuildergui.bat (Windows) or batchbuildergui.sh (Mac)
	2. Find line starting with ‘java –cp’
	3. In that line, find the section ‘-Xmx1024m’ and do one of the following:
	 To assign 2GB of RAM, change it to ‘-Xmx2048m’
	 To assign 3GB of RAM, change it to ‘-Xmx3072m’
	 To assign 4GB of RAM, change it to ‘-Xmx4096m’
	4. Save the file
	Use the smallest amount of RAM to get rid of the error to avoid performance problems with your local computer.
	When you need to process a large batch, start BatchBuilder using the batchbuildergui.bat or batchbuildergui.sh instead of the executable file.
	2. User Interface Basics
	2.1 BB panels2.2 BB menus
	The Batch Builder interface includes a menu bar, a tool bar, and three display panels. Context menus are also available by right-clicking on certain places within the GUI.
	2.1 BB panels

	In the following screen-shot of the interface, these components are labeled.
	The following image shows more details about the project panel. 
	2.2 BB menus

	There are two sets of menus in BB: 
	 Menus accessible from the menu toolbar at the top 
	 Context menus accessible by right-clicking a particular item in the Project Panel on the left. 
	Menu toolbar

	There are five menus that are accessible from the menu toolbar
	Project menu
	/
	 New – create new project.
	 Open – open existing project.
	 Close – close currently open project.
	 Save – save currently open project.
	 Save as … -- save currently open project as a new project. This option saves the project configuration file project.conf (which contains all the project metadata settings entered in the Deposit Settings and Object Template) into a new directory. This is a useful option to use if you are planning to create a new project but the Deposit Settings information or/and Object Template information is going to be the same.
	 Exit – exit the program.
	Batch menu
	/
	 New – create a new object batch.
	 Create descriptors & batch.xml – process a selected batch (note that a batch icon for a given batch needs to be selected in the Project Panel for this command to become active).
	 Stop creation of batch.xml – stops the creation of batch that is being currently processed (this command is only active while a batch is being processed).
	Object menu
	/
	 New – create new object (this command is only active if you first select a batch icon of a given batch in which object needs to be created in the BB2 Project Panel).
	 Create a new batch with objects from template – create a new batch of objects automatically from template. See the “Automatically build [object type] from template” section for a given object type in this Guide for procedure (E.g.: 5.2 Automatically build still image objects from template).
	View menu
	/
	 Options – view the options dialog. See section 1.2 Setting options for more information. 
	 Clear messages – clears messages from the messages panel.
	 Reload tree – reloads the Project Panel tree (useful when you want to see the latest changes made in the project panel).
	 Toolbar – show / hide toolbar with action icons /.
	Help menu
	/
	 About  -- information about Batch Builder version and built date.
	 Contents – link to Batch Builder 2 User Guide.
	Context menus

	There are six types of context menus that are available in BB2 – all from the Project Panel. These are:
	1. Project context menu
	2. Object template context menu
	3. Object template directory context menu
	4. Batch context menu
	5. Object context menu
	6. Object directory context menu
	These context menus are described below in more detail.
	Project context menu
	Right-clicking on the project icon (P) will open a context menu that allows you to create a new batch.
	/
	Object template context menu  
	Right-clicking on the object template icon (T) will open a menu where you can add a new directory or automatically create a batch of objects from template.
	/
	Object template directory context menu  
	Right-clicking on the directory icon will open a context menu where you can add a new directory nested inside the present one or remove a directory.
	/
	Batch context menu  
	Clicking on the batch icon (B) opens a context menu where you can create a new object, process the batch and remove the batch.
	/
	Object context menu  
	Right-clicking on the object icon (O) will open a context menu where you can add new directory, rename an object and remove and object.
	/
	Note that the right way to rename an object after it was created in BB is to use this menu option. Renaming the object directory on disk outside BB is not sufficient and will lead to errors when trying to open the project in BB afterward.
	Object directory context menu
	Right-clicking on the directory icon will open a context menu where you can add a directory (nested inside the current directory) or remove the current directory
	/
	3. Naming Rules for Objects, Files and Directories
	File names on diskObject and batch directory names on diskFile owner supplied namesObject owner supplied names
	File names on disk

	For all files in an object:
	 Maximum number of characters per file name is 100.  LTS recommends that file names be kept to 64 characters or less, and that the complete_directory_path + file_name for each file be kept to 255 characters or less.
	 Valid characters in file names are letters, digits, '.', underscores ('_'), and hyphens ('-').
	 File names should not contain spaces.
	Files that share a derivative relationship (e.g., a production master .tif file and its related deliverable .jpg or .jp2 file) should share the same file name in order for Batch Builder to determine that the relationship exists (e.g. clocktower.tif and clocktower.jpg).
	The file name of a digital file will be changed once the file is in DRS storage.  At the point of deposit, DRS assigns each file a numeric DRS identifier.  The file name will be the DRS ID followed by the format extension (e.g., 5844020.tif, 5844022.jpg).  
	The original file name is preserved in DRS metadata. The DRS load report that is sent after a successful DRS deposit will associate the file’s DRS ID with the original file name (FILE-ORIGPATH).  Also, if you use Batch Builder’s default method for assigning owner supplied name, the original file name (minus format extension) will be preserved in DRS metadata as the owner supplied name. In the case of PDS documents, the original filename will be the part of the owner supplied name before the double underscore (e.g. ‘doc1’ in the owner supplied name ‘doc1__seq1’)
	Object and batch directory names on disk

	 Maximum directory name length is 100 characters. 
	 No spaces are allowed in batch or object directory names
	 Valid directory name characters are letters, numbers, underscores ('_') and hyphens ('-').
	File owner supplied names

	File owner supplied name (file OSN) serves as an identifier that can be used to link files deposited into the DRS with local information about the files (such as local accession numbers or classification numbers).  
	An owner supplied name is generally optional for files and need not be unique, except in the case of:
	 images linked to OLIVIA
	 audio files, if a playlist is in use
	Failure to supply a unique OSN in these cases will prevent access to these files.
	There are three ways of supplying a file OSN:
	1. Use file name for file OSN. When using this option, set the file name pattern preferences for generating file OSNs in Batch Builder Options menu. See Section 1.2.2 for more information.
	2. Supply file OSNs using an external mapping file. To find out more about using mapping files see section 12 Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs of this document.
	3. Supply file OSNs on Command Line Interface (CLI) during batch processing. For more details about CLI see “Processing Batches Using Command Line Interface” in this Guide.
	Recommendations for file owner supplied names:
	 Owner supplied names should not exceed 100 characters.  
	 Only alpha-numeric characters and these symbols should be used:'.', underscores ('_'), and hyphens ('-').
	Object owner supplied names

	Object owner supplied name (object OSN) serves as an identifier that can be used to link objects deposited into the DRS with local information about them (such as local accession numbers or classification numbers).  Each object requires an owner supplied name.  
	Tip: Within a DRS owner code, the object  Owner Supplied Name must be unique. 
	There are four ways of supplying object OSNs:
	1. Enter Object OSN manually when creating a new object in Batch Builder (Note that you have to create a batch first, before you can create a new object). For the procedure see a subsection “Manually create [content model] objects from template” in a section on how to create object batches of a given content model in this Guide (e.g.: 5.1 “Manually create still image objects from template” in section 5 “Creating and processing still image object batches.”).
	2. Have BB create object OSNs for you when it is building object batches automatically from template.  In this case you need to add object name prefix to file names (the syntax is:  1) for all objects except PDS Document Objects:[object_osn]--[filename].[extension]; 2) for PDS Document Objects: [object_osn]--[filename]_ _[pageSeq].[extension])  or supply mapping.txt file in order for BB to associate files with objects. For the procedure see a subsection “Automatically build [content model] objects from template” in a section on how to create object batches of a given content model in this Guide (e.g.: 5.2 “Automatically build still  image objects from template” in section 5 “Creating and processing still image object batches.”).  See also Section 1.2.2 for additional information on setting file name patterns in the BB Options dialog.
	3. Supply object OSN using Command Line Interface (CLI) during batch processing (Note that to use this option you need to have an existing object with an object OSN. The new object OSN supplied in CLI overwrites the object OSN that was given to the object at the time it was originally created.).  For more details about CLI see section  11 “Processing Batches Using Command Line Interface” in this Guide.
	4. Supply object OSN using external mapping file during batch processing (Note that to use this option you need to have an existing object with an object OSN. The new object OSN supplied in the external mapping files overwrites the object OSN that was given to the object at the time it was originally created.). To find out more about using mapping files see section 12 Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs of this document.
	Recommendations for owner supplied names:
	 The number of characters per owner supplied name should not exceed a 100.  
	 Only alpha-numeric characters and these symbols should be used:'.', underscores ('_'), and hyphens ('-').
	4. Object and Batch Directories Structure and Contents
	Object directory structure and contents

	An object directory structure is generated by Batch Builder when a new object is created. The object directory structure is dependent on the content model. For instance, a Still Image object directory structure may look like this:
	Nested directories indicate a derivative relationship where a file in the top directory serves as a source of the files in the subdirectories. Each object type has a set of required directory name prefixes (such as “image” for Still Image object type). Custom names can be appended to the required prefixes. Batch Builder automatically enforces object directory structure and required directory prefixes based on the content model selected.
	After a batch is processed Batch Builder will place a descriptor.xml file at the top level of each object directory. No other files should be stored there. 
	Batch directory structure and contents

	All objects within a batch must be located in a batch directory.  The top level of this directory should contain only the batch control file (batch.xml) and object directories.  No other file should be stored in the top-level batch directory. 
	5. Creating and Processing Still Image Object Batches
	5.1 Manually create still image objects from template5.2 Automatically create still image objects from template
	There are three methods you can use to create Still Image objects in Batch Builder:
	1. Manually create objects from template. This is best for small batches (10 objects or less). In this scenario you generate an object structure in BB for each object and then copy files into it (can be done outside BB). See section 5.1 for the procedure.
	2. Automatically build objects from template. This method is best for large batches of objects (over 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 5.2 for the procedure.
	3. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. This method is useful when object properties such as Owner Code, Billing Code and URN authority path are different for each object. Because this option will be rarely used, it is not currently documented. 
	5.1 Manually create still image objects from template

	This is a description of the procedure to manually create a batch of Still Image objects from template in Batch Builder 2 (BB).  This method is a good choice when creating a batch with a small number of objects.  To create a batch with many objects (over 10), the automatic object creation procedure may be more efficient.  
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directories to object template.
	5. Create a new batch and objects.
	6. Move/copy files into corresponding directories on disk.
	7. Process the batch.
	8. Upload batch to dropbox
	9. Check load report in email
	What you need before you start: 

	 Prepare several digital images and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: image-1.tif, image-1.jp2 and image-1.jpg). Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
	 Decide what you will use for owner supplied names for image objects and the digital image files they consist of. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).
	Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
	TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. museum_slide_project)
	Content Model: select the "still image" value from the dropdown.
	Project Description (optional): Any information relevant to the project – will only remain locally.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Batch Name Pattern:  default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
	(This is the name for a batch that appears on DRS deposit reports.)
	[Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).Object Access:  the DRS access flag.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  use default value {n} to generate a unique number.
	c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  
	4. Add directories to template:
	For one image file per object:
	Add directory:
	a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.
	b. Type in a name for your directory in the text box . The directory name will start with “image” but the name you type will be appended to it.  Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a directory called ‘image_tifs_and_jpegs’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “HIGHUSE” for Usage Class.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to “Still Image File Metadata”
	d. Enter any file level optional metadata in the form
	Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	For multiple image files per object (e.g.: a file for archival master and a separate file for deliverable) you need to create a directory for the master file and a nested sub-directory for each derivative file.  (This is needed for BB to determine the derivative relationship).
	 Add a master directory: 
	a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.
	b. Type "-archival_master" or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it.  So, typing ‘-archival_master’ will result in a directory called ‘image-archival_master’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “LOWUSE” for Usage Class.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	Role: select ARCHIVAL_MASTER.
	Add a nested directory for derivative (e.g. a directory for deliverable images):
	a. Right click on the directory you just created in the Project Panel on the left and select the ‘add a directory…” menu option.
	b. Type "-deliverable" or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it.  So, typing ‘-deliverable’ will result in a directory called ‘image-deliverable’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “no” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “HIGHUSE” for Usage Class.
	Add additional metadata for this derivative subdirectory (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB
	e. Repeat steps 3 and 4 to create additional nested directories if you have more files derived from the current one. 
	f. Save your work (Project > Save on main menu).
	5. Create new batch with objects:Metadata added at this level can be applied to a specific object, or specific file directory. 
	a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch (will be used as the batch directory name on disk).  Click OK.
	Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.  
	b. Select the batch (with the red letter B) in the Project Panel
	c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and click OK. 
	d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object (blue letter O)  
	e. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note: any metadata entered at the object level will override metadata entered at the template level.
	f. Repeat b-e if you have more than object.
	g. Save your project (Project > Save on main menu).
	6. Copy image files into batch object directories on disk (can be done outside Batch Builder).
	Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.
	7. Process the batch:
	a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	Processing messages will appear in the messages pane. 
	b. When the batch is successfully processed you will see the following message: FINISHED Creation of batch.xml and descriptors complete for batch:
	8. Upload batch to dropbox.
	a. Open your SFTP client and log into your DRS2 training dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	9. Check load report in email.
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.   If you see any error messages, remedy the errors and re-process the batch. 
	5.2 Automatically build still image objects from template

	This is a description of the procedure to automatically build a batch of still image objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (more than 10) that need to be created and your source files are not broken into directories by object.
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit information.
	3. Create the object template.
	4. Add directories to the object template.
	5. Repeat steps in (4) for additional nested directories if needed.
	6. Save your work
	7. Move/copy images into the object template.
	8. Create a new object batch.
	9. Process the batch.
	What you need before you start:

	 Prepare digital images and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: image-1.tif, image-1.jp2 and image-1.jpg). 
	 Decide what you will use for owner supplied names for image objects and the digital image files they consist of. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
	 Make sure you either provide object name prefixes for each file to specify which objects it should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see section 1.2.2. For more details about external mapping files see section 12.1.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).
	Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
	TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. museum_slide_project)
	Content Model: select the "still image" value from the dropdown.
	Project Description (optional): Any information relevant to the project – will only remain locally.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Batch Name Pattern:  default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
	(This is the name for a batch that appear on DRS deposit reports.)
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	c. DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).Object Access:  the DRS access flag.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  use default value {n} to generate a unique number.
	d. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  
	4. Add directories to template:
	In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.
	For one image file per object:
	Add directory:
	a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.
	b. Type in a name for your directory in the text box . The directory name will start with “image” but the name you type will be appended to it.  Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a directory called ‘image_tifs_and_jpegs’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “HIGHUSE” for Usage Class.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	For multiple image files per object (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file. 
	Add a master directory: 
	a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.
	b. Type "-archival_master" or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it.  So, typing ‘-archival_master’ will result in a directory called ‘image-archival_master’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “LOWUSE” for Usage Class.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	Role: select ARCHIVAL_MASTER.
	e. Add a nested directory for derivative (e.g. a directory for deliverable images):
	f. Right click on the directory you just created in the Project Panel on the left and select the ‘add a directory…” menu option.
	g. Type "-deliverable" or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it.  So, typing ‘-deliverable’ will result in a directory called ‘image-deliverable’
	h. In the Project Panel on the left select the directory you just created.
	i. In the Content Panel on the right, choose “no” from the dropdown list for the field “First Generation in DRS”.
	j. Choose “HIGHUSE” for Usage Class.
	Add additional metadata for this derivative subdirectory (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB
	e. Repeat steps 3 and 4 to create additional nested directories if you have more files derived from the current one. 
	5. Save your work (Project > Save on main menu).
	6. Copy image files into Batch Builder template directory on disk (can be done outside Batch Builder).
	The directories you created in BB have been created on disk, in the project’s template path:
	{project_name}\template\
	In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using mapping.txt file for how to create a mapping file.
	In the automatic workflow, files with the same role (archival master, deliverable) are copied into the corresponding role-based directory.  In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.
	Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object template directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.
	7. Create a new object batch.
	You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI). 
	In the Graphical User Interface
	a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
	b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
	c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	d. Save the project to have BB2 write the new metadata values to the internal configuration files.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33
	Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name].
	Example:batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1
	Note that the batch directory name is the name of your new batch directory, to be created by BB.
	b. If the batch creation is successful you will see the following messages:
	8. Process the batch.
	You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).
	In the In the Graphical User Interface
	a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch ….
	If you see any error messages, remedy the errors and re-process the batch.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33
	d. Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a build -p “E:\My Project” -b batch1
	b. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see section 11. Processing Batches Using Command Line Interface.
	c. When the batch is successfully processed you will see the following messages:
	If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).
	5.3 Processing images for OLIVIA

	Procedure summary:
	1. Create a new project.
	2. Enter deposit settings.
	3. Create object template.
	4. Add directories to object template.
	5. Follow manual or automatic object creation process as described in sections 5.1 or 5.2 to create objects and process the batch.
	Steps:
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data:
	Project Name:  enter a name for your project (used for internal tracking only).Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).Content Model: select the "still image" value from the dropdown.
	Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:
	Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).Object Access:  the DRS access flag.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  use default value {n} will generate a unique number.
	c. Enter optional admin and descriptive metadata to the object template. Click the “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects).
	For more about optional metadata see: Adding Relationships, Adding Descriptive Metadata, or Adding Licenses, Documentation and Other Supporting Content.
	4. Add directories to object template.
	a. For one image file per object (e.g. one JP2 as both master and deliverable):
	Add directory: right click on “Object Template” in Project Panel tree.  The new directory name will start with “image” but you can append a custom suffix.
	Add metadata: click to select the new directory, then add metadata to the form:
	In the ‘Required’ tab:
	  First Generation in DRS: select "yes".  Usage Class: select "HIGHUSE".
	In the ‘Optional’ tab (this is required for OLIVIA / VIA workflow): scroll down to "Still Image File Metadata":
	Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note that in order to get a delivery URN on deposit and for a file to get linked in OLIVIA a file needs to have a role DELIVERABLE set in BB.
	Quality: Select ‘5’ from the dropdown list (required for OLIVIA / VIA workflow)
	b. For multiple image files per object (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.
	Add a master directory: right click on “Object Template” in Project Panel tree to create an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that describes the role.
	Add metadata for the master directory: click to select the new directory, then add required metadata to the form:
	In the ‘Required’ tab:First Generation in DRS: select "yes".Usage Class: select "LOWUSE".In the ‘Optional’ tab: scroll down to "Still Image File Metadata":Role: select ARCHIVAL_MASTER.
	Quality: select a value higher than ‘5’ from dropdown list (any value higher than ‘5’ is allowed - ‘10’ is the highest quality)
	Add a nested directory for derivative (JP2s or JPEGs): right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images).  Add a suffix for this derivative (e.g., "-deliverable").
	Add metadata for this derivative subdirectory: click to select the new subdirectory, then add metadata to the form:
	In the ‘Required’ tab:First Generation in DRS: select "no":.Usage Class: select "HIGHUSE".
	In the ‘Optional’ tab (required for OLIVIA / VIA workflow): scroll down to "Still Image File Metadata":
	Role: select ‘DELIVERABLE.  Note that in order to get a delivery URN on deposit and for a file to get linked in OLIVIA a file needs to have a role DELIVERABLE set in BB.
	Quality: Select ‘5’ from the dropdown list (required for OLIVIA / VIA workflow)
	Add a second nested directory if thumbnails are needed. If your deliverables are JPEGs, create an additional nested directory for a thumbnail image. Right click on the deliverable directory you just created for large delivery images and create another directory nested inside it.  Add a suffix for this derivative (e.g., "-thumb").
	c. Click to select the new subdirectory, then add metadata to the form:
	In the ‘Required’ tab:First Generation in DRS: select "no":.Usage Class: select "HIGHUSE".
	In the ‘Optional’ tab (required for OLIVIA / VIA workflow): scroll down to "Still Image File Metadata":
	Role: select ‘DELIVERABLE.  Note that in order to get a delivery URN on deposit and for a file to get linked in OLIVIA a file needs to have a role DELIVERABLE set in BB.
	Quality: Select ‘1’ from the dropdown list (required for OLIVIA / VIA workflow)
	d. Repeat steps a and b to create additional nested directories if you have more files derived from the current one.
	e. Save your work (Project > Save on main menu).
	5. Follow instructions in section 5.1 for manually creating a batch of objects or in section 5.2 for automatically creating a batch of objects from template and then process the batch.
	6. Creating and Processing PDS Document Object Batches
	6.1 Accepted formats6.2 File name rules6.3 Procedures to create a batch
	PDS Document objects are page-turned objects that can be delivered by the DRS Page Delivery Service (PDS). Each object can be composed of multiple files, each representing either a page image, a page text or (optionally) the page text together with the layout  (ALTO files). 
	All PDS Document objects automatically get assigned public delivery service URNs, which resolve to the Page Delivery Service (PDS) URLs. Individual files within a PDS Document object do not automatically get assigned public delivery service URNs.
	6.1 Accepted formats

	PDS Document objects can contain files in the following formats:
	Page Image
	 JPEG 2000 JP2 image files (file extension: jp2)
	 JPEG File Interchange Format image files (file extension: jpg)
	 Graphic Interchange Format (GIF) image files (file extension: gif)
	 Tagged Image File Format (TIFF) image files (file extension: tif or tiff)
	Page Text
	 Plain UTF-8 encoded text (file extension: txt)
	Page Layout
	 Extensible Markup Language (XML) Files (file extension: xml)
	The file extensions noted above are mandatory. 
	6.2 File name rules

	This topic describes specific file name requirements for page-turned object batches.  See Naming Rules for Objects, Files and Directories for general Batch Builder requirements.
	Page image, page text and page layout file naming
	The file-naming scheme for page image, text and page layout files in page-turned object is:
	     {fileBaseName}{separator}{sequenceNumber}.{extension}
	where:
	{fileBaseName} is usually a locally-meaningful name, for example a name that associates the digital file with an analog counterpart.  This may be an accession number, Aleph ID or other curatorially-significant name. Valid characters to use for the {fileBaseName} are letters, digits, '.', underscores ('_'), and hyphens ('-' ). 
	{separator}  is a double underscore (‘__’) used to separate the {fileBaseName} from the page sequence number.  
	{sequenceNumber} is the numeric value that represents the sequence number of the page within the page-turned document.  A sequenceNumber can be composed of any of the following characters: 0123456789.  
	The sequence number can include leading zeros, for example the third page can be written as: 3 or 03 or 000000003.  The page sequence number indicates a page's relative position within a sequence of pages, regardless of the numbering that may appear on the page.  
	.{extension} is one of the valid file extensions at the beginning of this topic.
	By default Batch Builder assumes that fileBaseName plus the separator and the page sequence number is the file OwnerSuppliedName. E.g.: in a file 12345__01.tif Batch Builder will assume that 12345__01 is the file OwnerSuppliedName. This default can be changed in View-Options menu. See section 1.2 Setting Options.
	Alternatively, instead of using the file naming scheme the file OwnerSuppliedName, the page sequence number and the object OwnerSuppliedName can be supplied in a special mapping file called “mapping.txt”. More about mapping files… 
	6.3 Procedures to create a batch

	6.3.1 Manually create PDS Document objects from template6.3.2 Automatically build PDS objects from template6.3.3 Use externally generated METS file to build structure-rich PDS objects
	6.3.1 Manually create PDS Document objects from template

	This is a description of the process to manually create a PDS Document object batch using Batch Builder 2 (BB). This method is best to use when you have only one or two PDS objects in your batch.
	Procedure summary:

	1. Create a new project
	2. Enter DRS deposit settings
	3. Create object template
	4. Add directories to template
	5. Create a new object batch
	6. Move/copy files into corresponding batch directories on disk
	7. Process the batch
	8. Upload batch to dropbox
	9. Check load report in email
	What you need before you start:

	 Prepare a batch of page images and (optionally) accompanying machine readable text and XML layout (Alto) files that constitute a future PDS Document object and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files and XML layout (Alto) files should match the file names of the page images files (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt, file1.xml).
	 Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2:[fileBaseName]__[sequence_number].[extension]. E.g.: file1__1.jpg, file2__2.jpg, etc. Check Section 1.2.2 of this Guide for more information about setting file name patterns in BB. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See section 12. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.
	 Decide what you will use for Owner Supplied Names for your object and the digital image files it consists of. For instance, you could use local classification or local accession numbers or an ALEPH ID.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).Content Model: select the value "PDS document" from the dropdown.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:
	Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).File Access Flags:  the DRS access flag for the files.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path. Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  default value {n} will generate a unique number. See Metadata Reference for more values for this field.
	c. Enter optional admin and descriptive metadata to the object template. Click the “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). 
	For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, and 16. Adding Licenses, Documentation and Other Supporting Content.
	4. Add directories to template:
	Image directories
	For one image file per page image:
	a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory name will start with “image” but you can append a custom suffix.
	b. Add metadata: click to select the new directory, then add metadata to the form:
	In “required” tab:
	   First Generation in DRS: select "yes".   Usage Class: select "HIGHUSE".
	In “optional” tab: scroll down to "Still Image File Metadata":
	   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	For multiple image files per page image (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file. 
	a. Add a master directory: right click on “Object Template” in Project Panel tree to create an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that describes the role. 
	b. Add metadata for the master directory: click to select the new directory, then add required metadata to the form:
	In “required” tab:   First Generation in DRS: select "yes".   Usage Class: select "LOWUSE".
	In “optional” tab: scroll down to "Still Image File Metadata":
	   Role: select ARCHIVAL_MASTER.
	c. Add a nested directory for derivative: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images).  Add a suffix for this derivative (e.g., "-deliverable"). 
	d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then add metadata to the form:
	In “required” tab:   First Generation in DRS: select "no":.   Usage Class: select "HIGHUSE".
	In “optional” tab: scroll down to "Still Image File Metadata":
	   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	e. Repeat the previous steps to create additional nested directories if you have more files derived from the current one. 
	f. Save your work (Project > Save on main menu).
	Text directories
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	Layout directories (for Alto coordinates files)
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “LOWUSE” for Usage Class.
	5. Create new batch with objects:
	Note: Metadata added at this level can be applied to a specific object or file directory. 
	a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch (will be used as the batch directory name on disk).  Click OK.
	Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.  
	b. Click to select new batch in Project Panel tree.  (Look for red letter B).
	c. Create new object from template: select Object > New from the main menu.  Enter the name of the object (by default, will be used as object OSN).  Make sure this object name is unique!  Click OK.  (Look for blue letter O).
	d. Enter optional metadata for each object and file.  Click the object directory in the Project Panel tree and select the “optional” tab on the right to enter optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). 
	For more about optional metadata see sections Adding Relationships, Adding Descriptive Metadata, Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	e. Repeat the previous steps to create additional objects (if you have more than one object in the batch).
	f. Save your project (Project > Save on main menu).
	6. Copy files into batch object directories on disk (done outside Batch Builder).
	Page image files go into an object's "image" directory.  Text files go in a "text" directory.  Layout files go in a "layout" directory. 
	Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.
	7. Process the batch:
	a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Processing messages will appear in the messages pane. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:
	8. Upload batch to dropbox.
	a. Open your SFTP client and log into your DRS2 dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	9. Check load report in email.
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.   
	6.3.2 Automatically build PDS objects from template

	This is a description of the procedure to automatically build a batch of PDS Document objects from template using Batch Builder 2 (BB). Use this method if you have more than two PDS Document objects in your batch.
	Procedure summary:

	1. Create a new project. 
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directories to template.
	5. Move/copy files into template directory.
	6. Create an new object batch
	7. Process the batch.
	What you need before you start:

	 Prepare a batch of page images and (optionally) accompanying machine readable text files and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files should match the file names of the page images files as well (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt).
	 Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2:[fileBaseName]__[sequence_number].[extension]. E.g.: file1__1.jpg, file2__2.jpg, etc. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See section 12. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.
	 Decide what you will use for Owner Supplied Names (OSNs) for your object and the digital image files it consists of. For instance, you could use local classification or local accession numbers or an ALEPH ID.
	 Make sure that the object OSNs are supplied for each file by one of the following methods:
	o Append the object prefix to each file name (the syntax is [objprefix]--[fileBaseName]__[pageSeq].[ext]). Set the desired file name pattern objects in the BB Options dialog (see section 1.2.2 for more information).
	o Supply an external mapping file that maps each file to object (see section 12.1 for more information).
	Procedure: 

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).Content Model: select the "PDS document" value from the dropdown.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:
	Note: Metadata added at this level will be applied to every object in a batch, unless overridden by specific object-level metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).File Access Flags:  the DRS access flag for the files.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  default value {n} will generate a unique number.
	c.  Enter optional admin and descriptive metadata to the object template. Click the “optional” tab.  
	IDS URN for Deliverable JPG and JP2: Select "Yes" if you need IDS URNs for all deliverable images in the batch.
	4. Add directories to template:
	In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.
	Image directories
	For one image file per page image:
	a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory name will start with “image” but you can append a custom suffix.
	b. Add metadata: click to select the new directory, then add metadata to the form:
	Required:
	   First Generation in DRS: select "yes".   Usage Class: select "HIGHUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.   Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	For multiple image files per page image (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file. 
	a. Add a master directory: right click on “Object Template” in Project Panel tree to create an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that describes the role. 
	b. Add metadata for the master directory: click to select the new directory, then add required metadata to the form:
	Required:   First Generation in DRS: select "yes".   Usage Class: select "LOWUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role: select ARCHIVAL_MASTER.
	c. Add a nested directory for derivative: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images).  Add a suffix for this derivative (e.g., "-deliverable"). 
	d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then add metadata to the form:
	Required:   First Generation in DRS: select "no":.   Usage Class: select "HIGHUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	e. Repeat previous steps to create additional nested directories if you have more files derived from the current one. 
	f. Save your work (Project > Save on main menu).
	Text directories 
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	Layout directories (for Alto coordinates files)
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “LOWUSE” for Usage Class.
	5. Copy files into Batch Builder template directories on disk (can be done inside or outside of Batch Builder).
	The directories you created in BB have been created on disk, in the project’s template path:
	{project_name}\template\
	In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using mapping.txt file for how to create a mapping file.
	In the automatic workflow, files with the same role (archival master, deliverable, text, layout) are copied into the corresponding role-based directory.  In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.
	Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object template directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.
	6. Create a new object batch.
	You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).
	In the Graphical User Interface
	a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
	b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
	c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata that applies specifically to your object (for example descriptive metadata or Aleph ID, administrative categories, etc.). Note that any optional metadata that applies to all objects in the batch should be entered in the object template before your batch is created. For more about optional metadata see sections Adding Relationships, Adding Descriptive Metadata, Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name].
	Example:batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1Note that [batch_directory_name] is the name of your new batch directory, to be created by BB.
	If the batch creation is successful you will see the following messages:
	7. Process the batch.
	You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).
	In the Graphical User Interface
	a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	If you see any error messages, remedy the errors and re-process the batch.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a build -p “E:\My Project” -b batch1
	b. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see section 11. Processing Batches Using Command Line Interface.
	c. When the batch is successfully processed you will see the following messages:
	If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message)
	6.3.3 Use externally generated METS file to build structure-rich PDS objects

	This is a description of the procedures to build structure-rich PDS objects using externally generated METS files. This method is best to use when additional structure (i.e. custom section nodes) needs to be added to a PDS object before DRS deposit. Structure-rich PDS objects can be built using the BB manual object building option as well as using the BB automatic object building option.
	Preparing externally generated METS file for import into Batch Builder 2
	1. Where to place the PDS METS file(s)?
	o When building the objects manually the file(s) should be placed into the directory: [project]\_aux\[batch]\[object] 
	o When building objects automatically the file(s) should be placed into the directory [project]\_aux\template 
	2. How to adjust PDS METS file(s) for ingest by BB?
	There are changes to the file path and the file name in each xlink:href attribute in the <filesec> section of the provided METS files that need to be done before the file can be read and converted by BB. 
	a. (Required) The file path must be updated to correspond to the Batch Builder 2 naming and directory structure for every file referenced in xlink:href attribute in the <filesec> section of the provided METS file. For instance, given that when you created directories in BB template you named your archival master directory image-arch, your deliverable directory image-deliverable and your text directory text, the DRS 1-style PDS METS <filesec> section should be updated in the following way:
	xlink:href="archival_master/mydoc__1.tif"should be updated to readxlink:href="image-arch/ mydoc__1.tif "
	xlink:href="archival_master/deliverable/ mydoc__1.jp2" should be updated to readxlink:href="image-arch/image-deliverable/ mydoc__1.jp2" 
	xlink:href="archival_master/ocr_uncorrected/ mydoc__1.txt"should be updated to readxlink:href="text/ mydoc__1.txt"
	File path syntax note: The file path style (Linux/Mac vs Windows) in the xlink attribute needs to correspond to the computer operating system on which BB is being run. If BB is run on Windows the file path should use Windows-style slashes:
	image-arch\image-deliverable\ mydoc__1.jp2 
	If BB is run on Linux or Mac the file path should use the Linux/Mac style slashes:
	image-arch/image-deliverable/ mydoc__1.jp2
	b. (Optional) The file name in xlink:href needs to be modified if you plan to add an object OSN prefix to file names. For every file referenced in xlink:href attribute in the <filesec> section of the provided METS file The file names should be updated in the following way.
	If original file names were mydoc__1.tif, mydoc__1.jp2 and mydoc_1.txt and the object OSN prefix was added to the left and the page sequence number was added to the right so that the new file names are: obj1-- mydoc__1.tif , obj1-- mydoc__1.jp2 and obj1-- mydoc__1.txt the xlink:href attributes should be updated to read:
	xlink:href="image-arch/obj1-- mydoc__1.tif"xlink:href="image-arch/image-deliverable/obj1-- mydoc__1.jp2" xlink:href="text/obj1-- mydoc__1.txt"
	where “obj1” is the object OSN prefix.
	3. Name the PDS METS file(s) to correspond to BB naming scheme
	The METS file(s) should be named in the following way:{obj_name}_mets.xml. 
	ExampleIf the original METS file name is original_name.xml, and the PDS Document object owner supplied name is obj1 the new name of the METS file should be obj1_mets.xml 
	Note that the object OSN that is part of the METS file name (e.g.: obj1_mets.xml) should match the object OSN specified in the object name prefix for each file (e.g.: obj1--image1_1.jp2) or in the external mapping file mapping.txt (See Using mapping.txt file for how to create a mapping file.). 
	If building objects automatically, once a new batch is created the METS file(s) will be moved to the appropriate object directory(ies): [project]\_aux\[batch]\[object]. Note that if you need to edit your METS file(s) after the batch has been created you can edit them in their new locations ([project]\_aux\[batch]\[object]).
	6.3.3.1 Using BB manual object building option

	This is a description of the process to manually create a structure-rich PDS Document object batch using Batch Builder 2 (BB). This method is best to use when you have only one or two PDS objects in your batch.
	Procedure summary:

	1. Create a new project
	2. Enter DRS deposit settings
	3. Create object template
	4. Add directories to template
	5. Create a new object batch
	6. Copy files into object directories on disk
	7. Adjust PDS METS file(s) for ingest by BB
	8. Rename the PDS METS file(s) to required naming scheme.
	9. Place PDS METS file(s) into corresponding object directori(es/y) on disk
	10. Process the batch
	11. Upload batch to dropbox
	12. Check load report in email
	What you need before you start:

	 Prepare a batch of page images and (optionally) accompanying machine readable text and XML layout (Alto) files that constitute a future PDS Document object and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files and XML layout (Alto) files should match the file names of the page images files (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt, file1.xml).
	o Repeat the steps above for each PDS object you are preparing. Files for all objects you are preparing should reside in directories designated by their future roles – e.g.: archival masters for all objects reside in one directory, large deliverables for all objects reside in another, nested directory, etc.
	 Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2:[filename]__[sequence_number].[extension]. E.g.: file1__1.jpg, file2__2.jpg, etc. Check Section 1.2.2 of this Guide for more information about setting file name patterns in BB. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See section 12. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.
	 Decide what you will use for Owner Supplied Names for your object and the digital image files it consists of. For instance, you could use local classification or local accession numbers or an ALEPH ID.
	 Supply externally generated PDS METS file for each object for ingest by Batch Builder (see Harvard METS Profile for PDS for a list of elements that can be included in the PDS METS file). See section “Preparing externally generated METS file for import into Batch Builder 2” above to learn how to adjust the METS file for ingest by Batch Builder.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).Content Model: select the value "PDS document" from the dropdown.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:
	Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).File Access Flags:  the DRS access flag for the files.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path. Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  default value {n} will generate a unique number.
	c. Enter optional admin and descriptive metadata to the object template. Click the “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). 
	For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, and 16. Adding Licenses, Documentation and Other Supporting Content.
	4. Add directories to template:
	Image directories
	For one image file per page image:
	a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory name will start with “image” but you can append a custom suffix.
	b. Add metadata: click to select the new directory, then add metadata to the form:
	Required:
	   First Generation in DRS: select "yes".   Usage Class: select "HIGHUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	For multiple image files per page image (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file. 
	c. Add a master directory: right click on “Object Template” in Project Panel tree to create an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that describes the role. 
	d. Add metadata for the master directory: click to select the new directory, then add required metadata to the form:
	Required:   First Generation in DRS: select "yes".   Usage Class: select "LOWUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role: select ARCHIVAL_MASTER.
	e. Add a nested directory for derivative: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images).  Add a suffix for this derivative (e.g., "-deliverable"). 
	f. Add metadata for this derivative subdirectory: click to select the new subdirectory, then add metadata to the form:
	“required” tab:   First Generation in DRS: select "no".   Usage Class: select "HIGHUSE".
	“optional” tab: scroll down to "Still Image File Metadata":
	   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	g. Repeat the previous steps to create additional nested directories if you have more files derived from the current one. 
	h. Save your work (Project > Save on main menu).
	Text directories
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	Layout directories (for Alto coordinates files)
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “LOWUSE” for Usage Class.
	5. Create new batch with objects:
	Note: Metadata added at this level can be applied to a specific object or file directory. 
	a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch (will be used as the batch directory name on disk).  Click OK.
	Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.  
	b. Click to select new batch in Project Panel tree.  (Look for red letter B).
	c. Create new object from template: select Object > New from the main menu.  Enter the name of the object (by default, will be used as object OSN).  Make sure this object name is unique!  Click OK.  (Look for blue letter O).
	d. Enter optional metadata for each object and file.  Click the object directory in the Project Panel tree and select the “optional” tab on the right to enter optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). 
	For more about optional metadata see sections Adding Relationships, Adding Descriptive Metadata, Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	e. Repeat the previous steps to create additional objects (if you have more than one object in the batch).
	f. Save your project (Project > Save on main menu).
	6. Copy files into batch object directories on disk (done outside Batch Builder).
	Page image files go into an object's "image" directory.  Text files go in a "text" directory.  Layout files go in a "layout" directory. 
	Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.
	7. Adjust PDS METS file(s) for ingest by BB. See section Preparing externally generated METS file for import into Batch Builder 2 at the top of section 6.3.
	8. Rename the PDS METS file(s) to correspond to BB external mapping files naming scheme. See section Preparing externally generated METS file for import into Batch Builder 2 at the top of section 6.3.
	9. Place the PDS METS file(s) into corresponding object directories
	The PDS METS file(s) should be placed into corresponding object directories: [project]\_aux\[batch]\[object].
	10. Process the batch:
	a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Processing messages will appear in the messages pane. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:
	11. Upload batch to dropbox
	a. Open your SFTP client and log into your DRS2 training dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	12. Check load report in email.
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
	6.3.3.2 Using BB automatic object building option

	This is a description of the procedure to build structure-rich PDS objects using externally generated METS files by means of the BB automatic object building option. This method is best to use when you have more than two PDS objects in your batch.
	Procedure summary:

	1. Create a new project 
	2. Enter DRS deposit settings
	3. Create object template
	4. Add directories to template
	5. Move/copy files into template directory
	6. Place PDS METS file(s) into corresponding template directory
	7. Adjust PDS METS file for ingest to BB
	8. Rename the PDS METS file to correspond to BB external mapping files naming scheme
	9. Create a new object batch
	10. Process the batch
	11. Upload batch to dropbox
	12. Check load report in email
	What you need before you start:

	 Prepare a batch of page images and (optionally) accompanying machine readable text files and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files should match the file names of the page images files as well (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt). 
	o Repeat the steps above for each PDS object you are preparing. Files for all objects you are preparing should reside in directories designated by their future roles – e.g.: archival masters for all objects reside in one directory, large deliverables for all objects reside in another, nested directory, etc.
	 Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2:[filename]__[sequence_number].[extension]. E.g.: file1__1.jpg, file2__2.jpg, etc. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See section 12. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.
	 Decide what you will use for Owner Supplied Names (OSNs) for your objects and the digital image files they contain. For instance, you could use local classification or local accession numbers or ALEPH IDs.
	 Make sure that the object OSNs are supplied for each file by one of the following methods:
	o Append the object prefix to each file name (the syntax is [objprefix]--[filename]__[pageSeq].[ext]). Set the desired file name pattern objects in the BB Options dialog (see section 1.2.2 for more information). 
	o When preparing several objects, objprefix for a corresponding object should be used for the files that are going to be part of that object. E.g.: obj1—file1__01.jpeg, obj2—file1__01.jpeg, obj1—file2__02.jpeg, obj2—file2__02.jpeg ect.
	o Supply an external mapping file that maps each file to object (see section 12.1 for more information). One mapping file can contain references to multiple objects.
	 Supply externally generated PDS METS file for each object for ingest by Batch Builder (see Harvard METS Profile for PDS for a list of elements that can be included in the PDS METS file). The PDS METS file should be placed into [project]\_aux\template directory (for Unix, Linux or Mac the path would be [project]/_aux/template). 
	o Note that you can place several corresponding METS files for each of your objects in the [project]\_aux\template directory. The naming scheme for the PDS METS files is explained in step 7 of this procedure.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).Content Model: select the "PDS document" value from the dropdown.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:
	Note: Metadata added at this level will be applied to every object in a batch, unless overridden by specific object-level metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).File Access Flags: DRS access flag for the files in the object. Should contain the least restrictive access flag that applies to all the files.URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  default value {n} will generate a unique number.
	c.  Enter optional admin and descriptive metadata to the object template. Click the “optional” tab.  
	IDS URN for Deliverable JPG and JP2: Select "Yes" if you need IDS URNs for all deliverable images in the batch.
	4. Add directories to template:
	In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.
	Image directories
	For one image file per page image:
	a. Add directory: right click on “Object Template” in Project Panel tree.  The new directory name will start with “image” but you can append a custom suffix.
	b. Add metadata: click to select the new directory, then add metadata to the form:
	Required:
	   First Generation in DRS: select "yes".   Usage Class: select "HIGHUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.   Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	For multiple image files per page image (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file. 
	a. Add a master directory: right click on “Object Template” in Project Panel tree to create an "image" directory.  In the text field, enter "-archival_master" or a similar suffix that describes the role. 
	b. Add metadata for the master directory: click to select the new directory, then add required metadata to the form:
	Required:   First Generation in DRS: select "yes".   Usage Class: select "LOWUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role: select ARCHIVAL_MASTER.
	c. Add a nested directory for derivative: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images).  Add a suffix for this derivative (e.g., "-deliverable"). 
	d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then add metadata to the form:
	Required:   First Generation in DRS: select "no":.   Usage Class: select "HIGHUSE".
	Optional: scroll down to "Still Image File Metadata":
	   Role: select appropriate value for derivative (e.g., DELIVERABLE).  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	e. Repeat previous steps to create additional nested directories if you have more files derived from the current one. 
	f. Save your work (Project > Save on main menu).
	Text directories 
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	Layout directories (for Alto coordinates files)
	a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “LOWUSE” for Usage Class.
	5. Copy files into Batch Builder template directories on disk (can be done inside or outside of Batch Builder)
	The directories you created in BB have been created on disk, in the project’s template path:
	{project_name}\template\
	In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using mapping.txt file for how to create a mapping file.
	In the automatic workflow, files with the same role (archival master, deliverable, text, layout) are copied into the corresponding role-based directory.  In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.
	Copy your PDS METS file into the 
	Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object template directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.
	6. Place PDS METS file(s) into corresponding template directoryThe file(s) should be placed into the directory: [project]\_aux\template. 
	7. Adjust PDS METS file(s) for ingest by BB. See section Preparing externally generated METS file for import into Batch Builder 2 at the top of section 6.3.
	8. Rename the PDS METS file(s) to correspond to BB external mapping files naming scheme. See section Preparing externally generated METS file for import into Batch Builder 2 at the top of section 6.3.
	9. Create a new object batch.
	You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).
	In the Graphical User Interface
	a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
	b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
	c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata that applies specifically to your object (for example descriptive metadata or Aleph ID, administrative categories, etc.). Note that any optional metadata that applies to all objects in the batch should be entered in the object template before your batch is created. For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name].
	Example:batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1Note that [batch_directory_name] is the name of your new batch directory, to be created by BB.
	If the batch creation is successful you will see the following messages:
	10. Process the batch.
	You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).
	In the Graphical User Interface
	a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	If you see any error messages, remedy the errors and re-process the batch.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a build -p “E:\My Project” -b batch1
	b. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see section 11. Processing Batches Using Command Line Interface.
	c. When the batch is successfully processed you will see the following messages:
	If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message)
	11. Upload batch to dropbox
	a. Open your SFTP client and log into your DRS2 training dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	12. Check load report in email.
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
	7. Creating and Processing Opaque Object Batches
	7.1 Manually build opaque objects from template7.2 Automatically build opaque objects from template
	There are two methods you can use to create Opaque objects in Batch Builder:
	1. Manually create objects from template. This is best when you have less than 5 objects to work with. In this scenario you generate in BB an object structure for each object and then copy files into it (done outside BB). See section 7.1 for the procedure.
	2. Automatically build objects from template. This method is best for large batches of objects (5 or more objects per batch). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 7.2 for the procedure.
	Note that an opaque object can have only one directory named “content” (where all the content files are stored). Inside the content directory there can be additional nested directory structures. However the word “content” is reserved and cannot be used in the name of any directories that are part of the opaque object.
	7.1 Manually build Opaque objects from template

	This is a description of the procedure to manually create a batch of opaque objects from template in Batch Builder 2 (BB). This method should be used if you have less than 5 objects per batch.
	Procedure summary:

	1. Create a new project
	2. Enter DRS deposit settings
	3. Create object template
	4. Add directories to template
	5. Add metadata
	6. Save your work
	7. Create a new object batch
	8. Move/copy files into corresponding directories on disk
	9. Process the batch
	What you need before you start:

	 Prepare several opaque objects and put them in a directory of your choice somewhere on local hard disk or network drive. Consult DRS2 Content Models Reference for guidelines on creating opaque objects.
	 Decide what you will use for Owner Supplied Names (OSNs) for opaque objects. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
	Procedure:

	1. Create a new project.
	a. Open BB by double clicking on the executable.
	b. From the Project menu select New.
	c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “opaque” from the dropdown; click OK to continue.
	2. Enter DRS deposit settings.
	a. Select “Deposit Settings” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter email address(es) for DRS Reports to be sent to.
	c. Type the email in Success Email field and press Enter on the keyboard.
	d.  Type the email in Failure Email field and press Enter on the keyboard.
	e. For more email addresses repeat c and d.
	f. Choose success method (‘email‘ is the most commonly used).
	g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS metadata for each batch). 
	3. Create object template
	a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter DRS Owner Code for objects you will be depositing (use all caps).
	c. Enter DRS Billing Code for objects you will be depositing (use all caps).
	d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta testing).
	e. (Optional) Switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. 
	4. Add directories to template.
	Content directory (note that an opaque object can have only one directory named “content”)
	a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “content” but you can append a custom suffix).
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “LOWUSE” for Usage Class.
	Documentation directory (optional)
	a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “documentation” but you can append a custom suffix).
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “LOWUSE” for Usage Class.
	Go to Project menu in the top menu bar and choose Save to save your project.
	5. Add metadata: click to select the new directory, then add metadata to the form:Required:First Generation in DRS: select "yes". Usage Class: select "LOWUSE".
	Optional: 
	Role:  There are no roles for content files, but you can select either DOCUMENTATION or LICENSE roles for documentation files.  Select any role that applies.  
	6. Save your work:  Project > Save on main menu.
	7. Create a new object batch.
	a. From the Batch menu select “New”; enter the name of the new batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the left (icon with red letter B).
	b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK. 
	c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.  
	d. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	e. Repeat b-d if you have more than object.
	8. Move/copy images into corresponding file directories on disk.
	(Done outside Batch Builder)
	The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right. 
	a. Copy the content files into the corresponding content directory in the object directory.
	b. Copy documentation files into the corresponding documentation directory in the object directory.
	c. Repeat if you have more than one object.
	9. Process the batch.
	a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	7.2 Automatically build Opaque objects from template

	This is a description of the procedure to automatically create a batch of opaque objects from template in Batch Builder 2 (BB).This method should be used if you have 5 or more opaque objects per batch and the object contents are simple (e.g.: several files per object without any nested directories). If the object content consists of many files and nested directories this method becomes impractical. In this latter case use the procedure to manually build Opaque objects from template.
	Procedure summary:

	1. Create a new project
	2. Enter DRS deposit settings
	3. Create object template
	4. Add directories to template
	5. Add metadata
	6. Save your work
	7. Move/copy files into corresponding directories on disk
	8. Create new batch with objects
	9. Process the batch
	10. Upload batch to dropbox
	11. Check load report in email
	What you need before you start:

	 Prepare your opaque objects and put them in a directory of your choice somewhere on local hard disk or network drive. Consult DRS2 Content Models Reference for guidelines on creating opaque objects. Note that each opaque object can have only one “content” directory in which the contents are contained. The word “content” is reserved and cannot be used in any directory names that are part of the directory structure of the object itself (i.e. directories nested inside the “content” directory).
	 Decide what you will use for Owner Supplied Names (OSNs) for opaque objects. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
	 Make sure that the object OSNs are supplied for each file by one of the following methods:
	o Append the object prefix to each file name (the syntax is [objprefix]--[filename].[ext]). Set the desired file name pattern objects in the BB Options dialog (see section 1.2.2 for more information).
	o Supply an external mapping file that maps each file to object (see section 12.1 for more information).
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: Project Name:  enter a name for your project (used for internal tracking only).Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).Content Model: select the appropriate value ("opaque") from the dropdown.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).Object Access:  the DRS access flag.  Set value to "N" (no access).
	c. Enter optional admin and descriptive metadata to the object template. Click the “optional” tab.  Notable metadata at this level:
	d. Admin category: assign a category to every object.  A curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.
	4. Add directories to template:About files in opaque objects:  All files that make up the opaque object must be stored in one “content” directory.  Any documentation files that describe the opaque content must be stored in a “documentation” directory.  The “documentation” directory must be parallel to the “content” directory.  There can be only one “content” directory per opaque object.
	a. Add directory: right click on “Object Template” in Project Panel tree.  Content directories are prefixed with "content".  Documentation directories are prefixed with "documentation.  But you can append a custom suffix to directory name.
	5. Add metadata: click to select the new directory, then add metadata to the form:
	a. Required:First Generation in DRS: select "yes". Usage Class: select "LOWUSE".
	b. Optional: Role:  There are no roles for content files, but you can select either DOCUMENTATION or LICENSE roles for documentation files.  Select any role that applies. 
	6. Save your work (Project > Save on main menu).
	7. Copy files into Batch Builder template directory on disk.
	The directories you created in BB have been created on disk, in the project’s template path:
	{project_name}\template\
	In the automatic workflow, files are copied into a directory in the template path.  In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.
	Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	8. Create new batch with objects:
	a. Create new batch: From the menu select “Object > Create a new batch with objects from template”.  Enter the name of the batch directory to be created on disk and click OK. 
	In response to this action you will see: 
	"FINISHED - Moved objects to [batch name]"  in the message panel.
	A new batch directory with red letter B added to the Project Panel.
	New object directories (marked by blue letter O), and file directories nested below the batch directory.
	Behind the scenes, BB created the batch and object directories on disk and moved the content files from the {project_name}\template directory into the object directories. 
	b. Add optional metadata for each object and/or each file.  Note that required metadata was supplied by the object template.
	Select an object directory (or file directory) in the Project Panel and then select the “optional” tab on the right.
	Object metadata: select the object directory, open the “optional” tab.  
	Notable metadata types include:
	Aleph ID for MODS import: import descriptive metadata from Aleph.  You can also right-click over the object directory in project panel to assign Aleph ID.
	Admin category: a curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.
	Descriptive metadata fields (MODS): use only if not importing by Aleph ID or including external MODS file.
	File metadata: select a file directory, open the “optional” tab:
	Admin category: a curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.
	To import an object description from Aleph, right click on the object directory and select "Set Aleph ID".
	c. Save your project (Project > Save on main menu).
	9. Process the batch:
	a. In the Project Panel tree, right click on the batch you want to process (batch with red letter B) and select “Create descriptors & batch.xml.”  Or from the main menu, select Batch > Create descriptors & batch.xml.
	b. Processing messages will appear in the messages pane. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:
	10. Upload batch to dropbox:
	a. Open your SFTP client and log into your DRS2 dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	11. Check load report in email:
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	c. For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
	8. Creating and Processing Document (PDF) Object Batches
	8.1 Manually create document objects from template8.2 Automatically create document objects from template
	There are three methods you can use to create Document objects in Batch Builder:
	1. Manually create objects from template. This is best when you have only one or two Document objects to work with. In this scenario you generate an object structure in BB for each object and then copy files into the structure (can be done outside BB). See section 8.1 for the procedure.
	2. Automatically build objects from template. This method is best for large batches of objects (over 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 8.2 for the procedure.
	3. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. This method is useful when object properties such as Owner Code, Billing Code and URN authority path are different for each object. Because this option will be rarely used, it is not currently documented
	8.1 Manually create document objects from template

	This is a description of the procedure to create a simple batch of Document (PDF) objects from template in Batch Builder 2 (BB). Use this method when only several document objects need to be created, processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically. 
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directories to template.
	5. Create a new object batch.
	6. Move/copy files into corresponding directories on disk.
	7. Process the batch.
	What you need before you start:

	 Prepare several PDF files and put them in a directory of your choice somewhere on local hard disk or network drive.
	 Decide what you will use for Owner Supplied Names for Document objects and the digital files (PDFs) they consist of. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).
	Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
	TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. software_documentation_project)
	Content Model: select the "document" value from the dropdown.
	Project Description (optional): Any information relevant to the project – will only remain locally.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	d. Click on “Deposit Settings” in Project Panel tree.
	e. Enter deposit data in the form:
	Batch Name Pattern:  default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
	(This is the name for a batch that appear on DRS deposit reports.)
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).Object Access:  the DRS access flag.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  use default value {n} to generate a unique number.
	c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  
	4. Add directories to template.
	a. Right click on “Object Template” in the Project Panel on the left and select the ‘add a directory…’ menu option. 
	b. Type in a name for your directory in the text box.  The directory name will start with “document” but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_diary_pdfs’ will result in a directory called ‘document_diary_pdfs’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “HIGHUSE” for Usage Class.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Document Object Metadata “
	d. Enter any file level optional metadata in the form
	Role:  use Ctrl Click to select ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	5. Save your work (Project > Save on main menu).
	6. Create new batch with objects:Metadata added at this level can be applied to a specific object, or specific file directory. 
	a. Create new batch: select “Batch > New” from the main menu.  Enter a name for the batch (will be used as the batch directory name on disk).  Click OK.
	Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.  
	b. Select the batch (with the red letter B) in the Project Panel
	c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and click OK. 
	d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object (blue letter O)  
	e. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note: any metadata entered at the object level will override metadata entered at the template level.
	f. Repeat b-e if you have more than object.
	7. Save your project (Project > Save on main menu).
	8. Copy image files into batch object directories on disk (can be done outside Batch Builder).
	Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom. 
	** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.
	** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project. 
	** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.
	9. Process the batch:
	a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Processing messages will appear in the messages pane. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:
	10. Upload batch to dropbox.
	a. Open your SFTP client and log into your DRS2 training dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	11. Check load report in email.
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.   If you see any error messages, remedy the errors and re-process the batch. 
	8.2 Automatically create document objects from template

	This is a description of the procedure to automatically build a batch of Document (PDF) objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (more than 10) that need to be created and your source files are not broken into directories by object. ( e.g. you have 100 PDF files in a directory on disk).
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directories to template.
	5. Move/copy files into template directory.
	6. Add object name prefix to file names or supply mapping.txt file.
	7. Create new object batch.
	8. Process the batch.
	What you need before you start:

	 Prepare the PDF files and put them in a directory of your choice somewhere on local hard disk or network drive.
	 Decide what you will use for qwner supplied names for document objects and the PDF files they consist of. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information. 
	 Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see section 1.2.2. For more details about external mapping files see section 12.1.
	Procedure:

	Start at Step 5 if you are reusing a project to generate a new batch.
	1. Create new project in Batch Builder
	a. From main menu select Project > New.
	b. Enter project data: 
	Project Name:  enter a name for your project (used for internal tracking only).
	Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
	TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. software_documentation _project)
	Content Model: select the "document" value from the dropdown.
	Project Description (optional): Any information relevant to the project – will only remain locally.
	c. Click OK to continue.
	2. Enter DRS deposit settings:
	a. Click on “Deposit Settings” in Project Panel tree.
	b. Enter deposit data in the form:
	Batch Name Pattern:  default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
	(This is the name for a batch that appear on DRS deposit reports.)
	Success Email:  type email and press enter.Failure Email:  type email and press enter.Success Method:  choose how you will receive load report.Deposit Agent:  type your HUID.
	3. Create object template:Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
	a. Click on “Object Template” in Project Panel tree:
	b. Enter required object metadata in the form:
	DRS Owner Code: your owner code (use all caps).DRS Billing Code: your billing code (use all caps).Object Access:  the DRS access flag.  At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.  URN Authority Path: your NRS authority path.  Use all caps.  Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html.URN Resource Name Pattern:  use default value {n} to generate a unique number.
	c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content.  Note that any metadata entered at the object level will override metadata entered at the template level.
	4. Add directories to template:
	In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.
	a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.
	b. Type in a name for your directory in the text box . The directory name will start with “document” but the name you type will be appended to it.  Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_PDFs’ will result in a directory called ‘document_PDFs’
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “HIGHUSE” for Usage Class.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	Role:  use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles.  Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	Add additional metadata (optional):
	a. Select the new directory in the Project Panel on the left
	b. In the Content Panel, select the ‘optional’ tab.
	c. Scroll down to "Still Image File Metadata “
	d. Enter any file level optional metadata in the form
	   Role: select ARCHIVAL_MASTER.
	5. Save your work (Project > Save on main menu).
	6. Copy files into Batch Builder template directory on disk (can be done outside Batch Builder)
	a. The directories you created in BB have been created on disk, in the project’s template path:
	b. {project_name}\template\
	c. In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.  See Naming Rules for Objects for how to add an object name prefix.  See Using mapping.txt file for how to create a mapping file.
	d. Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom 
	e. ** Quick way to copy content files: you can drag files from your file system onto the object template directories in the Batch Builder project panel.
	f. ** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project. 
	g. ** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.
	9. Create a new object batch.
	You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI). 
	In the Graphical User Interface
	a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
	b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
	c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
	d. Save the project to have BB2 write the new metadata values to the internal configuration files.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33
	Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1Note that the batch directory name is the name of your new batch directory, to be created by BB.
	b. If the batch creation is successful you will see the following messages:
	10. Process the batch.
	You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)
	In the Graphical User Interface
	a.  In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	If you see any error messages, remedy the errors and re-process the batch. 
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a build -p “E:\My Project” -b batch1
	b. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see section 11. Processing Batches Using Command Line Interface.
	c. When the batch is successfully processed you will see the following messages:
	If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).
	9. Creating and Processing Text Object Batches
	9.1 Manually create text objects from template9.2 Automatically create text objects from template
	There are three methods you can use to create Text objects in Batch Builder:
	1. Manually create objects from template. This is best when you have only one or two Text objects to work with. In this scenario you generate in BB an object structure for each object and then copy files into it (done outside BB). See section 8.1 for the procedure.
	2. Automatically build objects from template. This method is best for large batches of objects (over 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 8.2 for the procedure.
	3. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. 
	9.1 Manually create text objects from template

	This is a description of the procedure to manually create a batch of Text objects from template in Batch Builder 2 (BB). Use this method when only several Text objects need to be created, processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically. 
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directories to template.
	5. Create new object batch. 
	6. Move/copy files into corresponding directories on disk.
	7. Process the batch. 
	What you need before you start:

	 Prepare several text files and put them in a directory of your choice somewhere on local hard disk or network drive.
	 Decide what you will use for Owner Supplied Names for your Text objects and the digital files they consist of. For instance, you could use local classification or local accession numbers. Section 3 of this Guide for more information about file and object Owner Supplied Names.
	Procedure:

	1. Create a new project.
	a. Open BB by double clicking on the executable.
	b. From the Project menu select New.
	c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “text” from the dropdown; click OK to continue.
	2. Enter DRS deposit settings.
	a. Select “Deposit Settings” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter email address(es) for DRS Reports to be sent to.
	c. Type the email in Success Email field and press Enter on the keyboard.
	d. Type the email in Failure Email field and press Enter on the keyboard.
	e. For more email addresses repeat c and d.
	f. Choose success method (“email” is the most commonly used).
	g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS metadata for each batch). 
	3. Create object template (called “batch template” in BB 1).
	a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter DRS Owner Code for objects you will be depositing (use all caps).
	c. Enter DRS Billing Code for objects you will be depositing (use all caps).
	d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta testing).
	e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps.
	f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing).
	g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.
	4. Add directories to template.
	a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “text” but you can append a custom suffix).
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	e. In the Content Panel switch to Optional tab, scroll down to Text File Metadata and use Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	Go to Project menu in the top menu bar and choose Save to save your project.
	5. Create new object batch.
	a. From the Batch menu select “New”; enter the name of the new batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the left (icon with red letter B).
	b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK. 
	c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.  
	d. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your object). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.
	e. Repeat if you have more than object.
	6. Move/copy files into corresponding file directories on disk.
	(Done outside Batch Builder)
	The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right. 
	a. Copy the files into corresponding file directories in the object directory.
	b. Repeat if you have more than one object.
	7. Process the batch.
	a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	If you see any error messages, remedy the errors and re-process the batch. 
	9.2 Automatically build text objects from template

	This is a description of the procedure to automatically build a batch of Text objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that need to be created and your source files are in directories that are not broken by object.
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directives to template.
	5. Move/copy files into template directories.
	6. Add object name prefix to file names or supply a mapping.txt file.
	7. Create new object batch.
	8. Process the batch.
	What you need before you start:

	 Prepare a dozen of text files and put them in a directory of your choice somewhere on local hard disk or network drive.
	 Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See section 3 for more information about owner supplied names.
	 Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see section 1.2.2. For more details about external mapping files see section 12.1.
	Procedure:

	1. Create a new project.
	a. Open BB by double clicking on the executable.
	b. From the Project menu select New.
	c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “text” from the dropdown; click OK to continue.
	2. Enter DRS deposit information.
	a. Select “Deposit Settings” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter email address(es) for DRS Reports to be sent to.
	c. Type the email in Success Email field and press Enter on the keyboard.
	d. Type the email in Failure Email field and press Enter on the keyboard.
	e. For more email addresses repeat c and d.
	f. Choose success method ("email" is the most commonly used).
	g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS metadata for each batch). 
	3. Create object template (called “batch template” in BB 1).
	a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter DRS Owner Code for objects you will be depositing (use all caps).
	c. Enter DRS Billing Code for objects you will be depositing (use all caps).
	d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta testing).
	e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps.
	f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing).
	g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.
	4. Add directories to template.
	a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “text” but you can append a custom suffix).
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	e. In the Content Panel switch to Optional tab, scroll down to Text Metadata and use Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.
	Go to Project menu in the top menu bar and choose Save to save your project.
	5. Move/Copy files into template directory.
	Copy files to the corresponding text directory inside the template directory. 
	6. Add object name prefix to file names or supply a mapping.txt file.
	In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object. 
	o Add an object owner supplied name as a prefix to the name of each file. The prefix needs to be separated from the file name by the special separator sting “--“. E.g.: obj1--file1.txt is a file name that tells Batch Builder that this particular file needs to be part of object obj1. 
	o Provide a mapping file mapping.txt placed in the project /_aux/template directory which maps each file to an object owner supplied name. 
	Syntax: relative_file_path,file_OwnerSuppliedName,PDS_sequence number(optional),object_OwnerSuppliedName
	Notes on syntax: There should be no spaces between a comma “,” and the next character. If an optional element value is skipped it still needs to be designated by a comma “,” so that Batch Builder can associate the right value with the right element. For example, when using mapping.txt file for objects other than PDS Documents, an extra comma needs to be inserted between the FILE OSN value and Object OSN value where PDS sequence number value would be expected. 
	7. Create a new object batch.
	You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI). 
	In the Graphical User Interface
	a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
	b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
	c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to add any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1Note that the batch directory name is the name of your new batch directory, to be created by BB.
	b. If the batch creation is successful you will see the following messages:
	8. Process the batch.
	You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)
	In the Graphical User Interface
	a.  In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	If you see any error messages, remedy the errors and re-process the batch. 
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a build -p “E:\My Project” -b batch1
	b. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see section 11. Processing Batches Using Command Line Interface.
	c. When the batch is successfully processed you will see the following messages:
	Building PREMIS file metadata...
	Building HulDrsAdmin file metadata...
	Success!
	If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).
	10. Creating and Processing Audio Object Batches
	10.1 Manually create audio objects from template10.2 Automatically build audio objects from template10.3  Build an advanced audio batch
	There are four methods you can use to create Audio objects in Batch Builder:
	1. Manually create objects from template. This is best when you have only one or two Audio objects to work with. In this scenario you generate in BB an object structure for each object and then copy files into it (can be done outside BB). See section 10.1 for the procedure.
	2. Automatically build objects from template. This method is best for large batches of objects (over 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 10.2 for the procedure.
	3. Use Batch Builder advanced audio functionality to build an advanced audio batch. Use this method if you plan to deposit audio files along with additional supporting files containing technical and structural metadata about your audio – such as ADL audio decision lists and AES 60 structural metadata files for governing audio playback. If you do not need to deposit ADL or AES-60 files with your audio, use the procedures described in sections 10.1 or 10.2 instead
	4. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. 
	10.1 Manually create audio objects from template

	This is a description of the procedure to manually create a batch of Audio objects from template in Batch Builder 2 (BB). Use this method when only Audio objects need to be created, processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically. 
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings. 
	3. Create object template.
	4. Add directories to template.
	5. Create new object batch. 
	6. Move/copy files into corresponding directories on disk.
	7. Process the batch.
	8. Upload the batch to your dropbox
	9. Check the email report
	What you need before you start:

	 Prepare several audio files and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one audio file per recording (e.g.: an archival master and a deliverable or an archival master, a production master and a deliverable) make sure file names match (e.g.: music-1.aif, music-1.wav and music-1.mp3). Consult Section 3 of this Guide for more information on file and directory naming.
	 Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See Section 3 for more information about owner supplied names.
	Procedure:

	1. Create a new project.
	a. Open BB by double clicking on the executable.
	b. From the Project menu select New.
	c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “audio” from the dropdown; click OK to continue.
	2. Enter DRS deposit settings.
	a. Select “Deposit Settings” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter email address(es) for DRS Reports to be sent to.
	c. Type the email in Success Email field and press Enter on the keyboard.
	d.  Type the email in Failure Email field and press Enter on the keyboard.
	e. For more email addresses repeat c and d
	f. Choose success method (‘email‘ is the most commonly used).
	g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS metadata for each batch). 
	3. Create object template (called “batch template” in BB 1).
	a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter DRS Owner Code for objects you will be depositing (use all caps).
	c. Enter DRS Billing Code for objects you will be depositing (use all caps).
	d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta testing).
	e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps.
	f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing).
	g. (Optional) switch to “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. 
	4. Add directories to template.
	a. Right click on “Object Template” in the Project Panel on the left and add a directory  and select the ‘add a directory…’ menu option
	b. Type in a name for your directory in the text box.  The directory name starts with “audio”, but the name you type will be appended to it.  Tip: to make it easier to read, start your directory name with an underscore (_). So, typing ‘_mp3_files’ will result in a directory called ‘audio_mp3_files’.
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	e. Choose “HIGHUSE” for Usage Class.
	f. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and use Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.
	Create a directory for an archival master and nest one or more deliverable directories inside it (this is needed for BB to determine the derivative relationship).
	a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory …’ menu option. 
	b. In the text box, type  ‘-archival_master’ or a similar suffix that describes the role of your directory. The directory name will start with “audio” but the name you type will be appended to it. So, typing ‘-archival_master’ will result in a directory called ‘audio-archival_master’ 
	c. In the Project Panel on the left select the directory you just created.
	d. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”. 
	e. Choose “LOWUSE” for Usage Class.
	f. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role ARCHIVAL_MASTER.
	g. In the Project Panel on the left, right click on the directory you just created and select the ‘add a directory …’ menu option.
	h. In the text box, type ‘-deliverable’ or a similar suffix that describes the role for your directory.
	i. In the Project Panel on the left, select the directory you just created.
	j. In the Content Panel choose “no” from the dropdown list for the field “First Generation in DRS”.
	k. Choose “HIGHUSE” for Usage Class.
	l. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.
	m. If you have more deliverables that are derived from the archival master (an mp3 deliverable and an mp4 deliverable for instance) right click on the topmost audio directory you created, add a custom suffix if needed and follow steps g-i once again.
	5. Save your work (Project > Save on main menu)
	6. Create new object batch.
	a. Select “Batch>New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk) Click OK.
	Tip: including the word “batch” in your batch name will help you remember the directory’s purpose on the file system. 
	b.  Select the batch (with the red letter B) in the project Panel.
	c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK. 
	d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object. 
	e. (Optional) Select each object icon in the Project Panel and edit any needed metadata (for instance, if each object has a separate corresponding Aleph record, you can switch to the Optional tab in the Content Panel on the right while the object icon is selected in the Project Panel on the left and enter the Aleph ID for each object in the “Aleph ID for MODS import” field).
	f. Repeat if you have more than object.
	7. Move/copy files into corresponding file directories on disk.
	(Can be done outside Batch Builder)
	The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right. 
	a. Copy the files for into corresponding file directories in the object directory.
	b. Repeat if you have more than one object.
	8. Process the batch.
	a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	If you see any error messages, remedy the errors and re-process the batch.  
	9. Upload batch to dropbox.
	a. Open your SFTP client and log into your DRS2 training dropbox account.
	b. Change to the "incoming" directory.
	c. Upload the batch: copy the entire batch directory to the "incoming" directory.
	d. Close the SFTP client.  Batch processing will start.
	10. Check load report in email.
	a. Open your email inbox.
	b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
	For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.   If you see any error messages, remedy the errors and re-process the batch. 
	10.2 Automatically build audio objects from template

	This is a description of the procedure to automatically build a batch of audio objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that need to be created and your source files are not broken into directories by object.
	Procedure summary:

	1. Create a new project.
	2. Enter DRS deposit settings.
	3. Create object template.
	4. Add directories to template.
	5. Move/copy files into template directories.
	6. Add object name prefix to file names or supply a mapping.txt file.
	7. Create new object batch.
	8. Process the batch.
	9. Upload the batch to your dropbox
	10. Check the load report in email
	What you need before you start:

	 Prepare audio files and put them in a directory of your choice somewhere on local hard disk or network drive.  If you have more than one file per object (e.g.: an archival master and a deliverable or an archival master, a production master and a deliverable) make sure the file names match (e.g.: music-1.aif, music-1.wav and music-1.mp3). Consult Naming Rules section of this Guide for more information on file and directory naming.
	 Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See section 3 of this Guide for more information about owner supplied names.
	 Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see section 1.2.2. For more details about external mapping files see section 12.1.
	Procedure:

	1. Create a new project.
	a. Open BB by double clicking on the executable.
	b. From the Project menu select New.
	c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “audio” from the dropdown; click OK to continue.
	2. Enter DRS deposit settings.
	a. Select “Deposit Settings” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter email address(es) for DRS Reports to be sent to.
	c. Type the email in Success Email field and press Enter on the keyboard.
	d.  Type the email in Failure Email field and press Enter on the keyboard.
	e. For more email addresses repeat c and d.
	f. Choose success method (‘email‘ is the most commonly used).
	g. Enter HUID of the person who will be making DRS deposits (will be recorded in DRS metadata for each batch). 
	3. Create object template (called “batch template” in BB 1).
	a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
	b. Enter DRS Owner Code for objects you will be depositing (use all caps).
	c. Enter DRS Billing Code for objects you will be depositing (use all caps).
	d. Select DRS Access Flag value for objects you will be depositing (Use “P” for Beta testing).
	e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrsadmintest.lib.harvard.edu:9012/nrs/status.html) – use all caps.
	f. Enter URN Resource Name Pattern (Use the default value of “{n}” for Beta testing).
	g. (Optional) switch to “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 14. Adding Relationships, 15. Adding Descriptive Metadata, 16. Adding Licenses, Documentation and Other Supporting Content. 
	4. Add directories to template.
	a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “audio” but you can append a custom suffix).
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
	d. Choose “HIGHUSE” for Usage Class.
	e. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and use Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.
	Create a directory for an archival master and nest one or more deliverable directories inside it (this is needed for BB to determine the derivative relationship).
	a. Right click on “Object Template” in the Project Panel on the left to add a directory (this will be the directory for archival master). The directory name starts with “audio” but you can append a custom suffix.
	b. In the Project Panel on the left select the directory you just created.
	c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”. 
	d. Choose “LOWUSE” for Usage Class.
	e. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role ARCHIVAL_MASTER.
	f. In the Project Panel on the left right click on the directory you just created and create another directory nested inside it (this will be the directory for deliverable audio). Once again, append a custom suffix to directory name if needed (e.g. “audio-deliverable”).
	g. In the content panel choose “no” from the dropdown list for the field “First Generation in DRS”.
	h. Choose “HIGHUSE” for Usage Class.
	i. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.
	j. If you have more deliverables that are derived from the archival master (an mp3 deliverable and an mp4 deliverable for instance) right click on the topmost audio directory you created, add a custom suffix if needed and follow steps g-i once again.
	Go to Project menu in the top menu bar and choose Save to save your project.
	5. Move/Copy files into template directory.
	o If you have one audio file per object, copy each file to the corresponding audio directory inside the template directory. 
	o If you have more than one file per object, copy the files for each object into corresponding nested audio directories in the template directory.
	Important: the file names for all files belonging to the same object need to match (e.g.: audio-1.aif; audio-1.wav; audio-1.mp3).
	6. Add object name prefix to file names or supply a mapping.txt file.
	In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object. 
	o Add an object owner supplied name as a prefix to the name of each file. The prefix needs to be separated from the file name by the special separator sting “--“. E.g.: obj1--file1.aif is a file name that tells Batch Builder that this particular file needs to be part of object obj1. Make sure that the file name pattern setting in the BB Options dialog is set to the correct setting. See more information about file Owner Supplied Name pattern settings in section 1.2.2.
	o Provide a mapping file mapping.txt placed in the project /_aux/template directory which maps each file to an object owner supplied name. 
	Syntax: relative_file_path,file_OwnerSuppliedName,PDS_sequence number(optional),object_OwnerSuppliedName
	Notes on syntax: There should be no spaces between a comma “,” and the next character. If an optional element value is skipped it still needs to be designated by a comma “,” so Batch Builder can associate the right value with the right element. For example, for objects that do not have PDS sequence numbers, an extra comma needs to be inserted between the FILE OSN value and Object OS. 
	7. Create a new object batch.
	You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI). 
	In the Graphical User Interface
	a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK.  A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
	b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
	c. (Optional) Select each object icon in the Project Panel and edit any needed metadata (for instance, if each object has a separate corresponding Aleph record, you can switch to the Optional tab in the Content Panel on the right while the object icon is selected in the Project Panel on the left and enter the Aleph ID for each object in the “Aleph ID for MODS import” field).
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	Type bathcbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a buildtemplate -p “E:\My Project” -b batch1
	b. If the batch creation is successful you will see the following messages:
	8. Process the batch.
	You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)
	In the Graphical User Interface
	a.  In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
	b. Builder will start processing the batch. 
	c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …
	In the Command Line Interface
	a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.: cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.17
	b. Type bathcbuildercli –a build –p [project_directory_path] –b [batch_directory_name], e.g.:batchbuildercli -a build -p “E:\My Project” -b batch1
	c. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see section 11. Processing Batches Using Command Line Interface.
	d. When the batch is successfully processed you will see the following messages:
	If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message)
	10.3 Build an advanced audio batch (command line)

	This is a description of the procedure to build an advanced audio batch using Batch Builder 2 advanced mode.  Use this method if you plan to deposit audio files along with additional supporting files containing technical and structural metadata about your audio – such as ADL audio decision lists, AES-57 technical metadata files and AES-60 structural files (playlists) for governing audio playback.
	If you do not need to deposit these files with your audio, use the procedures described in sections 10.1 and 10.2 instead. 
	If you want to deposit just audio files and corresponding AES-60 playlists but do not need to deposit any additional technical metadata files, you may do so using the Audio genre and Text genre in Batch Builder GUI. First deposit the audio and then deposit the playlists as a separate Text object batch. See Sections 10.1 and 10.2 for depositing simple audio and Section 9 for depositing Text Object batches for more information.
	Note that BB2 in advanced mode is COMMAND LINE ONLY. Required and optional metadata such as deposit settings, object and file metadata is supplied using special configuration files.
	10.3.1 Command line syntax

	The existing Batch Builder Windows bat and Unix shell scripts are used to launch Batch Builder in advanced mode.  The syntax is:
	 On PC: batchbuildercli –advanced audio –d [object directory path]
	o Use Windows style directory separator ‘\’
	 On Mac or Linux: ./batchbuildersli.sh -advanced audio –d [object directory path]
	o use UNIX style directory separator ‘/’
	Note that by default the object directory name serves as the object Owner Supplied Name (you can override that in audio.properties file).
	Example 1 (Windows):
	   batchbuildercli –advanced audio –d “C:\mybatch\004390909”
	Example 2 (Mac / Linux):
	   ./batchbuildersli.sh -advanced audio -d /mybatch/004390909
	10.3.2 Preparation

	1. Arrange the content so that it has the directory structure shown in Figure 1.
	Figure 1:
	An example directory structure created in preparation for use with Batch Builder. Items highlighted yellow must be named as shown. Other directories can exist in the directory structure but Batch Builder will ignore them. 
	…/my_batch-19a326/
	        my_object-A299ff/
	   audio.properties  -- required
	relationships.csv  -- required if have derivative relationships                  mods.xml -- optional (descriptive metadata for the object)
	archival/ -- required if have archival master files
	                    sub_dir1/
	                              file1.wav
	                              file1.xml [AES57 metadata for file1.wav]
	                               file1.properties [DRS metadata for file1.wav]                                                       
	                               file2.wav
	                               file2.xml [AES57 metadata for file2.wav]
	file2.properties [DRS metadata for file2.wav]  
	                    sub_dir2/
	                               file1.wav
	                               file1.xml [AES 57 metadata for file1.wav]
	          file1.properties [DRS metadata for file1.wav]
	                               file2.wav
	                               file2.xml [AES57 metadata for file2.wav]
	file2.properties [DRS metadata for file2.wav]
	                               sub_dir1.adl [ADL for *.wav files in sub_dir1]
	                               sub_dir2.adl [ADL for *.wav files in sub_dir2]
	      digiprov.xml [process history for object]
	deliverable/
	            performances/ -- required if have deliverable files
	                        file1.mp3
	                        file1.xml [AES57 metadata for file1.mp3]
	file1.properties [DRS metadata for file1.mp3]
	                         file2.mp3
	                         file2.xml [AES57 metadata for file2.mp3]
	file2.properties [DRS metadata for file2.mp3]
	               playlists/ -- required for playlists
	                                             playlist1.xml [AES60 file]
	                                             playlist2.xml [AES60 file]
	     misc/ -- optional
	                       (can contain any # of files in any format)
	    original/ -- optional
	                     audio_object.xml [AES57 metadata for original item]
	    production/ -- required if have production master files
	                      sub_dir1/
	                              file1.wav
	                              file1.xml [AES57 metadata for file1.wav]
	file1.properties [DRS metadata for file1.wav]
	                               file2.wav
	                               file2.xml [AES57 metadata for file2.wav]
	          file2.properties [DRS metadata for file2.wav]
	                         sub_dir2/
	                               file1.wav
	                               file1.xml [AES57 metadata for file1.wav]
	file1.properties [DRS metadata for file1.wav]
	                               file2.wav
	                               file2.xml [AES57 metadata for file2.wav]
	file2.properties [DRS metadata for file2.wav]
	                         sub_dir1.adl [ADL for *.wav files in sub_dir1]
	                         sub_dir2.adl [ADL for *.wav files in sub_dir2]
	    workspace/-- optional
	                                 (can contain any # of files in any format)
	2. Create the required audio.properties configuration file. This contains all required batch and object settings. The format of it must be:
	a. US-ASCII text
	b. Each line in “property=value” format
	c. Lines can be commented out by starting the line with the ‘#’ symbol.
	d. Can’t use reserved XML characters (see the table below for full list).
	The table below lists the properties that can be specified in this file. An example audio.properties file is shown in Figure 2.
	Property
	Valid Values
	Example
	Meaning
	download
	true, false
	dowload=true
	specifies whether deliverable audio can be downloaded or can only be streamed. If dowload=true two delivery URNs will be created for deliverable audio -- one for FDS and one for SDS.
	accessFlag
	one of: P,R,N
	R
	The default access flag to use for this object’s files. Can be overridden by the access flag specified in file level properties files.
	alephID
	a valid Aleph Identifier
	009513791-2
	authorityPath
	a valid NRS authority path
	FHCL.Loeb
	Authority path for any URNs that will be created for this object’s files
	batchName
	100 character limit; Valid values: ASCII alpha-numeric characters,  / "-" / "." / "_" / "~"/
	The  following reserved XML characters should be excluded: 
	gen-delims  = ":" / "/" / "?" / "#" / "[" / "]" / "@"      sub-delims  = "!" / "$" / "&" / "'" / "(" / ")"                  / "*" / "+" / "," / ";" / "=" /
	Valid value examples: Project_137_4a~5.1a
	Batch-123_23yux-a.21
	Invalid values examples:
	batch&&<<>>><!
	project清代盐政与盐稅
	Name for the batch
	billingCode
	a valid DRS billing code
	FHCL.MUSI.MUS_004
	Billing code for the object
	depositAgent
	a valid 8 digit HUID
	xxxxxxxx
	Person depositing the object. 
	objectOSN
	A unique value within the content’s DRS owner code
	A299ff
	Name for the object
	ownerCode
	a valid DRS owner code
	FHCL.MUSI
	Owning unit of the object
	resourcePattern
	an NRS resource pattern, see Section 13.1 Assigning URN Resource Name Patterns
	{n}
	Resource name pattern for any URNs created for this object’s files
	role
	currently no roles for audio object are used
	One or more roles for the object (not likely to be used - included to support future uses)
	failureEmail
	one or more valid email addresses separated by commas
	example1@fas.harvard.edu, example2@fas.harvard.edu  
	People who will be sent failed loader reports
	successEmail
	one or more valid email addresses separated by commas
	example1@fas.harvard.edu, example2@fas.harvard.edu
	People who will be sent successful loader reports
	successMethod
	one of: EMAIL, DROPBOX, ALL
	EMAIL
	Distribution method for the loader reports
	Figure 2: an example audio.properties file
	#properties for the object
	alephID=009513791
	authorityPath=FHCL.Loeb
	batchName=Project_137_4a
	billingCode= FHCL.MUSI.MUS_004
	depositAgent=12345678
	failureEmail=example1@fas.harvard.edu,example2@fas.harvard.edu
	objectOSN= A299ff
	ownerCode=FHCL.MUSI
	resourcePattern={n}
	successEmail=example1@fas.harvard.edu,example2@fas.harvard.edu
	successMethod=EMAIL
	Place the audio.properties file at the same file system level as the object directory, e.g.:
	…/my_batch-19a326/
	  my_object-A299ff/ 
	  audio.properties
	3. Create a relationships file. This must be a comma-separated file named relationships.csv, supplying relationships between files in the object, and/or between this object and DRS objects, and/or between files in this object and DRS files or objects. The format must be:
	source,relationship_name,target_type,target
	where
	o source:
	 for files in this object: relative path to the source file from the object directory
	 for this object: the word object#
	o relationship_name, one of:
	 HAS_SOURCE (indicates derivative relationships between files in this object)
	 HAS_DOCUMENTATION (for pointing from files or the object to DRS-stored documentation files or objects)
	 HAS_METHODOLOGY (for pointing from the object to a DRS-stored methodology object)
	 HAS_RIGHTS (for pointing from files or the object to DRS-stored rights files or objects)
	o target_type, one of:
	 RELATIVE_PATH (used for a relative file path)
	 HUL_DRS_OBJECT_URN# (used for the URN of a DRS object)
	■ For example: urn-3:HUL.DRS.OBJECT:175616
	■ These are persistent IDs new to DRS2 given to all objects that always have a HUL.DRS.OBJECT authority path
	 OBJECT_OSN# (used for the owner supplied name of a DRS object having the same owner code as this object)  Note that the object ingest service needs to be updated to support handing relationships using OBJECT_OSN
	 We also support HUL_DRS_OBJECT_ORACLE and HUL_DRS_FILE_ORACLE target_type values
	o target: relative path to a file, DRS object URN or DRS object owner supplied name#
	Lines can be commented out by starting the line with the ‘#’ symbol
	Figure 3: an example relationships.csv file (the paths need to be in the form supported by the OS you are running Batch Builder on) 
	# Derivative audio content relationships
	deliverable\performances\file1.mp3,HAS_SOURCE,RELATIVE_PATH,production\sub_dir1\file1.wav
	deliverable\performances\file2.mp3,HAS_SOURCE, RELATIVE_PATH,production\sub_dir1\file1.wav
	deliverable\performances\file3.mp3,HAS_SOURCE, RELATIVE_PATH,production\sub_dir1\file2.wav
	deliverable\performances\file4.mp3,HAS_SOURCE, RELATIVE_PATH,production\sub_dir1\file2.wav
	Place this file at the same file system level as the object directory, e.g.:
	…/my_batch-19a326/
	  my_object-A299ff/
	  audio.properties
	  relationships.csv
	Note that the following relationships are automatically determined by Batch Builder and should not be listed in the relationships.csv file:
	 HAS_DOCUMENTATION relationships between audio files and audio decision lists deposited at the same time
	 HAS_PRESENTATION relationships between audio deliverable files and AES60 playlist objects deposited at the same time.
	4. If manually supplying descriptive metadata, create a MODS file called mods.xml complying with MODS schema versions 3.4 or earlier#.  See http://www.loc.gov/standards/mods/ for more information about MODS metadata and schemas.
	Place this file at the same file system level as the object directory, e.g.:
	…/my_batch-19a326/
	  my_object-A299ff/
	  audio.properties
	  mods.xml
	  relationships.csv
	Note that as an alternative to supplying a MODS file, descriptive metadata can be imported from Aleph by Batch Builder by providing an Aleph ID in the audio.properties file (See Figure 2).
	5. Optionally provide technical metadata for files in the batch in the AES57 format.
	These files should be named the same as the files they describe, except with an xml file extension. For example in Figure 1 on page 1 of this document, the file at
	my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.xml
	contains technical metadata for the file at
	my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.wav
	Batch Builder will read in and use the technical metadata supplied by these files but will supplement it with format metadata supplied by FITS (see http://fits.googlecode.com).
	6. Optionally provide properties files for files in the batch to override Batch Builder-configured metadata values. These files can contain any file-level batch Builder properties shown in the Table below.
	Property
	Valid values
	Example
	Meaning
	accessFlag
	one of: P,R,N
	P
	Access level of file
	adminCategory# -- done
	A comma-delimited list of one or more Wordshack URIs – You can alternatively use the same string formatting used in the BB GUI
	http://id.lib.harvard.edu/wordshack/adminCategory/12345
	Administrative categories to associate with the file
	fileosn
	34561-a7-bach
	Name for the file (not necessarily unique)
	isFirstGenerationInDrs
	one of: yes, no, unspecified
	yes
	whether or not the file is the closest version in the DRS to the original capture or creation
	isPreferredDeliverableSource
	one of: yes, no, unspecified
	yes
	whether or not the file is the recommended file to use for generating future deliverables
	processing
	comma-delimited list of one or more of:CROPPEDBIT_REDUCEDBRIGHTNESS_ADJUSTEDCOLOR_CORRECTEDCONTRAST_ADJUSTEDDENOISEDDESKEWEDDOWN_MIXEDDYNAMIC_RANGE_COMPRESSEDEQUALIZEDGAMMA_CORRECTEDLEVEL_ADJUSTEDPHASE_INVERTEDPROCESSED
	SAMPLERATE_CONVERTEDSHARPENED
	BIT_REDUCED, DENOISED
	Key actions taken on the file before it was deposited to the DRS
	quality
	one of: 1, 2, 3, 4, 5, 6, 7, 8, 9, 10
	5
	Locally-defined measure of quality
	usageClass
	One of: HIGHUSE, LOWUSE
	LOWUSE
	Estimate of how frequently the file will be accessed by library users
	methodology
	(any text)
	Notes about the methods performed and/or tools used in the creation, processing or preparation of the content prior to DRS deposit
	role
	comma-delimited list of one or more of#:ARCHIVAL_MASTER,CONTAINER,DELIVERABLE,DOCUMENTATION,LICENSE,LOG,ORIGINAL_ORDER,PAGE_COORDINATES,PAGE_IMAGE,PAGE_TEXT,PRODUCTION_MASTER,STYLE_SHEET,TARGET_DESCRIPTION,TARGET_IMAGE,THUMBNAIL,AUDIO_DECISION_LIST,PROCESS_FILES,PROCESS_HISTORY
	DELIVERABLE
	downloadProhibited
	(for audio files)
	yes
	yes
	Audio file must be streamed - direct download will not be permitted
	downloadProhibitedBasis
	(for audio files)
	one of: Harvard policy, license, statute, Risk assessment
	license
	Basis for the restrictions or terms of use
	downloadProhibitedLicense
	(for audio files)
	DRS object URN of the license object
	urn-3:HUL.DRS.OBJECT:197548
	ID of the documentation within the DRS, e.g. a deposited donor agreement
	downloadProhibitedLicenseTerms
	(for audio files)
	(any text)
	90 year policy
	A note about the documentation, e.g. the applicable section
	downloadProhibitedGrantStart
	(for audio files)
	A date/timestamp
	yyyy-mm-dd
	yyyy-mm
	yyyy
	schema date  and schema dateTime formats
	Embargo start date
	downloadProhibitedGrantEnd
	(for audio files)
	A date/timestamp
	yyyy-mm-dd
	yyyy-mm
	yyyy
	schema date  and schema dateTime formats
	Embargo end date
	Note that because of the way the support for PREMIS rights is implemented in the advanced workflow properties files, you can also set object level embargo and secure storage rights in the audio.properties files.  You just need to use the appropriate property names.
	These files should be named the same as the files they describe, except with a properties file extension. For example the file at
	my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.properties
	would contains metadata for the file at
	my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.wav
	10.3.3 Batch Builder Execution

	The syntax is:
	./batchbuildercli.sh -advanced audio -d path-to-object-directory
	where the path-to-object-directory is a relative or absolute path to the directory containing the content needed to build a single audio object.
	For example:
	./batchbuildercli.sh -advanced audio -d /home/prod/content/my_batch-19a326/obj-994533
	The program will:
	 Create a directory at workspace/moved_content
	 Put a copy of the files that were in the misc directory in the workspace/moved_content directory
	 Zip up the contents of the misc directory and name it misc_files.zip
	 Create the object descriptor for the audio content
	o The AES57 file at original/?.xml will be interpreted as technical metadata for the original item to be stored in a <sourceMD> element in the descriptor
	o If any AES60 files were included in the playlist directory:
	o Build separate Text objects for each playlist
	 The file name# will be used as the object owner-supplied-name
	 Create the object descriptor for each object
	 The descriptor will be named {object-OSN}_descriptor.xml and will be written to the batch directory
	 (Relationships between the playlist object and audio deliverable files will be automatically created by the DRS Loader.)
	After executing Batch Builder the following changes should be visible in the batch directory:
	…/my_batch-19a326/
	  batch.xml [DRS batch loading file]
	  descriptor.xml [object descriptor for the audio object]
	  my_object-A299ff/
	    misc/
	      misc_files.zip [the files that were in the misc directory]
	    workspace/
	         moved_content/ [will contain the content that was in  the misc directory]
	playlist1-A299ff_descriptor.xml [object descriptor for the playlist object containing playlist1-   A299ff.xml]
	playlist2-A299ff_descriptor.xml [object descriptor for the playlist object containing playlist2-A299ff.xml]
	10.3.4 Depositing to the DRS

	After executing the script, copy the following portion of the directory structure to your DRS dropbox.
	…/my_batch-19a326/ [example batch directory]
	  batch.xml
	  descriptor.xml
	  my_object-A299ff/ [example object directory]
	    archival/
	    deliverable/ 
	    misc/ 
	    original/
	    production/
	  playlist1-A299ff_descriptor.xml [example descriptor for a playlist object]
	  playlist2-A299ff_descriptor.xml [example descriptor for a playlist object]
	The DRS loader will not automatically delete any files or directories that are uploaded to a dropbox but that aren’t referenced in the object descriptors. These files and directories should be filtered out as part of the transfer process; otherwise they will need to be manually deleted from the dropbox. These include:
	 Any other subdirectories in the object directory (e.g. pre-archival, workspace)
	 Properties files (audio.properties)
	 AES57 files used to indicate metadata for the original item or for audio content files (*.xml)
	 MODS file (mods.xml)
	 Relationships file (relationships.csv)
	Notes
	 Object owner-supplied-names (Object OSNs)
	o Object OSNs are required in DRS 2 and must be unique within a DRS owner code.  Please keep that in mind when explicitly assigning objects names, for example in the audio.properties file; or implicitly for example, by the file names of the AES60 playlists.
	 URNs
	o An object-level URN is automatically given to all objects.
	 These URNs will have a HUL.DRS.OBJECT authority path, e.g. urn-3:HUL.DRS.OBJECT:175844
	o File-level URNs are automatically given to files with the role DELIVERABLE.
	 These URNs will have a local authority path, e.g. urn-3:FHCL.Loeb.Faids:mus00023
	11. Processing Batches Using Command Line Interface
	11.1 Basic command line syntax11.2 Switches11.3 Deposit settings properties11.4 Object properties11.5 Directory properties
	The Batch Builder 2 installation package includes a command line interface tool (CLI) designed for automated deposit workflows that performs three actions:
	 build: build the descriptors and batch.xml for a specified batch within a specified project using batch, object and directory level property values supplied on command line or/and  in the Graphical User Interface (GUI).
	 templatedirs: rebuild the directories in the object template from the information in the project configuration file .
	 buildtemplate: Create a new batch with objects from template in the specified project.
	CLI should be used in conjunction with the GUI. For instance, a depositor can use the Batch Builder GUI to build the initial project, and then use the command line to substitute batch-level, object-level and directory level metadata values when processing batches of objects. 
	CLI On-screen Help. To see on-screen help while in CLI type:
	batchbuildercli –h to display only example usage
	batchbuildercli –fullhelp to display example usage and a list of all overridable batch, object and directory properties
	11.1 Basic command line syntax

	Please note that on computers running Microsoft Windows XP or later, the maximum length of the string that you can use at the command prompt is 8191 characters. 
	-a actions:  templatedirs, buildtemplate, build.
	11.2 Switches

	-a [action] –required – accepts three actions: templatedirs, buildtemplate, and build. 
	 templatedirs: rebuild the directories in the object template from the information in the project configuration file .
	 buildtemplate: Create a new batch with objects from template in the specified project.
	 build: build the descriptors and batch.xml for a specified batch within a specified project using batch, object and directory level property values supplied on command line or/and  in the Graphical User Interface (GUI).
	-p [project directory path]   – required – indicates the path to the project directory on disk.  This path must be created in Batch Builder GUI before using the command line option.  The project path cannot be created while executing this command.  If path does not already exist the action will fail.
	-b [batch_name]   –  required for actions buildtemplate and build – name of batch directory.  When using buildtemplate action BB2 will create a new batch directory with the name specified by the –b switch, e.g.: batchbuildecli –a buildtemplate –p c:\myproject\ -b new_batch_directory_name. When using the build action, BB2 will process the existing batch directory specified by the –b switch, e.g.: batchbuildecli –a build –p c:\myproject\ -b existing_batch_directory_name.
	-aleph [object_name1]=[alephID];[ object_name2]=[alephID] etc.   – optional – system number of corresponding record in ALEPH.  Batch Builder uses this number to pull metadata from the corresponding ALEPH record into the MODS section of the object descriptor. This switch can be used with action build. Example: 
	-aleph obj1=12345;obj2=67890
	Note that no other methods of entering aleph id or MODS should be used for the batch if this switch is invoked – such as mapping files with ALEPH IDs, user supplied MODS files, descriptive metadata entered in the GUI or ALEPH IDs supplied in the GUI – otherwise BB will throw an error or silently fail to write the new ALEPH ID into the descriptor.
	-batchprop [property=value,property=value,property=value...] – optional – overrides specified project deposit settings for a given batch. The -batchprop argument must be wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should be separated by a comma ‘,’. Repeatable batch property values should be as property=value pairs separated by a comma – e.g.:  
	- batchprop “successEmail=success1@example.com,successEmail=success2@example.com”
	-objectprop [object_name::property=value,property=value;...] – optional – overrides specified object metadata properties for given objects. The -objectprop argument must be wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should be separated by a comma ‘,’. 
	-dirprop [object_name::directory_path::property=value,property=value;...] – optional – overrides specified file metadata property values for given files. The -dirprop argument must be wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should be separated by a comma ‘,’. 
	11.3 Deposit settings properties (batch properties)

	Syntax: -batchprop property=value,property=value,property=value...
	 projectName -- substitutes passed string for the existing BB project name
	 batchName – substitutes passed string for the default batch name (not the batch directory name )
	E.g.: -batchprop batchName=mybatch
	E.g.: - batchprop batchName={depositAgent}{batchDir}{ss}
	 successEmail – substitutes passed string for success email(s) (emails should be separated by comma without any blank space in between)
	E.g.: - batchprop successEmail=myname@example.com,myname2@example2.com
	 failureEmail – substitutes passed string for failure email(s)
	E.g.: - batchprop failureEmail=myname@example.com,myname2@example2.com
	 successMethod - substitutes passed string for the successMethod specified in deposit settings panel in the GUI. The options are email, all, dropbox.
	E.g.: - batchprop successMethod=email
	 depositAgent - substitutes passed string for the deposit agent HUID specified in deposit settings panel
	E.g.: - batchprop depositAgent=12345678
	Example: 
	11.4 Object properties

	Syntax: -objectprop object_name1::property=value,property=value;object_name2::property=value,property=value; etc.
	List of overridable object properties

	Property Name
	Definition
	ownerCode
	DRS Owner Code
	billingCode
	DRS Billing Code
	accessFlag
	DRS Access Flag
	adminCategory
	Administrative Category ID (can be looked up in Word Shack by searching for Admin Category display value
	captionBehavior
	IDS / PDS Caption Behavior
	captionUnitName
	IDS / PDS Caption Unit Name
	captionDescription
	IDS / PDS Caption Description
	metsLabel
	METS Label display value (currently displays in citation label of PDS Document objects)
	methodology
	Object methodology
	nonPublicNote
	Value for the non-public note field
	processingLevel
	Object processing level
	producer
	Object producer – controlled value from Word Shack
	relatedLinks
	Related links values – displays in PDS
	harvardMetadataLinks
	Harvard metadata links values – displays in PDS
	viewText
	viewText option – affects display of text in PDS
	secureStorage
	Rights Metadata – not yet implemented. Expected in Production Release 2.
	secureStorageBasis
	Rights Metadata – not yet implemented.
	Expected in Production Release 2.
	secureStorageLicense
	Rights Metadata – not yet implemented.
	Expected in Production Release 2.
	secureStorageLicenseTerms
	Rights Metadata – not yet implemented.
	Expected in Production Release 2.
	secureStorageGrantEnd
	Rights Metadata – not yet implemented.
	Expected in Production Release 2.
	embargoDuration
	Embargo duration value in days, months or years
	embargoBasis
	One of the controlled values:  
	 Harvard policy
	 license
	 risk assessment
	 statute
	 copyright
	embargoLicense
	URN of the DRS license object – corresponds to BB GUI field Documentation
	embargoLicenseTerms
	Corresponds to BB GUI field Documentation Note
	embargoGrantStart
	Corresponds to BB GUI field Start Date
	embargoGrantEnd
	Corresponds to BB GUI field End Date
	harvardPolicy
	URN of an existing Harvard policy object in DRS
	license
	URN of an existing license object in DRS
	statute
	URN of an existing statute object in DRS
	titleInfoType
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoTitle
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoSubTitle
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoPartNumber
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoPartName
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoNonSort
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoType2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoTitle2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoSubTitle2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoPartNumber2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoPartName2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	titleInfoNonSort2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameType
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameAuthority
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameNamePart
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameNamePartType
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameDisplayForm
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameAffiliation
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameRoleTerm
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameDescription
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameType2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameAuthority2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameNamePart2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameNamePartType2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameDisplayForm2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameAffiliation2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameRoleTerm2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameDescription2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameType3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameAuthority3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameNamePart3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameNamePartType3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameDisplayForm3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameAffiliation3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameRoleTerm3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	nameDescription3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	typeOfResource
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	typeOfResourceCollection
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	typeOfResourceManuscript
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	genre
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoPlaceTerm
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoPublisher
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoDateIssued
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoDateCreated
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoDateCaptured
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoDateValid
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoDateModified
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoCopyrightDate
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoDateOther
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	originInfoEdition
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	languageTerm
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	physicalDescriptionReformattingQuality
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	physicalDescriptionDigitalOrigin
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	abstract
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	tableOfContents
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	classification
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	identifier
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	identifierType
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	identifier2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	identifierType2
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	identifier3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	identifierType3
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	ccessCondition
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	accessConditionDisplayLabel
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	accessConditionType
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	recordInfoRecordIdentifier
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	recordInfoSource
	MODS Metadata – see http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html for more information
	has_documentation
	Object URN of a related Documentation object in DRS
	Has_methodology
	Object URN of a related Methodology object in DRS
	urnAuthorityPath
	URN Authority Path
	resourceNamePattern
	Resource Name Pattern for a URN
	role
	Object role
	Example 1: 
	Example 2: 
	11.5 Directory (file) properties

	Syntax: -dirprop “object1::directory_path1::property=value,property=value;object1::directory_path2::property=value,property=value;object2::directory_path1::property=value,property=value” ... etc.
	List of overridable directory properties

	Property Name
	Definition
	accessFlag
	File DRS Access Flag
	adminCategory
	Administrative Category ID (can be looked up in Word Shack by searching for Admin Category display value)
	adminFlag
	Adminstrative Flag
	adminFlagNote
	Administrative Flag Note
	isFirstGenerationInDrs
	Is first generation in DRS
	isPreferredDeliverableSource
	Is preffered deliverable source (for future reformatting purposes)
	nonPublicNote
	Value for the non-public note field
	processing
	Processing
	producer
	Object producer – controlled value from Word Shack
	quality
	Quality
	usageClass
	Usage Class
	methodology
	File Methodology
	processingNote
	Processing Note (Text files)
	encodingAgent
	Encoding Agent (Text files)
	encodingRole
	Encoding Role (Text files)
	language
	Language (Text files)
	disposition
	Audio Metadata
	useType
	Audio Metadata
	leftRightPanMap
	Audio Metadata
	frontRearPanMap
	Audio Metadata
	role
	Role
	has_target
	Has target in DRS
	has_color_profile
	Has color profile in DRS
	has_world_reference_data
	Has world location in DRS
	has_documentation
	Has documentation in DRS
	has_subset
	Has subset files in DRS
	has_presentation
	Has a playlist in DRS (Audio only)
	maxPixelDimension
	IDS restriction on delivery size for JP2 images in pixels
	maxPixelBasis
	One of the controlled values:  
	 Harvard policy
	 license
	 risk assessment
	 statute
	 copyright 
	maxPixelLicense
	URN of the DRS license object – corresponds to BB GUI field Documentation
	maxPixelLicenseTerms
	Corresponds to BB GUI field Documentation Note
	downloadProhibited
	Prohibits delivery of audio as downloadable file. Audio will only be delivered as streaming
	downloadProhibitedBasis
	One of the controlled values:  
	 Harvard policy
	 license
	 risk assessment
	 statute
	 copyright
	downloadProhibitedLicense
	URN of the DRS license object – corresponds to BB GUI field Documentation
	downloadProhibitedLicenseTerms
	Corresponds to BB GUI field Documentation Note
	harvardPolicy
	Object URN of related Harvard policy object in DRS
	license
	Object URN of related license object in DRS
	statute
	Object URN of related statute object in DRS
	idsDeliverableURNs
	Additional IDS URNs for individual images within a PDS Document object
	See the DRS 2 Metadata Reference document on the DRS 2 iSite for more detailed descriptions of the substituted properties. See Adding Relationships section for more details definitions of substituted relationship values.
	Example 1: 
	12. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs.
	12.1 Using mapping.txt file12.2 Using object_mapping.txt file
	Batch Builder can use external mapping files to:
	1. Associate Owner Supplied Names with existing files and new (to be built automatically by BB) objects (mapping.txt)
	2. Associate Aleph IDs with new (to be built automatically by BB) objects (mapping.txt)
	3. Determine page sequence numbers for PDS Document objects (mapping.txt)
	4. Associate Aleph IDs with existing objects (object_mapping.txt)
	5. Associate Owner Supplied Names with existing objects (object_mapping.txt)
	Mapping files can be used in two ways:
	 To interact with files and objects during automatic object building from template.
	 To interact with files and objects during batch processing.
	Batch Builder will display an INFO message in the message panel when any of the auxiliary input files are discovered, e.g.:
	12.1 Using mapping.txt file
	Rules for using mapping.txt file


	File name: mapping.txt
	Function: 
	 Objects that are built by BB automatically from template will inherit the following property values specified in this file: File Owner Supplied Name, PDS Document sequence number, Object Owner Supplied Name and Aleph ID.
	 Objects that are created manually will inherit the following property values specified in this file: File Owner Supplied Name, PDS Document sequence number.
	Placement: 
	 For use during automatic object building, place the file in the {project_dir}/_aux/template/ directory
	When used with the automatic object building function the file will be automatically copied to {project_dir}/_aux/{batch_name}/{object_name}/ for each object created.
	 For use during manual object building, place the file in the {project_dir}/_aux/{batch_name}/{object_name}/ directory
	Syntax: relative_file_path,file_OwnerSuppliedName,PDS_sequence number(optional),object_OwnerSuppliedName(optional), AlephNumber(optional) 
	E.g.:
	Notes on syntax: There should be no spaces between a comma “,” and the next character. If an optional element value is skipped it still needs to be designated by a comma “,” so Batch Builder can associate the right value with the right element. E.g.: 
	 Relative file path: the relative path to the file (including the file name and extension), from either the _aux/{batch}/{object}, or _aux/template directory. This is the file that the next 3 parameters will be applied to.
	 File Owner Supplied Name: (Required) - The file owner supplied name
	 Sequence number: (Optional) - Alternate method to providing the sequence number as part of the file name pattern. This controls in which order page images and text appear in PDS Document objects when they are displayed in PDS.
	 Object Owner Supplied Name: (Optional) - When the object Owner Supplied Name is not provided as part of the file name pattern, then this property can be used to control which files are added to which objects when building objects from the template. This parameter is ignored when the mapping.txt file is placed directly into _aux/{batch}/{object}/ directory for a manually created object. 
	 Aleph ID (Optional) - Aleph ID of the HOLLIS record where the object is described. Batch Builder imports MODS descriptive metadata from the HOLLIS record specified and places it into the object descriptor during batch processing. 
	Note that there are multiple methods of passing a MODS descriptive metadata file to Batch Builder. Only one method at a time can be used. 
	Procedure for creating and placing a mapping file

	Create the mapping file:
	1. Create a text file called "mapping.txt".  If your batch contains multiple objects, file mappings for all objects can go in this one file.
	2. Add a line of mapping values for every file to be mapped, using the syntax:  
	relative_file_path,file_OSN,PDS_sequence_number(optional),object_OSN(optional),AlephID (optional)
	Example that maps file OSN only:
	image-archivalmaster\379129.tif,ac1234,,,image-archivalmaster\image-deliverable\379129.jpg,ac5678,,,
	3. Save the mapping.txt file.  
	Add the mapping file to the batch:
	1. If using the manual object workflow:
	a. Create the batch with objects (Step 5 in the batch procedure).  This will generate batch directory structure on disk. 
	b. Copy mapping.txt into the object directory inside the BB project's auxiliary (_aux) path: 
	{project_dir}/_aux/{batch_name}/{object_name}/
	If you have file mappings for multiple objects in a batch, place a copy of the same file into each corresponding object directory inside the BB project's auxiliary (_aux) path.
	c. Continue with your batch procedure.
	2. If using the automatic object workflow:
	a. Add directories to the template and copy content files into those directories (Steps 4-5 in the batch procedure).
	b. Place mapping.txt into the template directory in the BB project's auxiliary (_aux) path:
	{project_dir}/_aux/template/
	c. Continue with your batch procedure.
	3. When BB processes the batch, an INFO message displays in the message panel when the mapping file is discovered, for example:
	INFO   - found mapping.txt in C:\drs2-beta2-training-BB\BB2-projects-2.0.19o\image-project\_aux\batch-brueghel-skaters-3\object-skaters-3
	12.2 Using object_mapping.txt file

	File Name: object_mapping.txt
	Function: The objects contained in the batches processed by Batch Builder will inherit the property values (such as Aleph IDs and object owner supplied names) specified in the file (note that this file is not used for automatic object building).  This file is accessed by Batch Builder during batch processing (generating the batch/xml file and the descriptor).
	Placement: There is one object_mapping.txt file per project. It needs to be placed in {project_dir}/_aux/template/ directory. It is read in once when the project is opened. If you created and placed the file while BB was open, you will need to restart BB so that the file can be accessed during batch processing.
	Syntax: object_directory_name,ALEPH_number,Object_Owner_Supplied_Name
	 Object directory name: (Required) - The name of the directory in which object is contained. E.g.: birdsofasia
	 Aleph id: (Optional) - Aleph ID of the HOLLIS record where the object is described. Batch Builder imports MODS descriptive metadata from the HOLLIS record specified and places it into the object descriptor during batch processing. 
	 Note that there are multiple methods of passing a MODS descriptive metadata file to Batch Builder. Only one method at a time can be used. 
	 Object Owner Supplied Name: (Optional) - This property can be used to override the object Owner Supplied Name that is normally derived from object directory name. It will be applied to the object specified by in the object directory name property.
	Example 1 (specifying object directory name and aleph ID):
	birdsofasia,005111819,
	brighambulletin,006659177,
	The extra comma at the end represents the blank value for object owner supplied name. It is required even if object owner supplied name is not specified.
	Example 2 (specifying object directory name, aleph ID and object owner supplied name):
	birdsofasia,005111819,BA_2348
	brighambulletin,006659177,BA_35559
	In this example all three values are specified. 
	Example 3 (specifying object directory name and object owner supplied name):
	birdsofasia,,BA_2348
	brighambulletin,,BA_35559
	13. Working with URNs
	13.1 Assigning URN resource name patterns13.2 Using URNs
	Batch Builder by default requests public delivery service URNs for deliverable files of still image objects, document objects and text objects. For PDS document objects a public delivery URN is requested for the object itself rather than for a particular file within the object. For opaque objects no public delivery URNs are requested. 
	URN authority path and URN resource name pattern values can be entered in the required settings panel for each object or in the object template required setting panel (in which case the settings will propagate to all objects created from the template). 
	/
	Required settings panel – NRS section
	13.1 Assigning URN resource name patterns

	The resource name component of the URN must be unique relative to the authority path.  Batch Builder can generate all or part of the resource name automatically using mask fields that will be replaced with actual values by the system (shown in the table below). 
	Resource names can be composed of alpha-numeric characters (upper and lower case, although all NRS comparisons are case-insensitive) and the following punctuation characters:
	Batch Builder will use {n} as the default resource name mask field ({n} resolves to a unique number).  However, Batch Builder supports additional resource name patterns that are described below.
	URN resource name pattern fields
	Field
	Replacement Value
	Meaning
	01 to 31
	Day of the month
	01 to 24
	Current hour of day
	00 to 59
	Current minute of hour
	01 to 12
	Current month of year
	00 to 59
	Current second of hour
	1999 to 9999
	Current year
	{n}
	0 to 10 to the 27th power
	Unique numeric value
	{fileBaseName}
	Name of the file excluding the file extension
	Base name of file. Note that this mask works only in BB. It does not work if assigning URNs to existing objects in Web Admin
	Here are examples of URN masks and the resulting resource name:
	urn-3:dig:{n}   -->   urn-3:dig:75 
	urn-3:FAL:{yyyy}-{n}   -->    urn-3:FAL:1999-76 
	urn-3:HCL-DIG:{yyyy}{mo}{dd}   -->   urn-3:HCL-DIG:20000103 (unique only for one file on any given day) 
	urn-3:HCL-DIG:{yyyy}{mo}{dd}{n}   -->   urn-3:HCL-DIG:200001032 (always unique) 
	13.2 Using URNs

	Each URN assigned by NRS has the form:
	   urn-3:{authorityPath}:{resourceName}   urn-3:RAD.SCHL:1081404
	where ”urn-3” is the Harvard namespace identifier, {authorityPath} is the NRS authority path corresponding to the organizational unit responsible for the URN, and {resourceName} is the unique identifier for the digital file.  
	To make a URN actionable (usable in a browser) for DRS 2 test objects, you must append it to an NRS URL (http://nrstest.harvard.edu:9031/).  The full working URL for the example URN above would be:
	http://nrstest.harvard.edu:9031/urn-3:HUL.Guest:152824 
	 New URNs are passed to the NRS name resolution server for activation. A URN requested during DRS2 batch deposit should become active within 15 minutes of successful batch deposit. 
	14. Adding Relationships
	14.1 Image relationships14.2 PDS Document object relationships14.3 Opaque object relationships14.4 Document (PDF) object relationships14.5 Text object relationships14.6  Audio object relationships
	DRS models relationships between files and objects. Relationships can indicate derivative relationships between object files, how an object is structured, or associations between content. 
	Derivative relationships and structural relationships are automatically determined by Batch Builder based on placement of files in particular directories and on file names. Other relationships must be explicitly set by depositors, especially relationships between objects or files being processed in Batch Builder to objects or files already stored in the DRS. 
	Below is a list of relationships Batch Builder can create for the six content models it currently supports.
	14.1 Still image object relationships
	File-to-file


	HAS SOURCE -- relationships between derivative images. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.
	HAS SUBSET FILE – file is the source of relationship to another file that is part of a stitched image. A DRS ID or a DRS URN of the related subset file needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	File-to-object

	HAS COLOR PROFILE OBJECT – file has an associated color profile object in the DRS. A DRS ID or a DRS URN of the color profile object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Color Profile Content Model is not supported by Batch Builder 2 yet).
	HAS TARGET OBJECT – file has an associated target object in the DRS. A DRS ID or a DRS URN of the target image object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Target Image Content Model is not supported by Batch Builder 2 yet).HAS WORLD REFERENCE OBJECT – file has an associated world file object in the DRS (for GIS objects). A DRS ID or a DRS URN of the world file object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	Object-to-object

	HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 
	14.2 PDS document object relationships
	File-to-file


	HAS SOURCE -- relationships between derivative images. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.
	File-to-object

	HAS COLOR PROFILE OBJECT – file has an associated color profile object in the DRS. A DRS ID or a DRS URN of the color profile object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Color Profile Content Model is not supported by Batch Builder 2 yet).
	HAS TARGET OBJECT  – file has an associated target object in the DRS. A DRS ID or a DRS URN of the target image object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Target Image Content Model is not supported by Batch Builder 2 yet)
	HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	Object-to-object

	HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	14.3 Opaque object relationships
	File-to-object


	HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	Object-to-object

	HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT– object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	14.4 Document (PDF) object relationships
	File-to-file


	HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.
	File-to-object

	HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	Object-to-object

	HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 
	14.5 Text object relationships
	File-to-file


	HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.
	File-to-object

	HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	Object-to-object

	HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 
	14.6 Audio object relationships
	File-to-file


	HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.
	File-to-object

	HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	Object-to-object

	HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS HARVARD POLICY – object  has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS STATUTE – object  has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
	HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. 
	15. Adding Descriptive Metadata
	15.1 Importing an Aleph record15.2 Entering data in the GUI15.3 Importing from a MODS file
	In DRS 2 descriptive metadata can be added to an object. It is stored in the object descriptor file. There are three ways to add descriptive metadata: 
	1. Have Batch Builder import descriptive metadata from an existing ALEPH record.
	2. Enter descriptive metadata in the Batch Builder GUI.
	3. Import descriptive metadata from a MODS file.
	15.1 Importing an Aleph record

	Batch Builder provides three ways of importing descriptive metadata from an existing ALEPH record:
	1. Specify Aleph ID in a mapping file (see Section 12: Using External Mapping Files for more information)
	2. Specify Aleph ID on command line (see Section 11: Processing Batches Using Command Line Interface for more information)
	3. Enter Aleph ID in Batch Builder GUI (either in object template metadata or in object metadata). This option is described below.
	To enter Aleph ID in Batch Builder GUI:
	1. Obtain the Aleph ID of the record 
	2. In BB select the object template or the object in the Project Panel on the left
	(Optional shortcut) Note that if you are selecting an object, you can right click on the object and choose “Set Aleph ID” from the right click context menu. A data entry box will pop up where you can enter the Aleph ID (this doesn’t work if you are selecting object template). You can then skip steps 3 and 4 below.
	/
	3. Switch to Optional tab in the Content Panel on the right
	4. Enter the Aleph ID into the field “Aleph ID for MODS import.” 
	/
	Note that Aleph ID is not repeatable. Save the project before processing the batch (so that the new information is written into the BB2 configuration file).
	Once the batch is processed the descriptive metadata for the object will end up in the MODS section of the object descriptor. Make sure that no other methods of entering descriptive metadata are used at the same time (e.g.: there is no MODS file as well or there is no descriptive metadata also entered in the Object Metadata fields in the BB GUI) or you will receive an error while processing a batch.
	15.2 Entering descriptive metadata in the BB GUI

	You can enter descriptive metadata directly in the BB GUI in the Object Metadata section in the Content panel. 
	In BB select the object in the Project Panel on the left; switch to Optional tab in the Content Panel on the right, and enter the descriptive metadata into the fields in the Object Metadata section. The descriptive metadata is expected in MODS 3.4 format and the fields in the GUI follow MODS 3.4. 
	You can look up MODS 3.3 fields definitions at: http://www.loc.gov/standards/mods/userguide/generalapp.html 
	15.3 Importing descriptive metadata from a MODS file 
	Rules for importing a MODS file


	Descriptive metadata for an object can be imported from a locally supplied MODS file. BB expects the MODS to be valid MODS 3.4 XML. There should be one MODS XML file per object being described. Descriptions of multiple objects cannot be supplied in the same MODS file. Each MODS file can contain only one set of descriptive metadata for an object – e.g.: a collection-level record and an object-lelel record cannot be part of the same MODS file for the same object.
	File Name: {obj_name}_mods.xml – where {obj_name} is OSN.
	Format: Valid MODS version 3.4 XML file
	Placement: 
	For use while automatically creating a batch place the file in {project_dir}/_aux/template/ directory. 
	Note that the file placed into {project_dir}/_aux/template/ directory will be moved to the corresponding _aux directory for the object (_aux/{batch_name}/{object_name}) after the object batch is built. The MODS file will be accessed by BB during batch processing (when batch.xml and object descriptor is created).
	For use during with manually creating a batch place the file in {project_dir}/_aux/{batch_name}/{object_name}/ directory
	The MODS file will be accessed by BB during batch processing (when batch.xml and object descriptor is created).
	Examples of valid MODS 3.4 XML file
	http://www.loc.gov/standards/mods/mods-guidance.html 
	Procedure for importing a MODS file
	Extracting MODS from HOLLIS or VIA using PRESTO


	If there is cataloging for an object in HOLLIS or VIA, you can use PRESTO to extract a MODS version of the record.  Since metadata extracted with PRESTO conforms to MODS version 3.4, the MODS file will be accepted as-is by the DRS2 batch loader without additional changes.  
	1. Identify the ID of the record you want to extract.  
	2. Construct a PRESTO request url for the record:
	For HOLLIS: http://webservices.lib.harvard.edu/rest/mods/hollis/{record_id_goes_here}
	For VIA: http://webservices.lib.harvard.edu/rest/mods/via/{record_id_goes_here}
	3. Paste the PRESTO request url into a browser.  The MODS XML file for the record will display.  If you don't see the XML, view source.
	4. Use the browser's "Save As" option to save the xml file to a local directory.
	5. Before using the file in Batch Builder, you must rename it to "{obj_name}_mods.xml" – where {obj_name} is the object's owner supplied name (OSN).
	Note about VIA:  A PRESTO request for VIA will return the record with all components (e.g., a work plus all surrogates).  Typically, what you need for object-level description in DRS2 is an individual surrogate description.  Before inserting a VIA MODS file into your batch, you may need to edit the file to remove surrogate descriptions that do not apply to the object you are depositing.
	Full details about using PRESTO are available in the PRESTO Data Lookup User Guide (http://hul.harvard.edu/ois/systems/webservices/lookup-userguide/).
	Creating MODS from scratch using a template

	It is easiest to create a MODS file from scratch by starting with a valid MODS template and inserting your descriptions.  For DRS2 beta testing, you can use a MODS full record example from the Library of Congress MODS web site:  http://www.loc.gov/standards/mods/mods-guidance.html.
	1. Create a text file called "{obj_name}_mods.xml" – where {obj_name} is the object's owner supplied name (OSN).
	2. Select a sample MODS record on the LC site: http://www.loc.gov/standards/mods/v3/mods-userguide-examples.html.
	3. Copy the entire LC MODS record and paste into your local MODS file.
	4. Add descriptions to the template as needed.  Remove elements that are not needed.
	5. Save the file.
	Adding a MODS file to the batch

	1. If using the manual object workflow:
	a. Create the batch with objects (Step 5 in the batch procedure).  This will generate batch directory structure on disk. 
	b. Copy the MODS file into the object directory inside the BB project's auxiliary (_aux) path: 
	{project_dir}/_aux/{batch_name}/{object_name}/
	If you have MODS files for multiple objects in a batch, do the same for each. 
	c. Continue with your batch procedure.
	2. If using the automatic object workflow:
	a. Add directories to the template and copy content files into those directories (Steps 4-5 in the batch procedure).
	b. Place the MODS file into the template directory in the BB project's auxiliary (_aux) path:
	{project_dir}/_aux/template/
	If you have MODS files for multiple objects in a batch, place all of them in the template directory.
	c. Continue with your batch procedure.
	3. When BB processes the batch, an INFO message displays in the message panel when the MODS file is discovered, e.g.:
	INFO – Imported XML from object-skating_mods.xml
	16. Adding Licenses, Documentation and Other Supporting Content
	In DRS 2, supporting content such as licenses, documentation, finding aids, donor agreements, etc., can be deposited along with the regular content and linked to from the regular content. In order to link regular content objects to supporting content in the DRS, the supporting content needs to be deposited first. After supported content is deposited, the supporting object DRS ID or DRS URN can be used to link it to the regular content. Use the corresponding relationships fields in BB to link regular objects to supporting content when creating a regular content batch.
	To deposit supporting content to the DRS follow the “creating a batch” procedure in this guide for one of the following DRS content models:
	 Still Image
	 Document
	 Text
	After you created your supporting content batch, choose one of the following roles for your supporting objects before they are processed by BB (select one of these roles in the Content Panel on the right while the object is selected in the Project Panel on the left):
	 DOCUMENTATION
	 DONOR_AGREEMENT
	 FINDING_AID 
	 HARVARD_POLICY
	 LICENSE
	 STATUTE
	Process the batch and deposit it to the DRS. 
	Once your supporting content batch is deposited, get the DRS ID or the DRS URN of your supporting object from the batch report, and, after you created your regular content batch, select your object in the BB Project Panel on the left and enter the ID of URN  of the supporting object into one of the following relationship fields in BB in the Content Panel on the right under the Optional tab (before processing the batch):
	 Harvard Policy (Other Rights Documentation block in Content Panel under the Optional tab)
	 License (Other Rights Documentation block in Content Panel under the Optional tab)
	 Statute (Other Rights Documentation block in Content Panel under the Optional tab)
	 Has Documentation (last field at the bottom of the Content Panel under the Optional tab)
	Process your regular content batch and deposit it to the DRS. You objects are now linked to the supporting content.
	17. Uploading Batches to DRS
	Batches are loaded to DRS 2 in the same way as in DRS 1. 
	1. Log on to your ftp dropbox and drag and drop the whole batch directory (the one that has the file batch.xml and object directories in it) that BB processed into the “incoming” directory in the dropbox.
	2. Disconnect from the dropbox to kick-off batch processing. 
	3. Once the batch is processed you will get a successful load batch report or an error report in the email.
	The path to the DRS 2 dropbox is: drs2drop.lib.harvard.edu. 
	Username is your regular DRS 1 dropbox username with prefix “drs2_” added to the username. For example, if your DRS 1 production dropbox is xyzftp, then your DRS 2 dropbox is drs2_xyzftp, etc. The password is the same as the password you have for the DRS 1 production dropbox. 
	18. Interpreting Load Reports
	13.1 Succesful load reports13.2 Failure load reports
	This section describes features of the loader reports generated in the DRS 2 environment.
	The DRS batch loader sends out an email message that reports on the success (or failure) of a processed batch. A batch consists of objects, a descriptor.xml file included with each object and the batch.xml batch control file. Recipients of the loader reports are identified within the batch.xml file.
	18.1 Successful load reports

	Reports of successfully processed batches will be sent to a designated email address or written to the dropbox (or both), based on preferences specified by the <successEmail> and <successMethod> elements in the batch.xml.  
	 If delivered by email, the load report message:
	o Will have a Subject line containing the following information:
	Subject: DRS LOAD REPORT (owner:{owner_code}, batch dir:{batch_directory_name}, batch:{batch_name} [DB:{batch_id}])
	o Will contain the following sections:
	Batch SummaryFile listingFile listing text file (attachment)
	 If written to the dropbox, the load report text file:
	o Will be located in the top-level batch directory with a file name that conforms to the following pattern: LOADREPORT_{batch directory name}.
	o Will contain these sections: 
	Batch SummaryFile listing
	Remember that object descriptor files (descriptor.xml) are part of each batch in DRS2. For every object in the batch there will be a corresponding descriptor file and these files will be included in the load report summary and file listing. 
	About the batch summary

	The batch summary section includes summary information about the batch.  Contents of this section include:
	 Batch directory name
	 Batch name
	 Depositor
	 Batch id
	 Owner(s)
	 Batch drop off time
	 Time waiting to start load
	 Loading start time
	 Loading end time
	 Total load time
	 Number of objects deposited
	 Number of files deposited
	 Batch size
	 Number of objects per object type
	 Number of files per format
	Sample summary for still image object batch:
	/
	Sample summary for page-turned (PDS) object batch:
	/
	About the file listing

	Following the batch summary section, the report lists metadata for each file in the batch, including any object descriptor files (descriptor.xml).  The data in this section is tab-delimited, with these metadata headings at the top:
	 OBJ-ID:  DRS ID of the object associated with this file.
	 OBJ-DELIV-URN: Delivery URN of the object (only PDS Objects have delivery URNs)
	 OBJ-URN:  DRS URN (an alternative internal identifier to DRS ID) of the object associated with this file
	 DEPOSITOR:  First and Last name of depositor responsible for this batch.
	 OBJ-OSN:  Owner supplied name of the object associated with this file.
	 BILLING:  Billing code for this file.
	 OWNER:  Owner code for this file.
	 OBJ-TYPE:  The content model identifier and name (e.g., " STILL IMAGE") for the associated object.
	 OBJ-ROLES: Lists object roles for each object, if any were specified.
	 FILE-ID:  DRS ID of the file.
	 FILE-URN:  Delivery URN of the file.
	 FILE-FORMAT:  Format of the file.
	 FILE-SIZE:  Byte-size of the file.
	 FILE-OSN:  Owner supplied name of the file.
	 FILE-ORIGPATH:  Directory path of the file in the batch.
	Tips and tricks

	Working with the file list.  Entries in the file list are arranged in the order files were ingested by the loader.  If you find it difficult to locate a particular file in the file list, best practice is to import the listing into an application that can sort tabular data, such as MS Excel (if working with the emailed report, import the attachment into MS Excel or another spreadsheet software).  In Excel, if you sort by the FILE-ID column, rows associated with a single object will sort together.  For page-turned object batches, sorting this way should push the METS file to top of the listing.
	18.2 Failure load reports

	If any errors are detected during a load, the entire batch is rejected and an error report is sent to the email addresses in the <failureEmail> element of the batch.xml document.  The error message will include dropbox name, batch directory, and batch name along with a message describing the cause of the failure. 
	All the digital files associated with an error batch are left in the depositor's batch directory, while the batch.xml file and the LOADING file are deleted.  To retry the batch, update any corrupt or missing digital files and upload the new batch.xml file.  After you disconnect from the SFTP session, your batch will be queued for reloading.
	Below are some common batch loader error scenarios and messages:
	1. Error in batch.xml header:  Errors in the header of the batch.xml file can cause processing to fail before the loader can read the failure email addresses.  In this case, the loader will report the error only to DRS staff in LTS.  If you submit a batch but receive no load report or error, send a message to the DRS2 team in LTS using this form:http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help.
	2. Couldn't find billing code for id {billing code}
	Sample: Type of problem: Couldn't find billing code for id HBS.BAKR.KRESS_001
	Cause: The specified billing code is invalid.  Correct the billing code in Batch Builder and regenerate the batch.
	3. Owner supplied name {OSN} already exists for owner code {owner code}
	Sample: Type of problem: Owner supplied name 'randy-pdsobject7' already exists for owner code HUL.TEST
	Cause: The specified owner supplied name has already been defined within the specified owner code.  Correct the OSN in Batch Builder and regenerate the batch.
	4. An unexpected problem occurred processing batch {batch ID}
	Sample: An unexpected problem occurred processing batch 8004. If this problem persists, please contact drs-support@hulmail.harvard.edu, forwarding the entire contents of this message.
	Cause: This error usually indicates an internal DRS issue rather than an error in the batch.  In many cases, reloading the same batch will be successful.  But if the problem persists, send a message to the DRS2 team in LTS using this form:http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help. 
	5. Object descriptor {path to descriptor.xml} not found 
	Sample: Type of problem: Object descriptor /drs2dev/dropboxes/ois2dev/incoming/DefectiveDescriptorBatch/DontRegenerateTheDescript/descriptor.xml not found
	Cause: The specified object descriptor file was expected by the loader but not found.  Upload the missing descriptor file and the batch.xml file and disconnect from the dropbox.
	6. MD5 checksum mismatch for descriptor {path to descriptor.xml}
	Sample: Type of problem: MD5 checksum mismatch for descriptor file /drs2dev/dropboxes/ois2dev/incoming/BadDescriptorChecksum/DontRebuildTheDescriptor/descriptor.xml, services reported 22B5A77B581CCFFE908E535795CDA06A
	Cause: MD5 checksum calculated by DRS services does not match the checksum supplied in the batch. 
	7. File not found: {path to file}
	Sample: Type of problem: File not found: /drs2dev/dropboxes/ois2dev/incoming/MissingDataFile/WhatISaidBefore/image/beethoven3.jpg
	Cause: The specified file could not be found in the batch.  Upload the missing file, re-upload batch.xml, then disconnect from the dropbox.
	8. Batch directory {directory path} contains no objects
	Sample: Type of problem: Batch directory /drs2dev/dropboxes/ois2dev/incoming/DefectiveBatchDotXML contains no objects
	Cause: The specified directory is missing from the batch.  Re-process in Batch Builder and upload the new batch to the dropbox.
	9. Descriptor file failed XML schema validation: {... }
	Sample: Type of problem: Descriptor file failed XML schema validation: cvc-complex-type.2.4.a: Invalid content was found starting with element 'amdSecXXXXXXXXXXXXXX'. One of '{"http://www.loc.gov/METS/":metsHdr, "http://www.loc.gov/METS/":dmdSec, "http://www.loc.gov/METS/":amdSec, "http://www.loc.gov/METS/":fileSec, "http://www.loc.gov/METS/":structMap}' is expected.
	Cause: The specified descriptor.xml file failed schema validation due to invalid content. Re-process in Batch Builder and upload the new batch to the dropbox.
	10. Could not parse batch.xml
	Sample: Type of problem: Could not parse batch.xml
	Cause: This error condition indicates xml in the batch file is not well formed and is usually related to bad character data.  Revise the file and upload again.  
	19. Viewing Your Deposited Objects
	In Web Admin

	Use Firefox or Chrome web browsers. Internet Explorer is currently not supported.
	1. Connect to DRS 2 WebAdmin: https://drs2-qa.hul.harvard.edu:9400/drs2_webadmin/search. 
	2. Enter the object ID from the emailed batch report into the Quick Search field and click on the Quick Search button.
	3. Click on the object ID in the search results.
	4. You will see an object view page with summarized information about your object. 
	5. View files in your objects by clicking on files IDs within the file listing table at the bottom of the screen.
	For more instructions on searching and testing Web Admin please consult the DRS 2 WebAdmin User Guide.
	In DRS public delivery systems

	You can view your objects using the following DRS 2 QA Delivery Services: IDS, PDS, FDS and SDS (audio delivery). Still Image objects are delivered by IDS; PDS Document objects are delivered by PDS; Document objects and Text objects are delivered by FDS. Audio objects are delivered by SDS. The URNs created by Batch Builder 2 resolve in NRS QA. 
	Use the following URLs to view your DRS2 objects:
	 To view Still Image objects in IDS: http://idstest.lib.harvard.edu:9001/ids/view/[file_id]E.g.: http://idstest.lib.harvard.edu:9001/ids/view/1166538 
	 To view PDS Document objects in PDS: http://pdstest.lib.harvard.edu:9005/pds/view/[object_id]E.g.: http://pdstest.lib.harvard.edu:9005/pds/view/1016400 
	 To view Document objects, Text objects and Opaque objects in FDS:  http://fdstest.lib.harvard.edu:9001/fds/deliver/[file_id] E.g.: http://nrstest.harvard.edu:9031/urn-3:H.LIB:216776 
	 To view Audio objects in SDS:http://sdstest.lib.harvard.edu:9007/sds/audio/[file_id] E.g.: http://sdstest.lib.harvard.edu:9007/sds/audio/1028926 
	Click on the Flash Player button to play the audio in your browser. 
	 To view objects using URNs:http://nrstest.harvard.edu:9031/urn-3:[nrs_authority_path]:[resource_name] E.g.: http://nrstest.harvard.edu:9031/urn-3:HUL.OIS:194271 
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